
Free DVD
inside

The in-depth quarterly for the photo enthusiast 

Anti-shake Special • Photoblogs • Full-frame Revolution • Blending Modes

w
w

w
.ct

-d
ig

ip
ho

to
.co

m

10 (2013) • $14.99
Winter Issue

Digital PhotographyDigital Photography

The End of Medium Format?

Full-frame
Revolution
Nikon/Hasselblad Shootout, Market Overview

Made Easy

Body Control
and Shooting Techniques

Stabilizer Hardware Test

Monochrome Composition

Photoblogging Made Easy

Blending Mode Techniques

Open Source Editing
Standalone Selection Tools

Full Version Software
Video Tutorials

Free DVD

Creative Corner

Anti-shake Special

Image Processing

DISPLAY UNTIL MARCH 28
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Our gallery grade printing process 
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and UV damage, regardless whether 

you choose an aluminum mount, 

laminated acrylic, or a canvas print.

Trust us to keep your captured 

moments and favorite memories 

vivid forever.
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When we journalists talk about a “Ferrari piece“, we mean an exciting article about a
high-end product that people love to read about, but which only very few of our
readers will ever buy. This issue contains just such a Ferrari article, and tells you all
about the fight the US$16,000 Hasselblad H4D-40 has on its hands now that Nikon
has released the D800E, with its 36-megapixel full-frame sensor and US$3,300 price
tag. And I can tell you this much right now: today’s medium-format Ferraris could
be in trouble. Multi-megapixel quality is now available in a full-frame package for a
fraction of the cost, and might just signify the start of a revolution in the high-end 
digital camera market. 

But back to the basics: what’s the maximum exposure time you can shoot without
producing camera shake? Our expert tutorial, written by a skilled military marksman
and photo enthusiast, gives you insider tips on how to keep your camera still in just
about any situation. We explain the techniques you need to squeeze the longest
possible exposure time out of every opportunity – all you have to do is practice.

And why not publish the results of all your efforts in a photoblog? Increasing
numbers of photographers present their work online, and a blog is a
personal and versatile alternative to a conventional Web gallery. Our
workshop provides a step-by-step guide to the open source WordPress
blogging platform, showing you how to create your own photoblog and
display your portfolio to its best advantage. We also introduce some
additional plug-ins and tell you how to use custom themes to give your blog
its own unique look. It’s easier than you might think, so why not give it a try?

Have fun with Issue 10 – we hope you are as excited as we are that we’ve
reached double figures!

Juergen Rink
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Portfolio
A spur-of-the-moment decision to go to Moscow turned out 
to be a wise career move, and Frank Herfort is now a celebrated
photographer in today’s new Russia. 

10        Frank Herfort: Portfolio and Artist Portrait

Full-frame vs. Medium Format

The Nikon D800E closes the gap between conventional and
medium-format digital cameras at a competitive price. We pit
the Nikon against the competition from Hasselblad and take a
closer look at today’s high-resolution camera market. 

18        Shootout: Nikon D800E vs. Hasselblad H4D-40
32        Lens Comparison
36        Lab Tests
42        Market Overview

Monochrome Image Composition
Shooting in black and white means reducing your subject to 
its bare minimum form. This expert workshop discusses new
and well-known rules of composition and shows how 
to use them to create enthralling images.  

46        Composing with Form instead of Color
50        Rules of Visual Design
55        Creating Tension and Mood 

Worm’s-eye Workshop 
Shooting objects from below presents special challenges,
especially if you want to use the results in a photomontage. 
We tell you how to be sure of getting realistic-looking results.

62        The Big View from Below

Shake-free Shooting 

The right stance and breath control techniques can help you 
to shoot shake-free using long handheld exposures, whether
standing, sitting or kneeling. We also test the best in-camera 
and accessory stabilizers.

68        Handheld Shooting Workshop: 
            Stance and Breathing Techniques
78        Stabilizer Hardware Test

Blending Modes for Photographers
Blending modes and advanced layer techniques provide 
new and exciting processing options for your best photos 
and usually take just a few clicks. 

92        Introduction
98        Adjusting Shadows, Highlights and Midtones
100      Advanced Tonal Adjustments
108      Advanced Blending Mode Techniques

Full-frame vs. Medium Format 18
Shake-free Shooting 68
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iPad Only?

I just received an email from Customer Service
about the c’t Digital Photography iPad app.
Your articles are more thorough than any
other publication, so something like this 
is extremely important. That said, by 
making it for iPad only, I, and many others, 
are left out. Either PDF issues, or an HTML 5
app, would have worked for all modern
computers. Will there be an option for 
non-iPad users? I currently use Windows,
Linux, and Android devices.

Paul Danger Kile

Never fear! There is also a zinio edition of each
issue that includes the option to download
our free DVD content too. See our
subscriptions page at www.ct-digiphoto.com
or check out www.zinio.com.

Best Periodical in Print

Thank you for the color management articles
in issue 8. This type of in-depth and well
written information is why I subscribe and
consider c’t Digital Photography to be the best
photography periodical in print.

Richard

Sets Standards

First of all thanks for your dedication and that
of the editor for coming back with such a well
thought out reply. It shows you take your
readers seriously and I can’t even begin to say
how important that is to me. As a long time
subscriber to c’t computermagazin and a new

subscriber to c’t Digital Photography I can only
applaud you for doing that.

I’d like to add that I really look forward to
every new issue of both magazines and the
photography edition has set a standard others
could only dream of. I’m particularly happy
with the way you take open-source and Linux
as seriously as any other OS out there. As an
experienced Windows and Linux user I feel I’m
getting the best of both worlds although it
may seem sometimes I have a knack of being
somewhat overly protective of Linux – it is, in
the end of things, nearer and dearer to my
heart.

Keep up the good work and I’ll try to keep
up good and fair comments and dialog!

Mike Bing

Excellent Camera Test 

The high-end camera test is excellent. It is a
great comparison with plenty of detail. If I
were thinking about purchasing a semi-pro or
pro camera, I would want to read this article
first!

Darrell Young 
(via Facebook)

Photographic Journal Worthy
of its Title

My sincere congratulations on an excellent
magazine. At last, I have found a photographic
journal worthy of its title.

Julian Ashbourn

Beyond All My Expectations

I’ve received my very first issue of c’t Digital
Photography, and it was beyond all my
expectations for a photography magazine.
This is by far the best photography magazine
I have ever read. I read the entire issue, cover
to cover, while flying from California to Texas.
Now here’s the problem, what am I supposed
to do while you guys are getting the next
issue ready for publication? I guess I am going
to have to pace myself with your future issues,
a little bit at a time, savor every word in every
article.

Every single article was at the right level, it
wasn’t too basic and it wasn’t too advanced,
each one was perfect for me. I must say my
favorite article, which I’ve read multiple times,
highlighting and annotating the article, was
‘Street Photography’. I have never read an
article or book about street photography
which has the breadth and depth this one has
and I love the writing style. I must commend
the author, Meike Fischer, a job well done! If
there is a book in the works, I will be one of
the first to buy it. Thanks for your time and
keep up the good work.

Joel

Meike Fischer has recently published a
German-language book on street
photography that goes into a lot of detail on
how to shoot street scenes, spontaneous
portraits and urban scenery. Check out the
publisher’s website at www.dpunkt.de and
search for ‘Meike Fischer ‘ to see some sample
pages.
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Reader Forum

Readers’ Letters

We are always happy to receive your
comments and suggestions in a letter,
an e-mail to editor@ct-digiphoto.com
or at www.facebook.com/ct-digiphoto.
We reserve the right to abbreviate your
input for publication. Our comments
are printed in italics.

Tell us what
you think:



OVER THE COURSE OF FOUR DAYS, ENGAGE WITH FASCINATING SPEAKERS, DINE WITH LOCALS 

IN THEIR HOMES, PARTICIPATE IN HANDS-ON WORKSHOPS, AND CELEBRATE IN STYLE AT 

BREATHTAKING VENUES.  FOR MORE INFORMATION, VISIT US AT AFAREXPERIENCES.COM

SEE AUSTRALIA THROUGH 
AFAR’S EYES



The Photo Optimizer package by Ashampoo is
perfect for photographers who don’t want

to spend too much time editing their images.
The program’s simple interface and one-click
approach does away with complex sliders and
manual tools settings, and enables you to adjust
image color, contrast and brightness in one
quick operation. Before and after views make it
possible to judge immediately whether the
built-in algorithms have produced the effect
you are looking for. 

If you are not satisfied with the automatically
generated results, you can still apply manual
corrections, and all adjustments you make are
non-destructive, allowing you to revert back to
the original image at any time. 

Photo Optimizer also includes watermarking
and red-eye removal functionality and also
offers additional vignetting and toning effects
for customizing individual images. You can
export your results to a variety of formats or
social networks that include Facebook and
Picasa Web Albums. 

A free, fully-functional copy of version 4.0.3
is included on this issue’s free DVD, and c’t
Digital Photography readers get a 60 percent
discount on any purchase of version 5. (sea)

Using Lines in Photo
Composition

Video tutorials: In this workshop, pro
photographer Eberhard Schuy explains
how to use lines to enhance and
emphasize the look of a photo.

In the past, photographers had to use
complex, expensive lenses to avoid producing

perspective errors in their images. Nowadays,
digital technology gives us a whole range of
alternative ways to keep our photos straight.

Perspective Pilot is one of these, and we have
included a full version on this issue’s DVD. The
program is designed to get rid of perspective
errors such as converging lines and inconsistent
vanishing points. On the subject of converging
lines, we once wrote ”The Leaning Tower of 
Pisa is Everywhere”, and we all know how easy
it is to capture unwanted converging lines,
especially if we are photographing churches,
towers or other tall buildings in an urban
situation in which we simply can’t use a high
viewpoint. And this is where Perspective Pilot
comes in – the program’s various tools make it
simple to straighten all kinds of perspective
errors, including the severe distortion that
results when you photograph a building using
a wide-angle lens. 

Perspective Pilot not only provides quick and
easy tools for straightening converging lines,
but also helps to correct our old friend the tilted
horizon, and it takes just a few clicks to get even
heavily sloping images back on the level. (sea)

Photo Optimizer

Full version software: This powerful
one-click image editor is designed to
help you perform basic image editing
tasks as quickly and easily as possible. 

Perspective Pilot

Full version software: Perspective Pilot
is a great image processing tool for all
those who like to shoot architectural
photos and urban landscapes.
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This issue’s free DVD includes a wide frange of free and full version image processing and photo
tools, as well as sample images relating to the tests and equipment described in the text. We have
also included free, full versions of Perspective Pilot, which will help you to correct perspective
errors in your photos, and Photo optimizer, which offers a variety quick and easy photo
optimization functions. A set of four expert video tutorials rounds out this issue’s offerings.

Free DVD | Highlights

Photographers use clever and unusual
compositions to attract and hold the

viewer’s attention. This workshop shows how
specific stylistic devices can be used to 
produce successful images. 

”The Use of Lines in Photographic
Composition” might sound like uninspiring
theory, but pro photographer Eberhard Schuy
approaches the subject in a clear and practical
way, using the Belgian Ardennes mountains as
an impressive stage to demonstrate the
techniques he describes. This area is full of long,
winding boardwalks used by hikers, and Schuy
uses these to demonstrate the effects of various
types of lines in photographic compositions. 

We all know that the look of an image can 
be altered significantly by changing the
shooting angle or position, but the targeted 
use of horizontal, vertical and diagonal lines 
to underscore and enhance the resulting
composition is a topic that receives less
attention. However, using lines to enhance 
a composition is not always easy, and Schuy
uses a range of examples to explain how 
to avoid common mistakes while shooting, 
thus avoiding the need to edit your images
later. (sea)

DVD Highlights



9c’t Digital Photography 10 (2013)

Free DVD | Contents

Image Processing Tools

Chromagic 1.1

Fotomatic 1.4

GIMP 2.8.2 

GIMP Portable 2.8.2 

GREYCs Magic Image Converter (GMIC) 1.5.1.9 

ImageMagick 6.8.0 

Inkscape 0.48.2

Inkscape Portable 0.48.2

LiveQuartz 1.9.0.1

Perspective Pilot 3.2.0 (full version)

Photivo

Photo Optimizer 4.0.3 (full version)

PSPI

RawTherapee 3.0.1 

Seashore 0.5.1

Separate+ 0.5.8

SmartCurve 2.2

StylePix 1.11.0

StylePix Portable 1.11.0

Photo Tools

Enblend/Enfuse 4.0 

EnfuseGUI 2.1.3

Hugin 2011.4.0

MacPorts 2.1.2

Plug-In Switch 1.3

WordPress 3.4.2

XAMPP 1.8.0

Sample Images

Blending Modes 

Full-frame vs. Medium Format

Video Tools

Deshaker 3.0

VirtualDub 1.9.11

VirtualDub Portable 1.9.11

Videos

Workshop: Break the Rules 

and Make Mistakes!

Workshop: Digital Powdering

Workshop: The Contrast 

Between Light and Shade

Workshop: The Use of Lines 

in Photograpic Composition

Comparing the Effects of a Kenyon 

Gyro Stabilizer and the Skyler MiniCAM

DVD Contents



Frank Herfort has been criss-crossing Russia
for the last four years, photographing its

tallest buildings from every angle known to
architectural photography. Totally unlike
conventional urban photos, his images of
monstrously massive buildings with an
overwhelming presence seem to come from
another time and dimension.

All these buildings have sprung up as if 
from nowhere, backed by the new financial
elite that formed after the Soviet Union
crumbled. There’s no doing things by halves
here – these buildings are all about pomp
and circumstance and making a statement.
Some of the settings, especially the 
Russian-style rental apartments, accentuate
the singularity of the high-rises and the
contrast between the two sides of modern
Russian life. Towering over everything, 
these phantasmagorical structures look like
something from a parallel universe. The
series is titled ‘Imperial Pomp – Post Soviet
Highrise’.

Whenever he gets a chance between
assignments, Herfort hunts out these
manifestations of megalomania. The photos
are spectacular, perfectly crafted and highly
effective, mainly because most people have
never seen anything like them. This is

photography ‘for the moment’ with no
unnecessary emotion.

Herfort’s most successful project so far
takes a very different approach. ‘Time in
Between’ portrays people in public waiting
rooms in Moscow in a way that tells complete
stories. The scenes seem to be frozen in time,
with no beginning and no end; the moment
lasts an eternity, and the painstaking
composition brings out the otherworldly
atmosphere of the rooms. Elsewhere, waiting
rooms look like waiting rooms, but the rooms
that Herfort found in Moscow are wide open
to interpretation and he expertly exploits this
ambiguity.

‘Time in Between’ was Herfort’s
graduation project at the University of Fine
Arts in Hamburg in 2005 and won him
multiple awards – quite a start to his career.
He had actually intended to shoot the
project while he was in London on a
scholarship, but the necessary spark of
inspiration was lacking, and Moscow had
been beckoning for a quite a while. On 
the spur of the moment, he found a 
Russian-speaking assistant and set off for
Russia in a car loaded with equipment. He
lived there until 2011, but he is now based
in Berlin. 

His other projects include ‘Russia at
Home’, which takes a look inside the homes
of the super-rich, and individual photographs
such as the two reproduced on page 16.

The photos for ‘Time in Between’ were shot
using an analog 4x5” large-format camera,
and the negatives were scanned before being
color corrected digitally. Digital cameras with
large-format backs were used for most of the
post-Soviet mega-building photos.

At 33, Frank Herfort has been extremely
successful in the years since that spectacular
final university project. Nevertheless, the
majority of his time is devoted to
commercial work. He presently spends only
about 20 per cent of his time on his own art
photography, though he plans to change
this in the future.

His advice to up-and-coming
photographers? A firm foundation with a
good degree and the usual internships is
essential, but once the groundwork has been
done, you have to find your own path. Too
many people look for inspiration in
well-known role models and keep returning
to study the classics. Herfort recommends a
different tactic: look for your own ‘signature’,
the thing that only you can do, and never
give up the search. (jr)
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Portfolio | Frank Herfort

Portfolio

Frank Herfort
A decision six years ago to go to Moscow had far-reaching
consequences for Frank Herfort: Russia is now the setting
for his major artistic projects and he has become one of
the country’s most sought-after photographers.
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Arco di Sole, Moscow, 2010 (Imperial Pomp – Post Soviet Highrise)

Nur Otan Party
Building, Astana, 
2012 (Imperial Pomp –
Post Soviet Highrise)
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Portfolio | Frank Herfort

Elephant, Moscow, 2005 (Time in Between)
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Sleeping Café, Moscow, 2005 (Time in Between)
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Portfolio | Frank Herfort

World Map, St Petersburg, 2006 (Time in Between)
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Portfolio | Frank Herfort

Staircase, St Petersburg, 2006 (Time in Between)
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Living Room, Moscow,
2012 (Russia at Home)

Missed, Moscow, 2011

Holiday,
Moscow, 2008





Thomas Saur, Stefan Arand

Full-frame vs.
Medium Format
Since the Nikon D800 was released, the discussion about its
true potential hasn’t stopped for a moment. Can a full-frame
camera that costs US$3,300 really match the quality produced
by the US$16,000 Hasselblad H4D-40? What are the strengths
and weaknesses of these two very different systems? We put
them through their paces, and our carefully planned shoots
and sample images provide some of the answers.



Sensor resolution is still increasing, and
camera manufacturers seem to be

involved in an endless race to outdo each
other on this front. The latest trump card in
the game is Nikon’s 36-megapixel D800,
with resolution that exceeds even that of
some much more expensive medium-format
cameras. The question on everyone’s 
lips is whether expensive, complex 
medium-format digital cameras are still
relevant when you can now acquire a 
full-frame DSLR with higher resolution at a
fraction of the cost. But as we all know,
resolution isn’t everything, and there are
distinct advantages to a larger sensor with
regard to noise characteristics and contrast
in fine subject details. Additional factors that
speak for medium-format cameras are the
absence of a low pass filter and 16-bit 
image processing, which both produce
additional reserves of quality in the images
they capture. 

Nikon has also introduced an ‘E’ version
of the D800, which has no anti-aliasing filter
and promises better image sharpness as a
result. The downside of this approach is an
increased risk of producing moiré effects,
but Nikon D800E owners seem prepared to
make that compromise. Nikon is marketing
its new baby as direct competition for the
medium-format sector, so it is no wonder
that numerous reports crediting the D800
with image quality equal to or better than
many medium format cameras appeared in
online forums and on video platforms soon
after its release. The US$3,300 Nikon seem
like a bargain compared with the five-figure
prices the medium-format competition
commands. 

Interestingly, there are sample images
around that demonstrate the superiority  of
the Nikon under some circumstances but
that of medium-format cameras under
others. We wanted to know exactly what’s
what, so we grabbed a Nikon D800 and 
a Hasselblad H4D-40 and subjected both 
to a rigorous comparison test shoot. The
results not only highlight the strengths and
weaknesses of both systems, but also gave
us a lot of useful experience that we want to
share here too. We can tell you this much in
advance: high-end cameras like these are
completely unforgiving of shooting errors,
and you have to pay attention to a number
of important factors if you want to realize
their true potential.

19
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Hasselblad H4D-40 with the HC 4/120 macro | 1/125s | f11

Our tests focused on real-world shooting
situations that include a macro shot, a studio
portrait, an open-aperture portrait, bokeh
and landscape. It is, after all, the visual
results that determine the real value of a
camera. We provide you with separate,
detailed analysis of each situation and
sample images to go with each, as well as
details of the observations we made while
shooting.

We also took both cameras to the c’t Digital
Photography lab, and we have included a tabe
of results on page 38, as well as a table of
technical data on page 41.

Image Processing

In order to make a fair comparison of our
sample images, we processed them all using
Adobe Lightroom, and attempted to produce

colors and tonal values that were as similar as
possible for both systems. We also applied
slight sharpening to all of our sample images
during the RAW conversion process.

The test images and detail crops do not
reproduce well in print, so we have also
included most of them on this issue’s free
DVD. 

Experience has shown that it is possible to
extract more quality from RAW image files if
they are processed using the camera
manufacturer’s own proprietary software.
Hasselblad’s Phocus Software offers more
color adjustment options than Lightroom or
Nikon’s Capture NX 2, for example when
correcting the finer points of skin tones.

Medium-format Full-frame

Camera:
Hasselblad Nikon 
H4D-40 D800E

Lenses:
HCD 4/28 Zeiss ZF.2 

Distagon T* 2.8/21

HC 2.8/80 Zeiss ZF.2 
Makro-Planar T* 2/50

HC 2.2/100 AF-S Nikkor 85mm f/1.4G

HC 4/120mm-II Zeiss ZF.2  
Makro-Planar T* 2/100

HC 4/210 AF-S Nikkor 70-200mm 
f/2.8G ED VR II

Our Test Cameras

The Hasselblad version of this shot
captured even the finest details,
such as the grainy texture of the
numbers on the dials

How we Tested



We lit our macro sample setup using flash,
combined with the HC 4/120mm-II on the
Hasselblad and the Zeiss ZF.2 Makro-Planar T*
2/100 with our D800E. We began by shooting
aperture-bracketing sequences with both
systems and selected the sharpest shot from
each sequence. Due to diffraction effects,
optimum sharpness is never actually achieved
using the smallest aperture available on a lens.
To compensate for the difference in sensor
sizes and produce comparable depth of field,
we closed the Hasselblad’s aperture down by
two extra stops.

At first glance, the quality of the two shots
is amazingly similar, although we discovered
on taking a closer look that the Hasselblad
actually captured the finer details of the
texture in the metal and the numbers on the
watch dials more precisely than the Nikon.
Overall, the images captured by the

Hasselblad displayed better detail rendition
and microcontrast, although you would need
to resort to a very large print to make the
differences visible to a casual viewer. The
differences we detected would be negligible
in the context of an everyday catalog or
editorial shoot that doesn’t rely on the use of
heavily cropped details.

Conclusion

In macro situations, the H4D-40 offers slightly
superior resolution and microcontrast. Tonal
quality and detail rendition were directly
comparable, and the Nikon/Zeiss
combination produced excellent results.
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Nikon D800E with a Zeiss ZF.2 Makro-Planar T* 2/100 |
1/125s | f11

Macro Shot

The Nikon D800E combined with
the Zeiss 100mm macro produced
astonishing reproduction quality
for a full-frame sensor. Sharpness
is only slightly less well defined
than the Hasselblad’s.



We shot all our studio portraits using the
AF-S Nikkor 85mm f/1.4G with the D800E
and the HC 2.2/100 with the H4D-40. We
stuck to f11 across the board and judged the
results (developed using Lightroom) by eye.
Both cameras delivered RAW files with
plenty of color and tonal headroom. With
sufficient tweaking, we managed to produce
results with the Nikon that pretty well kept
pace with the Hasselblad, although the
H4D’s 16-bit files still offer more overall
processing potential.

There are virtually no detectable
differences in resolution and sharpness,
although the Hasselblad again produced
slightly better microcontrast and its skin
tones were better graduated and looked a
little more vivid in the 100% monitor view.
The same was true for natural surface
textures such as wood, sand and textiles,
which also had a more realistic, three-
dimensional feel and details that almost
appear to rise from the surface of the image.
The Nikon skin tones were flatter and
offered less tonal gradation. Using the
Phocus software to develop the Hasselblad
images made these differences more
obvious still, especially in the skin tones. 

The offset printing process used to
produce this magazine covers up a lot of the
differences we found, which are only really
obvious in high-end prints or a 100% monitor
view. 

Full-frame vs. Medium Format | Studio Portrait

Studio Portrait

Hasselblad H4D-40 with the HC 2.2/100 | 1/150s | f11

Studio portrait lit with flash and a softbox. To keep the results as visually similar as possible,
both shots were developed in Lightroom 4.

Nikon D800E with the AF-S Nikkor 85mm f/1.4G | 1/125s | f11
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Hasselblad H4D-40 | 1/250s | f11 | 100mm

RAW processing 
performed using
Lightroom 4.0

RAW processing 
performed using
Lightroom 4.0

Nikon D800E | 1/125s | f11 | 85mm

The Hasselblad produced more convincing skin detail and tonal gradation
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Hasselblad H4D-40 | 1/250s | f11 | 100mm Nikon D800E | 1/125s | f11 | 85mm

RAW processing
performed using
Phocus 2.6.6

RAW processing
performed using
Nikon Capture NX 2

Here, you can see the results of using the manufacturers’ proprietary software to develop the images. Hasselblad’s Phocus package
is well thought out and is obviously aimed at professionals aiming for reliable, realistic skin tones and great detail rendition.
Nikon’s Capture offering provides a poor workflow and produces disappointing results – we preferred the Lightroom version.



The aim of this shot was to produce a portrait
with shallow depth of field and the best
possible bokeh. We positioned our model in
slight backlight and lit her indirectly using  a
large reflector. We used both lenses (the
85mm Nikkor and the HC 2.2/100) at their
maximum aperture settings.

The fantastic quality of the admittedly
much more expensive Hasselblad lens 
was obvious from the start, and the results 
it produced were vivid, highly
three-dimensional and really sharp, and
showed virtually no ill effects caused by stray

light. The Nikon lens also performed very well
in light of the aperture we used, but simply
doesn’t match the Hasselblad’s overall quality.
Stopping down a little visibly improved
sharpness and microcontrast in the Nikon
results, but of course reduced the
accompanying bokeh effect. The Nikon
images are slightly soft and lifeless and 
also suffered from blooming at some 
high-contrast edges in the shots that were
more clearly backlit. 

This task gave the Hasselblad every
opportunity to demonstrate its strengths.

Provided you shoot carefully and focus
precisely, you can use this camera/lens
combination to produce clear, sharp images
at just about any aperture, although it has to
be said that its depth of field is so shallow at
f2.2 that it was difficult to keep both our
model’s eyes in focus in a frame-filling
portrait! Under such circumstances, setting
and keeping focus is a real challenge.

In order to produce usable outdoor
results while shooting handheld, we
stopped the Nikkor down to f2 and the HC
to f2.8. The Hasselblad’s large viewfinder
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Hasselblad H4D-40 with the HC 2.2/100 |
1/800s | f2.2

Open-aperture Portrait

The Hasselblad’s theoretical detail
superiority didn’t always show in our
outdoor portraits



makes it easier to focus manually, but its
autofocus system is not as good as the
Nikon’s, and the D800E’s autofocus hit rate
is simply much better.

In contrast to the D800E’S
ultra-sophisticated system, the H4D-40 has
just one relatively large AF area in the center
of the frame, which is why Hasselblad has
taken the trouble to develop its ‘True Focus’
technology to help the camera focus
automatically on subjects that aren’t
positioned in the middle of the frame. With
most autofocus DSLRs, if you lock focus and

then re-frame your shot, a slight focusing
error will result. Hasselblad uses a yaw rate
sensor to measure the angular velocity of
the camera as you move it and to recalculate
the focus position accordingly. The problem
with this approach is that if the model
moves (even just a few millimeters) once you
have begun the True Focus process, the
technology doesn’t provide sufficient focus
accuracy – or at least it didn’t in our
open-aperture test shots.

Nikon’s multiple selectable AF areas make
it possible to focus more accurately for

handheld shots, and especially for moving
subjects. This makes the D800E the better
choice for all moving subjects, including
sports events and fashion shoots. 

Conclusion

The D800E won this round purely on the
strength of its autofocus system, which made
it much easier for us to produce usable results
than with the H4D-40.
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Nikon D800E with the AF-S Nikkor 85mm 
f/1.4G | 1/4000s | f1.4

In this outdoor situation, the lighter 
Nikon with its better autofocus system
produced less risk of camera shake and
better results 
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Hasselblad H4D-40 with the HC 4/210 | 1/40s | f4 

Bokeh
Many pro photographers swear by
medium-format cameras because of
their superior detail rendition and the
vivid, three-dimensional look that the
resulting photos often have. The large
sensor format produces shallower depth
of field than equivalent full-frame angles
of view and apertures. Even though
medium-format cameras don’t have
such wide maximum apertures, they are
still better at isolating a subject from 
its background and creating distinct 
bokeh effects.
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The AF-S Nikkor 85mm
f/1.4G produces very
pleasant, soft bokeh and 
a look that is absolutely
comparable with
medium-format shots.
However, to produce
these kinds of results, you
have to be prepared to
open the aperture right
up and accept some
compromises regarding
sharpness and contrast.

Nikon D800E with the Zeiss 
ZF.2 Makro-Planar T* 2/50 |
1/200s | f2 
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Quick Tip

We recommend using an online
calculator tool such as the one at
http://www.dofmaster.com/dofjs.html
to calculate precise depth of field for
your particular situation. Such a tool also
enables you to calculate the settings
you need to use to produce equivalent
results using full-frame and
medium-format gear. For example:
using the H4D-40 and the HC 2.8/80 set
to f2.8 for a subject distance of one
meter, depth of field will equal 3 cm. To
capture the same image using the 
full-frame Nikon, you would have to use
a 50mm lens set to f1.4.



You would probably expect two different
cameras using the same exposure settings
under the same lighting conditions to
produce pretty much the same range of
tonal values in the resulting image.
However, it seems digital camera
manufacturers follow exposure control
philosophies that differ just as much as the
look produced by different analog film stock.
Our sample images show that Hasselblad
has obviously tweaked its system so that it
tends slightly toward underexposure but
ensures well-defined highlight detail. In

contrast, the Nikon system appears to put
more emphasis on shadow detail. 

The shot of the scales and fruit was backlit,
which meant that the scales themselves were
slightly underexposed. To get the look we
wanted we significantly brightened the

shadows in both versions – we were surprised
to find that the Nikon shot contained much
more detail headroom  in the shadows than
the Hasselblad version. We were able to
brighten the Nikon image quite easily without
producing obvious noise artifacts in the
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Hasselblad H4D-40 with the HC 2.2/100 |
1/750s | f2

Exposure and
Dynamic Range

The backlit situation meant that we had to brighten the shadows later using Lightroom. This
process produced obvious noise in the Hasselblad version of the shot.



process, but we could only brighten the 
H4D-40 file if we were prepared to accept a
lot of additional noise, making it difficult to
achieve satisfactory results. On the other
hand, the transitions in the Hasselblad shot
are smoother and more detailed, while the

Nikon produced some obvious zigzagging. If
you know what to look out for, you can
compensate for the shortcomings of both
cameras by using appropriate exposure
settings. Overall, the Hasselblad offers slightly
better dynamic range.

31c’t Digital Photography 10 (2013)

Nikon D800E with the AF-S Nikkor 70-200mm f/2.8G ED VR II |
1/400s | f4.4 | 170mm

Hasselblad H4D-40 with the HC 4/210 | 1/80s | f16

Nikon D800E with the AF-S Nikkor 85mm f/1.4G |
1/400s | f2

The Nikon shot displays almost no detail in
the sky, whereas the Hasselblad did a much
better job of capturing the texture of the
clouds and produced an image that is
generally more vivid and three-dimensional

We were able to brighten the shadows in the Nikon shot without producing too much
additional noise



We shot this landscape using the H4D-40 and
the HC 2.8/80 at f10 and 1/40 s. To avoid
camera shake at this slow shutter speed, we
also used mirror lock-up and mounted the
camera on a tripod.

We used the Zeiss ZF.2 2/50 Makro-Planar
at f8 and 1/100 s to shoot the same scene with
the D800E. The movement of the Nikon’s
much smaller mirror had a negligible effect on
the sharpness of the resulting image.

Although the pixel-level resolution of both
cameras appears similar at a first glance, the
Hasselblad produced an image with an even
greater feeling of depth than in our previous
portrait test.

The medium-format image displays
better microcontrast and rendered the
filigree structures of the vegetation more
effectively as a result. The larger, 16-bit color
space offered by the Hasselblad produced
better tonal differentiation and more precise
detail rendition in the finer parts of the
subject, and enabled us to perform more
post-processing without too much loss of
image quality. We were able to apply
stronger gradients and heavier tonal value
adjustments while retaining the tactile look
of the image, whereas the Nikon image
began to look a little flat following much less
serious processing. This lack of headroom

makes it more difficult to capture landscapes
reliably, especially in the changeable
lighting conditions that often prevail in
outdoor situations. We were better able to
restore pixels affected by blooming in the
H4D-40 files, while the Nikon once again
produced more workable shadow detail.

The Hasselblad’s large viewfinder makes it
easier to compose landscape images,
although the Nikon offers live view as an
alternative. In combination with a monitor
magnifier and the monitor zoom function, it
is possible to use live view and manual mode
to focus precisely and judge depth of field in
real time before releasing the shutter.
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The image we captured using the H4D-40 shows very fine
differentiation between the various green tones and is highly 
tactile all the way down to the finest details in the leaves

Landscape

Hasselblad H4D-40 with the HC 2.8/80m | 1/40s | f10



Conclusion

Both systems are eminently suitable for
landscape photography, and the best one to
choose will depend on the type of photo
you want to shoot. If you are after the best
possible image quality and you need as
much processing headroom as possible,
medium format should be your first choice.
The downside of this choice is the higher
price and greater weight of the equipment
you will have to carry with you. For regular
travelers and adventure photographers, the
Nikon makes an extremely practical
lightweight alternative.
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The D800E used with the Zeiss ZF.2 50mm f/2.0 macro lens captured all the available
detail, although overall, the image looked slightly weaker than the Hasselblad version
and didn’t provide quite such fine distinctions between the various green tones

Quick Tip
The H4D-40 is the only medium-format
camera in the Hasselblad range to offer
built-in long exposure functionality that
allows you to program exposure times
of up to 256 seconds. This gives creative
photographers a whole new range of
possibilities, for instance for night shots
or light painting applications.

A lightweight camera is a real bonus on
carefully planned landscape shoots that
require you to cover long distances on
foot to reach your subject. If this is the
case, the lighter weight of the lenses,
triood and other accessories required also
speak for the Nikon. The D800’s
weatherproof body also makes shooting
outdoors in inclement weather a less
nail-biting experience. To make up for the
potential disadvantage of the smaller
viewfinder, use a monitor magnifier or
the camera’s focus confirm functionality.

Nevertheless, some photographers
simply prefer the heavyweight build and
image quality that a medium-format
camera provides. 

Whatever your personal preference, 
the extreme resolution of both cameras
is unforgiving of even the slightest
camera shake, whether due to mirror
movements, wind or a sloppy tripod, 
so they have to be handled extremely
carefully if you want to produce 
high-quality results.

Camera Handling

Nikon D800E with the Zeiss ZF.2 Makro-Planar 
T*2/50 | 1/100s | f8



The greater the sensor resolution, the greater
the demands on your lenses. We compared
several lenses for both systems to see if they
are capable of doing justice to the high-end
hardware built into the cameras. As already
mentioned, we tested the D800E with Nikon
and manual-focus Zeiss lenses. Manual focus

is often an advantage for specialist themes
like macro and landscape photography.

Once again, we found that
ultra-wide-angle lenses produce optical
anomalies that are very difficult to correct,
especially at the edges of the frame where 
the light rays hit the sensor at a steep angle.

We selected the Zeiss Distagon T* 2.8/21 (the
best full-frame ultra-wide-angle lens we
know) as a worthy competitor to the famously
sharp  Hasselblad HCD 4/28.

In spite of its extremely high quality, the
Zeiss showed weakness in edge detail
throughout the entire aperture range when
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Comparing Lenses

Cityscapes

We used the HC 4/210 with the Hasselblad and the AF-S Nikkor
70-200mm f/2.8G ED VR II with the Nikon to shoot all of these
images. We used mirror lock-up and a tripod to prevent camera
shake.

The Nikkor doesn’t stand a chance in direct competition with the
Hasselblad heavyweight, and edge detail especially shows obvious
weakness. Unfortunately, the zoom also comes a clear second even
when used stopped down. In this case, the lens simply doesn’t
make the most of the available resolution. In contrast, the
Hasselblad’s detail rendition remains consistently excellent
throughout the entire frame. 

Edge detail
Nikon D800E with the AF-S Nikkor 70-200mm 1f2.8G ED VR II |
1/250s | f11 | 170mm

Edge detail
Nikon D800E with the AF-S Nikkor 70-200mm f/2.8G ED VR II |
1/5000s | f2.8 | 170mm 

Edge detail 
Hasselblad H4D-40 with the HC 4/210 | 1/800s | f4 

Edge detail
Hasselblad H4D-40 with the HC 4/210 | 1/160s | f16



compared with the (approximately 21mm
equivalent) Hasselblad HCD 4/28. The HCD
displayed much less edge fall-off at maximum
aperture and virtually no ill effects at f8 and
beyond. The Zeiss wasn’t even capable of
holding its own against the Hasselblad in
terms of center sharpness at maximum
aperture. The small amounts of distortion and
slight vignette effects produced by both
lenses were easyily corrected using Lightroom.

The Zeiss Makro-Planar T* 2/50 produced
excellent detail right into the corners at f4 and
beyond, while the Hasselblad HC
2.8/80  produced constant sharpness in all
image areas right from its f2.8 maximum
aperture. 

The Makro-Planar T* 2/100 delivered
virtaully perfect results from f2.8 onward and
provided us with the best overall sharpness
that we were able to capture with the Nikon
during the entire test. The 70-200mm Nikkor
simply cannot compete and produced
obvious edge fall-off across the entire zoom

range. Edge sharpness is only really usable at
f8 and beyond, while center rendition is
adequate from f4 onward.

We found the results produced by the
AF-S Nikkor 85mm f/1.4G to be too soft over
the entire frame at maximum aperture,
although the effect disappeared quickly in
the center of the frame form f2.8 onward.
Edge and corner definition followed suit at
f4 and beyond. The HC 4/120-II leaves
nothing to be desired, even at maximum
aperture, producing no discernible edge
weakness at any time.

Conclusion

One distinct advantage of the D800E is the
huge range of compatible Nikkor and
third-party lenses available for it. The camera’s
relatively shallow throat depth also makes it
suitable for use with adapted lenses from
other manufacturers. However, you still need
to make sure that the lens you are considering

is good enough to do justice to the Nikon’s
sensor before you invest in it.

At the end of the day, we couldn’t avoid
the feeling that the Nikon D800E offers
potential image quality that isn’t matched
by many of the high-end lenses on today’s
market. On the other hand, the Zeiss
Makro-Planar T* 2/100 shows just what is
possible if the camera is coupled with an
appropriately high quality lens. The results
were ultra-sharp and directly comparable
with medium-format images at all but the
very largest aperture setting. In comparison,
the US$2,400 that Nikon charges for its 
70-200mm zoom simply doesn’t represent
good value.

Except for the slight edge blur we found
using the HCD 4/28 at maximum aperture
(which was much less obvious than that
produced by the Nikon/Zeiss combo), the
Hasselblad lenses we tested all delivered
consistently good sharpness throughout the
frame. 
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Center detail
Nikon D800E with the AF-S Nikkor 70-200mm f/2.8G ED VR II |
1/250s | f11 | 170mm

Center detail
Hasselblad H4D-40 with the HC 4/210 | 1/160s | f16

Center detail
Nikon D800E with the AF-S Nikkor 70-200mm f/2.8G ED VR II |
1/5000s | f2.8 | 170mm 

Center detail
Hasselblad H4D-40 with the HC 4/210 | 1/800s | f4 
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Hasselblad HCD 4/28 at maximum aperture (f4) Zeiss Distagon T* 2.8/21 at maximum aperture (f2.8)

Hasselblad HCD 4/28 at f11 Zeiss Distagon T* 2.8/21 at f8

Hasselblad HC 2.8/80 at f11 Zeiss Makro-Planar T* 2/50 at f8

Hasselblad HC 2.8/80 at maximum aperture Zeiss Makro-Planar T* 2/50 at maximum aperture

AF-S Nikkor 70-200mm f/2.8G ED VR ll set to 100mm
and f8

Zeiss Makro-Planar T* 2/100 at f8

AF-S Nikkor 70-200 mm f/2.8G ED VR ll set to 100mm
and maximum aperture (f2.8)

Zeiss Makro-Planar T* 2/100 at maximum
aperture (f2)

The Hasselblad HCD 4/28 clearly shows less
edge weakness than the Zeiss Distagon
T*2.8/21 at maximum aperture. However,
the Zeiss is extremely sharp in the center 
of the frame at all apertures.

The Zeiss’ edge definition is still poor, 
even at f8. At f11, the Hasselblad produce
faultless results throughout the 
entire frame.

A comparison of the two best standard
lenses once again reveals more obvious
weakness on the part of the Zeiss 
Makro-Planar T* 2/50 at maximum aperture
than that produced by the Hasselblad HC
2.8/80. Both lenses produced  very good
center sharpness at maximum aperture and
excellent overall sharpness when used
stopped down.

The difference in image quality at maximum
aperture is even more obvious when
comparing the fixed focal length 100mm
Zeiss lens with the Nikon zoom at its
100mm setting. The Zeiss is capable of
producing quality worthy of the camera’s
monster sensor, whereas the Nikkor zoom is
very weak at the edges of the frame and
still shows some softness in the center. Even
at f8, the zoom still produces weak edge
performance, and here too, the Zeiss does a
much better job.
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Available light photography is a special
challenge for both photographer and
equipment. In poor light, the only way to
ensure that you can use sufficiently short
exposure times to prevent camera shake is to
increase the ISO sensitivity setting.

Both of our test systems produced similar
results at ISO 400, but the Nikon displayed
much less obvious noise in critical image areas
at ISO 800 and beyond. The noise
characterstics displayed by the H4D-40 at ISO
1600 were similar to those shown by the
D800E at ISO 6400, making the Nikon the clear
winner in the ISO stakes.

The images produced by the H4D-40 at ISO
800 and above show obvious color noise in
the shadows but delivered marginally better
highlight detail at ISO 400. At ISO 800 and
beyond, the Nikon produces superior results
throughout the frame.

Conclusion

Generally speaking, if you tend to end up
shooting handheld in low light, the D800E is
the better choice. The Nikon offers more
ISO-based room for maneuver when it comes
to retaining image quality while squeezing
shorter exposure times out of the camera.

ISO 400: Both cameras show slight noise,
especially in the shadow areas. There are 
no visible noise artifacts in the highlights.

ISO 800: The D800’s superiority is already
visible at this level. The Artifacts produced
by the H4D-40 are particularly obvious in
the shadow details.

ISO 1600: While the Nikon’s noise
characteristics change only slowly with
increasing sensitivity, at this level, the
H4D-40 is already producing obvious noise
artifacts. Detail rendition is still good, but
luminance noise begins to appear alongside
the existing color noise.

H4D-40, ISO 400

D800E, ISO 400

H4D-40, ISO 800

D800E, ISO 800

H4D-40, ISO 1600

D800E, ISO 1600

ISO Comparison

Full-frame vs. Medium Format | ISO Comparison
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The Hasselblad H4D-40 

TEST RESULTS, PART 1
Sensor resolution
[Lp/h]

better >

Relative center
resolution
(ISO 100,
wide-angle) better >

Center resolution
(ISO 100)
[lp/h]
better >

Center resolution
(ISO 400)
[lp/h]
better >

Center resolution
(ISO 800)
[lp/h]
better >

Center resolution
(ISO 1600)
[lp/h]
better >

Center resolution
(ISO 3200)
[lp/h]
better >

Hasselblad H4D-40 with the HC 2.8/80
Nikon D800E with the AF-S Micro Nikkor 105mm f/2.8G VR

2738
2456

120
109

3285
2679

3285
2597

3285
2555

3285
2592

–
2681

The results we achieved in our test lab basically
confirmed the observations we made while we
were out and about. We were surprised by the
relatively poor noise results that the D800E
produced in comparison with our test of the
standard model D800 (see our multi-camera
test in issue 9 of c’t Digital Photography). The
reason is probably that we conducted the tests
for the D800E on RAW image files in order to
keep the comparison with the H4D-40 (which
can only save RAW files) fair. In this test, we
developed the images from both cameras
using the same parameters in Lightroom 4,

whereas the JPEG images we tested in issue 9
were developed internally by the camera’s
firmware, which automatically applies a variety
of optimization steps – including noise
reduction – during the process.

The resolution values recorded by both
cameras are very high indeed and change
relatively little across a broad range of ISO
values (up to ISO 1600 for the Hasselblad and
ISO 6400 for the Nikon). The Nikon D800E
delivers high maximum contrast at ISO 100
and satisfactory contrast right up to ISO 1600,
whereafter it drops off continuously. Its

signal-to-noise ratio is good up to ISO 100,
adequate up to ISO 800 and becomes visibly
poorer thereafter. The visual noise values we
recorded behaved similarly and began to drop
off at ISO 1600 and above.

The H4D-40 produced high maximum
contrast values at ISO 100 and passable values
up to ISO 400, above which there is significant
fall-off. Its signal-to-noise ratio is good at ISO
100 but begins to drop off significantly at ISO
400. Here too, the visual noise values we
recorded followed a similar pattern but are
already very poor at ISO 1600. 

TEST RESUTLS, PART 2
Signal-to-noise ratio
[S/Nx] ISO 100
better >

Signal-to-noise ratio
[S/Nx] ISO 400
better >

Signal-to-noise ratio
[S/Nx] ISO 800
better >

Signal-to-noise ratio
[S/Nx] ISO 1600
better >

Signal-to-noise ratio
[S/Nx] ISO 3200
better >

Signal-to-noise ratio
[S/Nx] ISO 6400
better >

Visual noise 
OECF20 ISO 100
< better

Hasselblad H4D-40 with the HC 2.8/80
Nikon D800E with the AF-S Micro Nikkor 105mm f/2.8G VR

63.0
67.0

34.0
35.0

22.0
25.0

13.0
18.0

–
13.0

–
9.0

1.0
0.8

Lab Tests
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The hype surrounding the introduction of the
Nikon D800E is largely justified. This is an
impressive camera with a compact,
lightweight weather-resistant body, a wide
range of sophisticated functionality and
image quality that gives it a unique position
among today’s full-frame DSLRs. This 
upstart represents a real challenge to most 
full-frame DSLRs and – with its unique,
ultra-high-resolution sensor – to many
medium-format cameras too.

Our test images showed that the promise
of medium-format resolution in a full-frame

package was particularly true in the center of
the frame, while the Nikon’s edge definition
simply wasn’t up to that of the Hasselblad
when shooting at maximum aperture. This
fact underscored our suspicion that the
quality of the available lenses plays a
significant role in differentiating the
performance of these two systems. There are
very few lenses out there that are capable of
making the most of the Nikon sensor’s
extreme resolution. 

We found that even Nikon’s own-brand
lenses couldn’t really hold their own with the

36-megapixel (Sony-built) sensor. The
Hasselblad’s excellent Fuijnon lenses are
perfectly suited to squeezing the best
possible quality out of a high-resolution
sensor and are easier to use. They also
produce better results at wide apertures. In
the end, the H4D-40 won the day in the
object, landscape and architectural
photography categories with its excellent
sharpness characteristics that consistently
reach the very edges of the frame.

Generally speaking, under controlled
shooting conditions, the Hasselblad, 

The Nikon D800E

Final Conclusions

Center resolution
(ISO 6400)
[lp/h]
better >

Contrast/Subject
range, ISO 100
[in f-stops]
better >

Contrast/Subject
range, ISO 400
[in f-stops]
better >

Contrast/Subject
range, ISO 800
[in f-stops]
better >

Contrast/Subject
range, ISO 1600
[in f-stops]
better >

Contrast/Subject
range, ISO 3200
[in f-stops]
better >

Contrast/Subject
range, ISO 6400
[in f-stops]
better >

Real subject
range
[# of tonal values]
better >

Color Checker SG Δ E 
ISO 100 

< better

–
2947

10.0
11.0

8.0
9.7

6.7
8.7

5.7
8.0

–
7.0

–
6.0

256
251

10.9
8.3

Visual noise 
OECF20 ISO 400
< better

Visual noise 
OECF20 ISO 800
< better

Visual noise 
OECF20 ISO 1600
< better

Visual noise 
OECF20 ISO 3200
< better

Visual noise 
OECF20 ISO 6400
< better

Startup time [s]

< better

Shutter lag (wide-
angle) at >1000 lx in
LiveView [s] < better

Shutter lag (wide-angle) at >1000 lx 
[s]
< better

2.1
1.5

3.5
2.1

6.3
2.9

–
4.2

–
6.2

7.9
0.2

–
0.9

0.6
0.2

Quick Tip

If you want to get the most out of the
Nikon D800E’s mega-sensor, you will
need to use fixed focal length lenses set
to their optimum aperture. We
recommend that you take a look at the
excellent lenses offered by third-party
manufacturers such as Zeiss or the Leica
R series, which can be adapted for use
with the Nikon mount. These lenses
require manual focusing, but reward
the patient photographer with excellent
microcontrast and great sharpness,
especially at the edges of the frame. The
Nikon’s built-in focus confirm indicator
or live view (with an optional monitor
magnifier) are great ways to help you
focus accurately.
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with its consistently sharp, highly
three-dimensional-looking results and
additional 16-bit processing headroom, wins
the day at  lower sensitivity settings up to ISO
400.

On the other side of the coin, the D800E
offers a lightweight, high-performance
alternative for all photographic tasks that
demand speed and flexibility – such as sports,
outdoor portraits, fashion shoots and 
low-light situations.  

Both systems deliver extremely
high-quality results with sharpness and
resolution that are difficult to distinguish
when printed at normal sizes up to about A3
(approximately 12 x 17 inches). At low ISO

settings, the medium-format system just
nosed ahead with regard to absolute image
quality, but the introduction of the new Nikon
has seriously diminished the comfortable lead
that medium-format cameras enjoyed until
recently.

The single most limiting factor for both
systems is probably the photographer’s own
technical ability. You have to know how to
handle a camera of this caliber properly if you
want to make the most of its unique
capabilities. Choice of lens, the best aperture
to use, preventing camera shake, precise
focusing and high-end RAW processing
software are just some of the factors that you
must have under control. (pen)

For

–ˇBetter image quality up to ISO 200/400
–ˇImage files offer more processing headroom
–ˇBetter dynamic range, highlights especially can be more

easily restored
–ˇBetter lenses produce better detail sharpness in all image

areas 
–ˇ16-bit image capture
–ˇBetter skin tones
–ˇImages generally appear more three-dimensional
–ˇHigh-end tilt/shift adapter available
–ˇOther Hasselblad/Zeiss lenses can be used with adapter
–ˇMuch better viewfinder
–ˇTrue Focus autofocus assist
–ˇApproximately 10 percent more sensor resolution
–ˇIncludes Lightroom 4 and Phocus software
–ˇLong exposures programmable up to 4 minutes 
–ˇManufacturer’s proprietary Phocus software delivers better

color fidelity, color quality and DAC digital lens correction
functionality 

–ˇExcellent tethering functionality, remote camera control via
PhocusMobile for iOS

Against

–ˇPoor monitor
–ˇSlow handling
–ˇOnly one focus area
–ˇSlow autofocus
–ˇProne to camera shake due to heavy mirror movement,

often requires mirror lock-up.
–ˇLarge and heavy
–ˇBody not weatherproof
–ˇShortest exposure time 1/800 s
–ˇRelatively small range of available lenses
–ˇNo adapter option for third-party lenses

Approximate Retail Price US$16,000 (body only)

Hasselblad H4D-40

Forikon D800E

–ˇExcellent high-speed autofocus
–ˇ4 fps continuous shooting
–ˇWeatherproof body
–ˇConsistent image quality at high ISO sensitivity 
–ˇLarger range of compatible lenses than any medium-format

camera
–ˇCompatible with high-end third-party lenses from Zeiss and

Leica (R series with adapter)
–ˇShort throat depth makes adapting lenses simpler
–ˇImage-stabilized lenses available
–ˇShadow detail can be more easily restored
–ˇCompact dimensions
–ˇVideo functionality
–ˇLive view
–ˇHigh-quality monitor
–ˇBuilt-in HDR functionality
–ˇRAW and JPEG capture
–ˇTwin card slots provide extra capture flexibility
–ˇPhocus software can read Nikon image files
–ˇNikon RAW editing software included
–ˇRelatively low price

Against

–ˇ’Only’ 14-bit color depth
–ˇViewfinder difficult to use with manual focus lenses
–ˇNikon lenses only able to match sensor quality at medium

or small apertures
–ˇHigh pixel density quickly tests the limits of lens resolution,

especially at wide apertures and using ultra-wide-angle
lenses

Approximate Retail Price US$3,300 (body only)

Nikon D800E
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Full-frame vs. Medium Format | Technical Details

HIGH-RESOLUTION FULL-FRAME AND MEDIUM-FORMAT DSLRS

Manufacturer/Model Hasselblad H4D-40 Nikon D800E
URL www.hasselblad.com www.nikon.com
Digitization
Native resolutions (in pixels) 7304 x 5478 7360 x 4912, 5520 x 3680, 3680 x 2456 (36 x 24), 6144 x 4080, 

4608 x 3056, 3072 x 2040 (30 x 20), 4800 x 3200, 3600 x 2400, 2400 x
1600 (24 x 16), 6144 x 4912, 4608 x 3680, 3072 x 2456 (30 x 24)

Sensor type, effective megapixels / Size / Self cleaning CCD, 40 million / MF ( 43.8 mm x 32.9 mm) / – CMOS, 36 million / KB (35.9 mm x 24.0 mm) / v
Image format(s) / Compression rates / Video format RAW 3FR (16-bit), TIFF (8 Bit) / 1 / – RAW, TIFF, JPEG, RAW+JPEG / 3 / MPEG-4 H.264
Video: Max. resolution [pixels], length, fps n/a Full HD 1080p, 29 min 59 s, 30
Memory card type / Average file size1 CF / 52 MB (.3fr) SD(HC/XC) + CF I / 23.4 MB
Features
Crop factor (full-frame equivalent) / Bayonet 0.8 / Hasselblad H n/a / Nikon F (AF)
ISO settings 100-1600 in 1/1 increments Auto (200 – upper limit + longest exposure time up to 1 s programmable), 

(ISO 50) 100-6400 (ISO 25 600) in 1/3, 1/2 or 1/1 increments
Shutter speeds (s) / Default flash sync (s) 25-1/800 s / User-defined Bulb, 30-1/8000 / 1/250
Focusing / Image stabilizing AF (one-shot) / – AF (one-shot, continuous, tracking), MF / – (in-lens)
AF areas / Focus assist lamp 1  cross sensor 51 (15 cross sensors) or 1 (with 51 or 11 positions) or selected combinations 

(21 or 9) / v (white)
Metering: Matrix / Center-weighted / Spot – / Spot, Center-weighted, CenterSpot / v v (91,000 pixels) / v (4 metering area sizes) / v
Programmed auto / Scene modes / Custom presets v (with shift) / – / v (4 presets) v (with shift) / – / v (4 presets)
Exposure: Aperture priority / Shutter priority / Manual v / v / v v / v / v
Exposure compensation [EV] / Depth-of-field preview ±5 EV in 1/3, 1/2 or 1/1 increments / v ±5 EV in 1/3, 1/2 or 1/1 increments / v
Bracketing: Exposure / WB / Focus /  Interval timer / Sound v (highly configurable) / v / – / v / – v (highly configurable) / v (+ D-Lighting bracketing) / – / v

(+ time-lapse) / v (16-bit, mono2, 48 kHz)
Self-timer / Continuous shooting speed (JPEG/RAW)6 User-selectable from 1 s to 1 hour / 0.9 fps (unlimited) 20, 10, 5 or 2 s (1-9 shots, 0.5-3 s intervals) / 4.0 fps, 100 shots; 4.0 fps, 

100 shots (5-1 fps selectable)
White balance: Auto + Manual / Presets / Fine-tuning 2 auto + 4 manual / 12 / v (and Kelvin)
Sharpness, Contrast, Saturation adjustable / Color spaces v (Fine-tuning) / sRGB, Adobe RGB
Viewfinder: Type / Magnification / Coverage / Eyepiece distance Eye-level / n/a / 100 % / n/a Pentaprism / 0.7x / 100 % / 17 mm (with built-in blind)

Monitor:  Diagonal / Resolution (dots) / No. of brightness settings 3" / 460 320 / na 3.2" / 921 000 / 11 or auto
Live View / With AF using sensor / Dedicated sensors – v (5-30 min. or unlimited) / v / –
Body material / Control panel / Auto monitor rotation Metal / v (backlit) / v Magnesium, weatherproof / v (green backlight) / –
4-way selector / Multi selector / Command dials v / – / 2 v (8-way + center button) / 1 / 2
Flash guide number (ISO 100) / Charge time / Connector 12 / na / v (TTL shoe, X-Sync socket) 12 / 4.4 s / v (TTL shoe, X-Sync socket)
Playback
Multiple (# of images) / Zoom / Histogram 9 or 4 / v / v 72, 9 or 4 / v / v (with RGB)
Connectors /Dimensions
Power source Li-ion rechargeable battery Mains adapter (dummy battery), Li-ion battery, battery grip
Interfaces / A/V out / HDMI / Remote control FireWire (IEEE 1394b) USB 3.0, GPS IN / – (Stereo microphone IN, headphones) / v (type C) / v

(Cable)
Dimensions (W/H/D) / approx. weight (body only) 153 x 131 x 205 mm, 2290 g3 146 x 123 x 82 mm / 995 g
What’s in the Box
Manual / User guide User manual Quick start guide, User manual
Accessories HVD 90° viewfinder, digital back, Li-ion battery Li-Ion battery EN-EL15 (7.0 V, 1900 mAh, 14 Wh),

charger, body cap, flash shoe cover, transparent
monitor cover, shoulder strap, USB cable

Optional accessories Waist-level viewfinder, tilt/shift adapter, GPS receiver, flash adapter Memory cards, mains adapter + battery chamber
adapter, cable remote release, GPS receiver,
WiFi adapter, HDMI cable, microphone, angle finder,
Nikon system accessories

Software
Standalone software (platform) Phocus (Win/Mac) Nikon ViewNX 2 (Win/Mac)
Recommended retail price US$16,000 US$3,300
1 Average value, measured using largest native image size and best JPEG quality 2 Stereo via external microphone      3 Including HC 2.8/80, battery and CF card                              
v included                  – not included                  n/a not applicable c
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» Ultra-high-resolution Full-frame Cameras

Peter Nonhoff-Arps

Full-frame or
Medium Format?

Ultra-high-resolution DLSRs with full-frame sensors are beginning to
break into a market once dominated by medium-format cameras, so
it’s no wonder that the medium-format sector is developing fast to
keep up. The result is a two-pronged trend toward higher sensor
resolution and smaller, less expensive entry-level camera models.

The Nikon D800/D800E is the first of what is sure to be a new wave of
cameras with full-frame sensors and medium-format resolution.
Among the few others currently available are the
Sigma SD1 Merrill (see our multi-camera test in
Issue 9 of c’t Digital Photography) and the
Leica M9-M. Both are unique in their
own ways. Sigma claims sensor
resolution of 46 megapixels for
the Merrill, although this figure
is the result of adding
together the pixels from
each of the Foveon
sensor’s three layers.
These capture pixels for
each of the primary
(RGB) colors separately,
giving the camera ‘real’
three-color data for
each image pixel,
whereas ‘conventional’
cameras such as the
Nikon D800E or the
Hasselblad H4D-40
interpolate color data from
neighboring pixels using a
Bayer Pattern RGB filter located
in front of the sensor. Both of these
models do without the optical 
low-pass filter built into most DSLRs, thus
allowing more of the ambient light to reach the
sensor directly, but making them more prone to
producing moiré artifacts. While the Sigma camera’s sensor design
makes a low-pass filter  unnecessary, the image files it produces are

nevertheless ‘only’ 14.8 megapixels in size. Having said that, the data
they contain is not interpolated, so the physically measurable

resolution is comparatively high for the size of the files
involved (once again, see our test in Issue 9). Like the

Hasselblad H4D-40, the Sigma produces its best
results at low ISO sensitivity settings. The

Leica M9-M is a purely black-and-white
digital camera, constructed by

replacing the RGB sensor filter found
in its M9 sister model with a

colorless, optically transparent
filter. The resulting images
contain only grayscale pixels,
giving the camera’s firmware
more image data per pixel to
play with and increasing its
effective resolution. M9-M
image files measure
5212x3468 pixels (i.e., about
18 megapixels). The clear filter

also allows more photons
through, effectively increasing

the sensor’s underlying light
sensitivity and making it possible 

to shoot images of acceptable quality
at sensitivity settings of up to 

ISO 10 000. The camera is, of course,
compatible with the entire legendary range

of Leica M-series lenses, which also helps to
produce images with excellent sharpness and

dynamic range. The downside of all this quality is the price,
and the US$10,500 price tag for the M9-M with a standard lens is
definitely pushing into medium-format territory.

Leica M9-M



Full-frame vs. Medium Format | Market Overview

Pricewise, the Hasselblad H4D-40 (see page 18) is positioned between
the middle and the lower end of the medium-format scale. Hasselblad
offers the H-series body with a 60-megapixel digital back and 80mm
standard lens for about US$30,000. The H4D-200MS model delivers an
incredible 200 megapixels of resolution by capturing multiple shots
with its 50-megapixel sensor using the patented Multi-Shot capture
technology. This technique uses piezo-electric motors to shift the sensor
by whole or half-pixel distances within the RGB Bayer filter pattern
between shots. This type of camera is often used to capture photos of
works of art or motor vehicles that have to be displayed at more than
life size.

The highest resolution currently available in a conventional
medium-format digital back is the 80-megapixel (10 328x7 760) IQ80
offered by Phase One with a price tag of about US$40,000 for the back
only.

The Hasselblad H4D-40 with an 80mm standard lens like the one we
tested costs about US$18,000, or US$14,000 if you go for the
30-megapixel H4D-31 version. As a comparison, the 22-megapixel
Mamiya Leaf Aptus-II 22 costs about US$8,500 with a Contax 645AF
body but without a lens.

The Pentax 645D offers high-resolution medium-format
photography with a full-frame feeling. It has a 44x33mm 
(40-megapixel) Kodak CCD sensor and is light and compact compared
with many other medium-format cameras. Its handling is very similar
to that offered by the current K-series APS-C DSLRs, making it easy for
experienced photographers to switch formats. At US$12,000 with a
55mm lens, it is on a price level more comparable with some high-end
full-frame DSLRs than with the Hasselblad/Mamiya medium-format
segment.

Analog medium-format systems such as the Hasselblad V series can
be upgraded using the 50-megapixel CFV-50 digital back for about
US$14,000. The Mamiya Leaf Aptus-II back is available with various
resolutions for a range of 80 different medium-format camera
bodies and costs about US$8,000 for the 22-megapixel
version for Mamiya 645 or Hasselblad H1 bodies.

» Medium Format
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Pentax 645D

Phase One IQ80

Hasselblad H4D-200MS
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The price differential between full- and medium-format lenses is
roughly commensurate with the differences between body prices.
High-quality Nikon or Zeiss lenses cost about US$1,000-2,500,
whereas equivalent medium-format lenses cost double that and
more. Hasselblad’s ‘standard’ 80mm HC 2.8/80 lens is relatively
good value at US$2,600, while the HC 4/120 II macro lens goes
for US$5,000 and the HCD 4/28 ultra-wide-angle comes in at
about US$5,300. Mamiya lenses cost about the same as their
Hasselblad counterparts, while Pentax medium-format
lenses are a little cheaper but don’t have such wide
maximum apertures. The Pentax 645D is compatible with
older, analog Pentax medium-format lenses, which can
often be found at bargain prices on the used market.

See also
Dr. Klaus Peeck, SLR and System Camera
test,  c’t Digital Photography, Issue 9, p. 18 ff.

» Lenses

Leica’s S system is positioned right between full-frame
and medium format. The body looks like a slightly
oversized full-frame DSLR and contains a
37.5-megapixel sensor that measures 45x30 mm,
which is about 60 percent larger than a full-frame
sensor. Leica also offers a range of S-compatible
lenses with focal lengths between 30 and 180 mm.
At US$23,000, the S2 body is not exactly a bargain,
but is nevertheless a sure-fire provider of high-end
Leica quality.

» Between Two Worlds

Full-frame vs. Medium Format | Market Overview

The Leica S2’s sensor measures
45x30mm, giving it a classic 3:2 
aspect ratio

The Hasselblad HCD 4/28
ultra-wide-angle has a very wide
maximum aperture setting of f4

c’t Digital Photography 10 (2013)
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to the techniques of the pros 

Keep on top of the latest trends and get your own 
regular dose of inside knowledge from our specialist 
authors. Every issue includes tips and tricks from 
experienced pro photographers as well as independent 
hardware and software tests. There are also regular 
high-end image processing and image management 
workshops to help you create your own perfect 
portfolio.

Each issue includes a free DVD with full version 
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Torsten Andreas Hoffmann 

Relationships Between Shapes 

Composition 
in Black and White



Although black-and-white photography
has to make do without the richness 

of the color spectrum, it has always 
been considered more artistic than 
color photography. One of the defining
characteristics of black-and-white
photography is sparing, almost ascetic use 
of  sensory stimuli.

The guiding force behind black-and-white
photography is the language of form, which
is governed by laws that almost all human
beings regard in the same way, for they arise
from the way we perceive the world around
us. Mastering this language, which inhabits
every image like a governing principle, makes
it easier to compose powerful images. As you
will discover, visual language operates quite
differently from spoken language, which is
constrained by time and expresses events in
sequence.

Visual language communicates directly. In
an instant, we comprehend the heart of an
image in its entirety. It is less rational than
written language, but more emotional and is
the ideal medium for expressing emotions.
For photographers, this entails relying more
on intuition, or ‘gut feeling’, than intellect.

Nevertheless, we still need to know and
understand artistic principles and internalize
them by carefully analyzing the results of our
own work, so as to become more fluent in
visual language. Likely as not, we do not speak
it perfectly yet. Cultivating the habit of
analyzing your work willl automatically help
you to create better compositions.
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Taking photos in black and white involves reducing
everything to form and tones of black, white and gray. 
But how do you create tension in an image? Which rules
apply to the composition of black-and-white photos? 
The examples and discussion in this article will help you
produce more professional-looking monochrome images.



Those new to black-and-white
photography are frequently
disappointed because they still 
think in color rather than in black 
and white.

Reality clothes itself in many colors: the ‘blue
hour’ just before sunrise or just after sunset
has a magical effect, with the sky glowing

orange above blue-tinged buildings and
countryside. But beware of all this bewitching
color. All too easily, we forget that
black-and-white photography translates
colors into nothing but gray values. This fact
calls for a rethink and a fresh artistic take on
what we see. Instead of expressive colors, we
have to work with lines, textures and shapes
to bring vitality to our photos.

If you are still feeling your way, it can be a
good idea to make an occasional exposure in
black-and-white mode to help you see what
the subject looks like in black and white. But
remember to switch back to color mode
straight away and create your monochrome
images by converting them from color. This way,
you will have many more processing options  –
such as color filter simulation – at your disposal.

A New Way to Look at Things

Black and White Composition | Learning to See

The solution (below): The three
men create a shape that stands

out against the sky – a complete
contrast to the architectural
structure. Their almost black
silhouettes impart strength,
contrast and tension to the 

black-and-white image.

Notre Dame in the setting sun (above
right). Against the background of a

glowing orange sky, the cathedral and
the bridge are bathed in a violet so

enchantingly beautiful that it verges on
being overly sentimental. In black and

white, the same image comes out a
disappointing dirty gray, with not even

a hint of the original fairy-tale feeling.
To photograph Notre Dame in black

and white, we have to look at it
completely differently.



Black-and-white photographers have to
embrace the mystery of light. Of all the
aspects of photographic composition,
the relationship between light and
shadow is perhaps the most important.

Understandably, light is a very important
factor in composition. To capture it in color, it
is best to shoot early in the morning or in the

late afternoon and early evening, when light
has its warmest color temperature and is at its
most atmospheric. The middle of the day is a
bad time to take color photos, because the
light has a cool, clinical feel. However, you can
take black-and-white photos at any time of
day, because they depend more on the
interplay between light and shadow than the
color temperature of the light they contain.

The sky is often crucial to creating a certain
lighting mood, so you need to take careful
note of sky and cloud formations and include
them in your composition, especially when
photographing cityscapes and landscapes. In
backlit situations, polarizing and graduated
filters can heighten the magical effect of the
ambient light.
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The wonderful Piazza Colonna in Palermo with its
many statues can create a ‘ghostly’ feel if captured in
the right light, as shown in the photo below. The
composition of this photo is particularly intriguing
because the upper bank of clouds mirrors the
crescent-shaped view of the piazza. An untrained
observer would probably not have noticed this
correspondence between two elements in the image,
but it is one of the keys to the orderly look of the
photo and therefore crucial to its composition.

Black and White Composition | Light

The Right Light



The visual content of any good photo 
is based on an abstract structure, a
pattern of some kind. It is this pattern
that determines whether the image
looks interesting or lackluster, chaotic
or orderly.

The same artistic rules that apply to painting
also apply to photography, although
photographers have to work quite differently

from painters, because they cannot simply
invent their subjects or arrange them any
way they like. Instead, they have to select
from what is available, and sieze the moment
using a powerful composition and  a wide
frame (i.e., a wide-angle lens), a medium
frame (a standard lens) or the small frame
created by using a telephoto. Consider every
photo critically and ask yourself, would a
painter have composed a painting in the

same way? Is there anything distracting or
superfluous in the photo? Are there elements
that detract from the main message? The
quality of a photo is determined to a very
large extent by the way the individual
elements relate to each other. Often all it
takes to transform a weak image into a
powerful one is simply to step a few meters
to the left or right, to bend down a little or to
use a different lens.
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Black and White Composition | Differing Viewpoints

The distribution of the hay bales within the
frame makes the photo above balanced and
interesting, while the one on the left appears
not to have been composed at all and is
quite dull. The arrangement of the hay bales,
their differing proportions and the unusual
shapes of the trees on the horizon create
agreeable visual tension. The line of trees is
an important element, and is based on the
basic framework of elements that governs
the golden ratio (see the next page).

Image Composition
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The ‘golden ratio’ has been used since
the times of the Ancient Greeks to
describe particularly harmonious
proportions in the layout of an image.
The golden ratio creates a framework
of elements which form the basis of
many well-composed images.

Good image composition involves arranging
the visual elements within the frame in such as
way that the viewer experiences both harmony
and visual tension, but not monotony.

One particularly harmonious visual
arrangement is the ratio 1:1.618, also known
as the golden ratio. If you divide a straight line
using this ratio, the relationship of the longer
part to the shorter part is the same as that of
the longer part to the entire line.

Along with its two axes of symmetry, the
lines that divide an image vertically,
horizontally and diagonally using this 
ratio (i.e., roughly 5:8) form a basic framework
that can be used to aid photographic image
composition (see the diagram below).

However, care is required when using
these lines to compose an image, and
adhering to them strictly can produce images
that look rather static. Aligning some but not
all of the individual elements in a photo with
some of these lines helps to achieve a clear,
well-structured visual impression. Advertising
photographers often use this framework to
compose their images, making the results
easy to interpret quickly – an important
consideration when shooting photos for
billboards. 

The Framework of an Image

Black and White Composition | The Golden Ratio

Comparing these two photos shows how
subtle but effective use of the framework

created by the golden ratio can be. Placing
the horizon in the center (above right)

makes the dark sky look too heavy because 
it takes up more of the space within 

the frame. Both photos were taken on a 
beach in Ireland with a 200mm 

telephoto lens and were deliberately 
underexposed to prevent the highlights 

in the ocean from burning out.
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Black and White Composition | Static vs. Dynamic

If an image is oriented to the vertical
and horizontal lines of the golden
ratio’s framework, it is generally
considered to be ‘static’. If it is
oriented to the diagonals or other
slanted lines, it is referred to as
‘dynamic’.

Static compositions are usually shot 
using telephoto lenses. In architectural
photography, for example, static composition

ensures that almost all the visible lines are
vertical or horizontal. Wide-angle lenses
achieve the opposite, and produce oblique
vanishing lines and distort the look of a
building if you don’t take care to position the
image plane perpendicular to its surface.
Wide-angle lenses are a great tool for creating
dynamically composed images.

Static images are easier to recall. As an
experiment, have your friends look from
behind through the focal plane shutter of an

analog camera  (without film inside)  set to
1/60 s. Place a statically composed image in
front of the camera followed by  a dynamically
composed one. Your friends will most likely be
able to tell you what they saw in the first
image (in spite of the very brief viewing time),
but not what the second image showed.

Contemporary documentary photographers
often combine  dynamic compositions with
motion blur to create edgy, energetic images
depicting troubled or troubling subjects.

This view of Midtown
Manhattan is a typical static
composition that emphasizes
the two horizontal golden
ratio dividing lines. The
horizon is on the lower
horizontal line and the
bottom of the blind is on the
upper one. The rest of the
image comprises almost
entirely vertical and
horizontal lines. A static
composition like this
emanates stability and calm.

Static and Dynamic Composition

The image on the right shows a
typical dynamic composition,

oriented primarily to the positive
rising diagonal of the golden
ratio  framework, but also to

other oblique lines. In this case,
the composition emphasizes the
subject’s movement and creates

an impression of speed and
energy without any obvious

points of stability or calm.



Specific shapes embedded in the
content of an image, such as the
triangular shape in the image below 
are known as ‘super signs’.

Super signs are usually only perceived
subconsciously. People are not usually
aware of them when looking at an image,
but they are nevertheless very effective – a
phenomenon that the advertising industry
often puts to good use. An isosceles 

(or right-angled) triangle is one of the  
best-known super signs, and is a particularly
good shape for creating visual harmony.
Roofs in classical architecture are often
constructed using Isosceles triangles as their
basic form.

Triangular photographic super signs can be
either clearly defined or simply hinted at. Like
the golden ratio, super signs order an image
and give it a harmonious feel, although again,
overuse can produce inert-looking images.

Caspar David Friedrich, a German
Romantic landscape painter, incorporated
triangular shapes in many of his famous
paintings, especially in cloud formations. 

The art of great image composition is to
integrate such visual elements into an image
so that they have a positive effect while
remaining just below the threshold of
people’s conscious awareness.

The easiest way to create a triangular composition is by using the vanishing point
created by almost any path or road. If you position yourself in the middle of a
relatively straight road, one-point (or ’vanishing point’) perspective will almost
always make the road appear to form an Isosceles triangle – provided you don’t
use too powerful a telephoto lens. In the photo on the left, the sandy ground
between the two freshly surfaced lanes of a freeway creates exactly this kind of
triangular motif.

Artistically speaking, this image derives its spark from the imperfect symmetry
caused by the vanishing point  disappearing right of center and from the varying
distances to the approaching camels. If the image had been composed so that
the two vertical halves mirror each other symmetrically, it would have appeared
rigid and lifeless.

Super Signs

Black and White Composition | Super Signs
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Black and White Composition | Rhythm

Just like a piece of music, an image can
have its own innate rhythm that
determines its basic structure and the
way space is allocated within the frame.

Rhythm generally refers to the recurrence of
similar patterns. In music, this obviously refers
to the tempo and rhythmic structure dictated
by the composer, whereas in nature, it may be
the changing seasons. In order to bring
rhythm into a visual composition you have to
view its content in an abstract way and learn
to use the language of form so that you can
play it like a musical instrument. Rhythm in
photographic images means including similar,
repeated elements within the frame. Constant
repetition of just a few, similar elements
makes an image much more powerful.

In this photo of the top of the
Chrysler Building in New York, the
rhythm comes from the repetition 

in the small triangular windows, 
the lines that surround them and 

the arches that extend left and 
right like palm leaves. The visual 

tension is created by the 
differences between 

these rhythmically repeated 
visual elements.

Image Rhythm

Rather than simply explaining digital
technology, The Art of Black and White
Photography, published by Rocky Nook,
emphasizes the intrinsic and artistic
aspects of photography. Among his many
topics, the author explores architectural,

street and surreal photography as well as
the art of photographing people.

Price: US$44.95
ISBN: 978-1-933952-96-3
www.rockynook.com

The Art of Black and White Photography
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Black and White Composition | Creating Tension

A mistake that beginners often make is
to place the subject in the center of the
frame. This often produces dull photos
and is a waste of a great opportunity.

The way modern cameras are constructed
tempts us to place the subject in the center
of the frame, but there are often other,
better ways of composing an image and
creating tension. Every photographer should

practice deliberately positioning the main
subject of a photo at the edge of the frame
while searching for a counterpoint to place
in the opposite corner (see the photo
overleaf).

It is not always wrong to place the subject
centrally, but if you do, make sure the rest 
of your composition matches, perhaps by
using vanishing-point perspective. The
effectiveness of this type of composition

comes from the fact that it draws the viewer
into the center of the image.

Compositions that emphasize the center of
the frame automatically utilize the power of
symmetry. Symmetrically composed images
often have a powerful, traditional feel, but can
be quite stiff and static. As a rule, the farther
the composition takes the emphasis away
from the center of the frame, the more
unconventional its effect will be.

This portrait of an
Indonesian rice farmer
was composed
deliberately with the
subject’s face in the
center. The nose
accentuates the vertical
axis of symmetry. A
centralized, symmetrical
composition like this
underlines the archaic
effect of the image – an
effect that can be used
to give a subject a
spiritual or almost
sacred look.

Image Tension and the Center of the Frame

1. Shoot in color and convert your images
to black and white later.

2. Shoot in RAW format. Among its many
advantages, RAW provides better tonal
gradation and less noisy sky during
conversion to black and white.

3. Use a polarizing filter rotated to 90
degrees in sunlight and lateral light. This
increases the contrast between the clouds
and the sky.

4. Use a two- or three-stop graduated gray
filter when shooting the sky in backlit
situations. This evens out the extreme
differences in lighting between the sky and
the foreground or background.

5. Converted black-and-white images
require increased contrast in comparison
to their color originals.

6. If you convert your images using
Photoshop, be sure to try out the built-in
color filter functions. The Yellow filter

preset, for example, gives landscapes a
mystical air.

7. When processing, work on one part of
the image at a time, and use the Dodge
and Burn tools to brighten or darken
selected image areas. Or better still, select
the parts of your image that are too dark or
too bright using the Polygon Lasso with a
feather setting between 100 and 250 pixels
before performing any adjustments
(brightening, increasing contrast etc.).

Tips for Shooting Better Black-and-white Photos
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Black and White Composition | Creating Tension

It is the visual tension between the two monks that makes this image come alive.
The monks were deliberately placed at the extreme right and left of the frame
and are even slightly cropped. This leaves most of the frame quite empty and
bathed in blur. Nevertheless, the intense eye contact between the two subjects
completely fills the frame. The photo was shot at a Buddhist monastery in Nepal.
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Black and White Composition | Creating Tension
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Black and White Composition | Image Balance

Statically composed images are usually
automatically balanced. When
composing images dynamically,
however, it is important not to lose
your artistic balance.

We have seen that a considered composition
gives a photo interesting, sometimes  abstract
foundations. This basic structure can take on
many forms oriented around the golden ratio,

using super signs, or based on static, dynamic
or rhythmic patterns.

One thing is true no matter which type of
composition you opt for: the basic structure
that underpins an image must be in balance
and shouldn’t ‘tip’ too far in any direction. 
The visual rules governing various formats
predetermine the outcome to a certain
extent: the familiar horizontal landscape
format tends to produces static-looking

images, while portrait-format images are
more dynamic, and are more susceptible to
becoming top-heavy. Combining portrait
format with a dynamic composition often
produces an overall image structure that can
quickly get out of kilter. If that happens, it is
often difficult to judge image balance just 
by looking through the viewfinder, and you
will need to make some test shots to help
fine-tune your composition.

Balancing an Image

This photo is a dynamic composition,
invigorated by a large number of slanting

lines. Due to the use of a powerful
wide-angle lens, almost all the basic

shapes and lines are on a slant, yet the
image is balanced. All the leaning

buildings create movements that balance
each other out (see the red lines in the

diagram above). The tall building at the
extreme left of the picture, although

‘falling’ to the right, is counterbalanced by
the air shaft in the center, which is leaning

to the left. Since both of the buildings at
the bottom are leaning slightly to the left,

the composition needs something to
counteract this movement. This is

provided in the form of the right-leaning
pointed black triangle at the top. The

overall result is a well-balanced picture.
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Black and White Composition | Image Balance

If we crop the photo from the preceding
page, it appears to be leaning toward the

left, although it remains balanced
(above). Now, if we flip the cropped

photo, we make an amazing discovery:
the result (shown on the right) feels
much more out of balance than the

original photo. The explanation for this
subjective impression is simple: in the

Western world, we ‘read’ images from left
to right. This means that the ‘tip’ in the

original image is counteracted by the
movement of the viewer’s eye from 
left to right, while the flipped photo 

tilts completely out of balance.

Torsten Andreas Hoffman was born in
1956 in Düsseldorf, Germany, and trained
as a photography and art teacher at the
Institute of Fine Arts in Braunschweig.
Photography has taken him to India,
Indonesia, Mexico, Nepal, Turkey, the
United States, the Sahara and the United
Arab Emirates. His work has been seen in
numerous exhibitions at high-profile

galleries and in more than 20 coffee-table
books. He has been published in German
magazines like Geo, Merian, Chrismon,
Photographie, Schwarzweiss and mare, as
well as in international magazines such as
Digitalis Foto in Hungary. He has worked
extensively in New York and has
published two art calendars and three
books of photos of the city

Hoffmann is a member of the LOOK and
BBK photo agencies and was appointed a
member of the German Photographic
Society (DGPh) in 2006. He lives in
Frankfurt am Main and Goslar.
He was nominated for the German Photo
Book Prize in 2008 and won a Silver 
Medal at the International Calendar Show
in 2009.

About the Author



60 c’t Digital Photography 10 (2013)

Black and White Composition | Reduction to the Minimum

Another mistake that beginners make is
trying to cram too much into a photo. It
is always worth taking a ‘less is more’
approach to image composition.

Reduction is an important creative tool in
contemporary art. Piet Mondrian, like many
other painters, moved farther and farther
away from the world of complex images
toward ever simpler forms. The Russian artist
Kazimir Malevich painted the first
monochrome painting at the turn of the 20th

century. This approach is also seen in
contemporary photography: Japanese
photographer Sugimoto created a series of
marine images in black and white in which the
only contrast to the monochrome sky is the
sea. Sugimoto reduces his compositions even
farther by positioning the horizon in the
center. This is a great example of how you can
break the rules once you have learned them. It
is a very useful exercise to limit your
compositions so that they contain a minimum
of elements.

The best way to get to that point is 
to follow Andreas Feininger’s advice and
“explore the subject”. Say you want to
photograph an interesting house: Feininger’s
recommendation was to walk right round the
house first to discover the angles from which
it reveals its true essence. It always pays to
give yourself plenty of time to take your
photos, and to spend enough time looking
through the viewfinder in order to reduce the
subject to its essence.

The Quest for the Essence of a Subject

The essence of these dunes in the Sahara is
their serpentine flow and the interplay

between light and shadow. To really bring
this out, the photographer had to wait

until just before sunset and then search
the view until a clear composition that

captured the essence of the desert
became apparent. In the final image

(right), the three prominent curves and
their shadows ‘make’ the picture,

depicting a clear, reduced form. The
smaller image (above) lacks this clarity and
reduction. The sheer breadth of the scene
is clearly evident in the photo on the right

without actually becoming the main
theme. These two photos were shot 
using a 28mm lens within 20 meters 

and an hour of each other.
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Black and White Composition | Creating Moods

A really successful photo is not only
well composed, but also has a ‘certain
something’ that expresses the way the
photographer experienced the scene.
The vitality that a photo projects is
connected with the inner energy that
you tap into during the shoot.

There is little point in taking a purely analytical
approach to black-and-white photography.
On the contrary, renowned black-and-white

photographer Robert Haeusser is absolutely
right when he recommends that
photographers should travel the world and
seek out the places that truly interest them.
He believes it is essential to break free from
the idea of working through a conventional
list of ‘must-see’ attractions. Instead, follow
your instincts like a divining rod and allow the
camera to linger where it wants. If your gut
feeling tells you to photograph a ramshackle
backyard, it is perfectly OK to ignore the

magnificent building opposite. Potent photos
will only ever come from places that conjure
up genuine enthusiasm.

It is impossible to explain why this is so,
but it is nevertheless one of the secrets of
great photography. Applying technology and
the rules of composition has to become
second nature if you are to create truly great
images, but these tools are nevertheless just
the icing on the cake of a photo shot with real
conviction. (keh)  c

Black-and-white photography finds its voice thanks
not only to graphic lines, but also to strong

contrasts and deep black shapes. Take these photos
of a village in Sicily, for example. The one on the

right is lifeless because the tonal values are
distributed too evenly throughout the frame. The
solution is to embed the same composition in the
deep black frame of a wall in the foreground. The

resulting image (above) radiates a lot more energy
because the blackness of the wall creates the

impression that the village is glowing. These images
clearly show how only a few steps or a few seconds
can make the difference between a powerful photo 

and a lifeless snapshot.

Sensing and Capturing Atmosphere
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Doc Baumann

The Big View from Below
If you want to make small objects loom large in a montage, you have 
to photograph them with the end result in mind. This workshop
explains what to look out for when shooting and processing images
shot from a low viewpoint.



Occasionally, we come across montages
in which small objects look much larger

than they actually are – a toy dinosaur
inserted into an image to look as if it is on the
prowl between skyscrapers, for example.
Sometimes, shots like this fail due to the
incorrect direction of the incident light,
differences in surface texture or inappropriate
shadows, and many don’t work because the
perspective of the source image simply
doesn’t fit with that of the new background. 

Usually, you only see the parts of a statue
like the one shown here that are visible from
the front at eye level. You view the foot of the
pedestal from above and, logically, you look
up to view the statue located on top of it. 
The simple conclusion to be drawn here is
that in order to make small objects appear
larger than they actually are, you need to
photograph them from below – or, in other
words, from the position you would have to
be in to view an object that really is as large as
you want to make your subject look.  If you
shoot with your camera positioned on the
ground, you will unavoidably leave the lower
parts of your subject out of the frame. This
means it is necessary to go a step further and
ensure that you can photograph your subject
from below its base level. The following pages
describe some examples of this type of image
and give some useful tips on how to shoot
and manipulate them effectively.

Image Processing | Perspective Montage

This is the original image – the montage is shown opposite

Our tip: A suitable shooting angle helps to
make a montage look realistic. Decide in
advance which background you want to use
(in this case, the pedestal), and adjust
perspective in your source image
appropriately. The shooting angle for the
statue in the far right-hand montage shown
here was too flat, and makes the statue
appear to tip forward. In the other example,
it was too shallow and makes the statue
appear to tip backward.
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The large, classical sculpture on the left is
located on a bridge in Berlin. The bronze figure
on the right is only about 40 cm tall and was
set up so that the direction of the incident light
was virtually identical to that in the original
image. To achieve the correct shooting angle, I
put the figure on a piece of board balanced
between the rungs of a ladder and shot lying

on the ground looking upward (keeping my
fingers crossed that the figure wouldn’t topple
off its perch in my direction). It is always tricky
to precisely judge shooting angles while
looking through the viewfinder, so it is a good
idea to take several versions of shots like this at
slightly different angles and with slight
variations in the horizontal camera position.

1 Replacing the statue in a classical sculpture

Image Processing | Perspective Montage

Our tip: To achieve the correct
perspective, take a print of the
background image with you and draw in
the angle you wish to duplicate (see
below). In this case, the square pedestal
makes it relatively simple to compare
angles and shoot appropriately.



4 Making sure the surroundings
look right
The charm of this example lies less in
matching perspective and more in the
challenge of harmonizing the lighting
conditions in the two images. We could have
reproduced the shadows of the leaves
digitally on a separate layer, but it was much
simpler to photograph the statuette under a
fruit tree and directly insert the resulting
selection. We also experimented with the
color of the light to account for filtering and
reflections caused by the leaves. Although the
statue in the original image (above) displays
no obvious green tones, we found that using
the Image > Adjustments > Match Color
command helped to give the finished image a
more cohesive look .
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Image Processing | Perspective Montage

The next step is to fill the background around
the inserted object – for example, using Layer
> Fill > Content-aware (see the tip opposite).
The selected replacement figure is saved on
the clipboard. The pedestal in the original
photo is then selected and the selection
inverted before using Edit > Paste Special >
Paste Into to insert the statuette. This step

automatically creates a layer mask that hides
the pedestal. The mask is not linked to the
layer’s own pixels, so we can move and scale
it at will to locate it behind the pedestal. Once
these rough adjustments have been made, we
can fine-tune the image and make any
necessary color changes.

2 Inserting and adapting the new object

Our statuette’s square baseboard doesn’t
help if the original image was shot from a
frontal frog’s-eye viewpoint like the one
shown here. In this case, there are virtually
no tangible elements that can be used to
directly compare the two images, so we have
to judge perspective by eye. The alternative
is to measure the distance and the angles
involved by hand – although I am fairly sure

that I would have provoked some opposition
if I had tried to lean a ladder up against 
the monument to Giordano Bruno on the
Campo dei Fiori in Rome (on the left) and
attempted to measure it with my carpenter’s
rule. In this case, even the photo taken from
the steepest possible angle wasn’t sufficient
to produce a realistic-looking montage (on
the right).

3 Extreme Worm’s-eye View
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Image Processing | Perspective Montage
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Our tip: Content-aware Fill is an
impressive tool that was introduced with
Photoshop CS5. Any anomalies it
produces in the resulting image areas
can be easily repaired using the Stamp
tool. Make sure that you only select areas
that you really want to fill, as the tool also
takes ‘inappropriate’ neighboring pixels
into account (see below). If we exclude
the pedestal completely, only the sky is
used for the fill (bottom).

We were able to use the outline of the castle
and the pine forests surrounding it as a hard
border between the foreground and the
background, but we used a mirrored soft
transition to separate Rome from its new
surroundings. Applying a slight soft focus
effect to the ‘mountains’ makes them look

more realistic, and the overall feeling of depth
can be enhanced by brightening the scene
slightly, reducing contrast and adding a slight
blue tone. Finally, we used the Photoshop
Puppet Warp tool to correct the tip in St.
Peter’s Square caused by the wide-angle lens
used to take the original photo. (jr)  c

5 Do-it-yourself Mountains
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Our tip: The best way to produce a misty
transition is to use a reflected gradient
drawn vertically with the help of the
Shift key on a separate upper layer. The
gradient and its layer mask are easier to
see against a black background than
they are against the real Berlin skyline
(below).
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Alexander Jansen

Making the Most of

Handheld Long Exposures
This article explores the fundamentals of marksmanship and how they can be
applied to improving your photographic technique, especially when shooting long
exposures without a tripod. With a little practice, the tips and tricks outlined here
will help you to learn how to remain flexible with a camera in your hands and will
help you to instinctively take on stable shooting positions.



Recently, a photographer friend expressed
his frustration with electronic vibration

control systems – they are a fine invention,
but simply cannot replace a steady hand. This
article provides a unique, in-depth tutorial on
how to improve your physical technique for
shooting handheld long exposures.

Although my friend was referring to
shooting 1/8-second shutter speeds using a
medium (70-200mm) telephoto lens, I have
produced great results at 1/4s with my  
80-450mm (equivalent) lens set to its long
end, admittedly with shake reduction

enabled. The following pages take a look at
how marksmanship training can be adapted
for use in the world of photography, and will
teach you how to ‘shoot’ your camera like a
high-end rifle. At the end of the day, the
fundamental approach is the same in every
respect. If you have already learned how to
shoot a gun, you will probably do many of the
things we will be discussing without even
thinking about it: position, breathing control,
aiming and sight picture and, of course,
shutter squeeze. Let’s take a look at the
details. 
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Hand Position
For the sake of clarity, the explanations on the
following pages assume that everyone shoots
right-handed in accordance with the
ergonomics of most currently available DSLR
cameras.

When you shoot normally (i.e., using
exposure times of 1/50s and faster), you won’t
have to follow these particular tips quite so
stringently and the majority of the camera’s
weight will be supported by your ‘trigger’ (i.e.,
right) hand. More specifically, the center of
mass (i.e., center of balance) of the camera is
at the body end. This is why long lenses that
require the use of tripod collars – 400mm
primes, for example – have their collars
positioned way out toward the front element
of the lens. Basically, you use your right hand
to support the weight of the camera/lens and
your left hand to zoom and/or focus, but
primarily to aid stabilization. In this case, your
left hand actually bears very little weight.

When applying these fundamentals to
slow, handheld exposures, you have to
switch the basic position. This means that
your left arm supports the weight of the

camera – not only by keeping it elevated, but
also by pulling it tight into your shoulder. If
your lens is large enough, open your hand so
it is palm up and allow the lens barrel to rest
on your open hand. The heel of your hand
should be positioned just in front of the lens
mount, so that your main point of support
(think of the part of your hand that bears the
most weight when you do a push-up) is
under the camera body itself (fig. 1). Use your
trigger (shutter) hand to pull the camera
back until it presses firmly on your face with
your eye positioned at the viewfinder.

Elbow Position

Unlike the old John Wayne movies in which
they have you believe the proper way to shoot
is with your elbow cocked to the side (an old
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Hand, Elbow, and 
Standing Positions
If you hold the camera correctly, you can use surprisingly 
long exposure times in a standing position without producing 
unwanted blur. In these cases, an important and often 
underestimated factor is the way you position your arms.

Fig. 1: Use your left hand to support the weight of the camera and, if your lens allows, rest the lens barrel on the
palm of your open hand. The heel of your hand should be positioned just in front of the lens mount. 

Fig. 3: This is a free-standing
position. It differs from a braced

position (see page 74) in which
your legs don’t significantly

contribute to your overall stability.



Army doctrine) it is, in fact, more effective to
point both elbows downward and pull them
in tight to your body. Once again, if you are
shooting using ‘normal’ exposure times, you
should use whichever shooting position is
most comfortable.

Figure 2 illustrates the hand positioning
described earlier. My hand is open and
elongated along the entire length of the lens
starting with the heel positioned where the
camera body and lens meet. Leaning down a
little and pointing your elbows in toward your
stomach further restricts vertical movement
and provides added stability.

Standing Position

When there is nothing to brace against and
you have to stand, arch your back a little (if you
are familiar with weight training, think
Olympic lifts), and lean into the camera, as
described for ‘Sitting Positions’ below. This is a
very stable position. My feet are spread slightly
wider than shoulder width, and my training in
boxing and mixed martial arts has taught me
to take on a ‘lower and wider’ default stance
than I would otherwise adopt. You may find
that spreading your feet even wider proves to
be more stable or comfortable, which in turn
leads to more stability. Experiment with both.

Another version of the standing  
self-stabilizer was taught to me when I was
learning how to shoot long distance (300m
and more) standing up with a rifle. I prefer this
position for technical reasons (not just because
it makes my butt look fantastic), and I call it the
“Torso-Turn-Hip-Point“ (fig. 4). I don’t know the

correct terminology, but my own term works
for me as a way to explain it.

Starting in a normal standing position,
rotate your torso to the left while keeping
your feet firmly planted so that they are
perpendicular to the direction you are
‘aiming’. Then point your hips toward your
‘target’ (i.e., to the left). You should feel most
of your weight on your left
foot and your left hip will
experience a deep stretch.
Tuck in your left elbow so
that it points directly down
to your left hip,
remembering to keep
your arm flush against
your body.
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Fig. 4: Another version of
the standing self-stabilizer
was taught to me when I
was learning how to shoot
long distance standing up
with a rifle. I call this the
“Torso-Turn-Hip-Point”.
It can be tricky to 
learn but is worth the
practice.

Fig. 2: The left-hand photo shows the position my elbows naturally take on, whereas the one on the right
shows the technique I use when I am shooting to get the most of the available light using long exposures.
In this case, my elbows are pointed downward and my forearms are resting on my chest.



Kneeling Position

Let’s imagine the weather is fine and that
there is no danger of dirtying up your slacks,
so we can practice ‘taking a knee’. The basic
kneel position is shown in fig. 5.

Note how my left arm supports the
weight of the camera and is itself supported
by my left knee, which has a strong,  
flat-footed 90 degree plant on the ground.
Notice as well how far forward I am leaning.
The elbow position is one aspect of a
kneeling position that a lot of people get
wrong. Note that my elbow joint is not
resting directly on my knee – instead I have
the meaty part of the back of my arm (the
tricep muscle) resting on my knee. Some
people prefer to point their left arm straight
forward rather than canted toward the
inside like mine, but this is a matter of

personal preference. And,
while we are on the subject
of not putting ‘bone on
bone’, fig. 6 shows how not
to shoot while kneeling.

Don’t just believe me on
this – test it! If you adopt the
stance shown in fig. 6 and roll
your elbow joint around a
little, you will immediately
see how unstable it is.
Now do the same test
after resting the
meaty part of your
triceps on your knee as
depicted in fig. 5. 

There are two positions for your back foot.
You can either leave it free or let your weight
settle and sit on it. The latter position is
technically more stable, but I find it
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Kneeling and 
Sitting Positions
Every photographer should master kneeling 
and sitting positions. It is important to remember 
that you can only hold your camera steady if you 
position your body effectively first.

Fig. 5: Kneeling position. The left arm
supports the weight of the camera and is
supported by the left knee, which has a
strong, flat-footed 90-degree plant on the
ground.

Fig. 6: Some people prefer this direct
elbow-to-knee position, but it simply isn’t
useful in photographic situations

Fig. 7: You can either use your back foot as a free-standing support point
(left)  or lay it flat and sit on it for extra stability (right)



uncomfortable. I like to lean forward when I
am kneeling and I can’t do this comfortably
while sitting on my foot. Again, experiment
with both positions – you will quickly find out
which feels more natural to you.

Sitting Position

The sitting position is intrinsically more stable
than standing or kneeling because your
center of gravity is lower and more of your
body (your ‘fourth point of contact’) is in
contact with the ground. This position is also
less obtrusive if you wish to remain unseen.

Sometimes you simply cannot adopt a
standing position. I found myself in this
situation while attending a Cirque du Soleil
performance. It was dark and I was in the
middle of the audience, so I couldn’t stand up
or get up on one knee and simply had to deal
with the situation as it was. But that is the
beauty of knowing about all these different,
stable shooting positions – you remain
flexible and you can choose the position that
works best in any given situation, thus making
you a more adaptable (and successful)
photographer.

As with the keeling position, when sitting
you should avoid bone-to-bone contact. The
only difference here is, instead of resting your
triceps on your knee, you need to rest both
elbows on the meaty part of your calves. You
can also go above the knee and put your
elbows on your thighs, although I prefer
doing it the way I have shown in the
illustration because, once again, it allows me
to ‘lean into the camera’.

To further maximize stability (or if you
found yourself asking, „What calves?“), put
your feet together and, instead of putting
your elbows on your calves, rest your forearms
along the insides of your legs.

Notice it is no longer your elbows, but
instead your triceps resting on your shins that

give you support. Note also that in this
position, my back takes on exactly the same
shape here as it did in the kneeling position.
The fundamentals remain the same
throughout. I know this is getting
monotonous, but there is nothing the military
does better – repetition, repetition, repetition!
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Fig. 10: Maximum stability in a sitting position is achieved by leaning
forward. In this position, the major source of support is the contact
between your triceps and your shins.

Fig. 8: The sitting position is the most
stable of all, and I can use it all day long.
Instead of resting your knee into your
triceps, you rest both elbows in the meaty
part of your calves.

Fig. 9: To further maximize stability, put
your feet together and rest your forearms
along the insides of your legs. And, if you
are ready to go the extra mile, you might
like the increased stability provided by
leaning completely forward.



Wall Lean

Let’s assume that you are in an indoor
situation in a 16th century basilica and you
can’t get the organ pipes to stop dancing
across your image sensor. Simply leaning
against a wall will give you a lot of extra
stability. You can either shoot parallel to the
wall or you can twist your torso away and
shoot perpendicular to the wall’s surface. Just
like in the “Torso-Twist-Hip-Point“ position
described on page 71, I find facing away from
a wall more stable if the situation gives me the
choice.

As you can see, in both cases I maintain a
light shrug. Nothing too dramatic, but
enough to help tighten my posture. Also, as
with every other position I have talked 
about so far (except for sitting), my elbows
are tucked in tight together against my
chest.

Elbow Hook

If there is a vertical column, fence post or
simply the end of a wall in the vicinity (or a
door frame like the one in fig. 12), you can
hook your elbow on the edge of it. In this case,
I am shooting through a doorway while
stabilizing my entire body with my elbow. Like
many of these positions, an elbow hook is by
no means perfect, but it still helps if it is the
only solution available.

In case you didn’t notice (it’s OK, I didn’t
notice either until I reviewed fig. 12 at the
editing stage), my body is not leaning on the
wall. You can lean on the wall if you want, but
if you do, bear in mind that you will be
reaching even further along it with your
elbow. Another alternative in similar
situations is to lodge a corner of the 
wall, fence post or whatever in your armpit

and squeeze, making a kind of impromptu
vice.

Monopod and Bipod

Another popular and very effective means of
stabilizing is to use your elbow as a monopod.
You can plant it firmly on virtually any
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Bracing Techniques
This section focuses on several different ways to brace your 
camera and/or yourself against the different features of the 
terrain you are shooting in. Bracing is a real help, but the 
individual approach you take will depend on your location 
and your current shooting position.

Fig. 12: Shooting through a doorway. My
elbow stabilizes my entire body. This
solution is far from perfect, but still helps if
it is the only one available.

Fig. 11: Simply leaning against a wall
gives you a lot of extra stability. You can
either shoot parallel to the wall’s surface
(left) or you can twist your torso and
shoot perpendicular to it (right).

74



horizontal, flat, rounded, or even pointed
surface, whether this be the top of a fence
post, the back of a chair, a ledge, a window sill,
a railing, or anything else really. Using an arm
as a monopod support has helped shooters to
stabilize for centuries. 

Alternatively, use both elbows as a
‘bipod’. This technique is especially effective
if you are in a sitting position. As previously
mentioned, leaning into a position
maximizes stability (fig. 14). Notice the
increased spread of my elbows in the 
leaning variation. If possible, I try to
completely flatten my elbows, as shown in
fig. 15. I have had a lot of success using this
position.

If you flatten your elbows, you won’t, of
course, be able to maintain the wrist position
that allows your palm to support the bottom
of the lens barrel, so you will simply have to
experiment to find out which variation is most
comfortable and stable for you – elbows
flattened or the ‘leaning-forward-but-still-
upright’ position.

At this point, you might be asking
yourself why I don’t just place my camera on
the surface if I am so close to it anyway and
use the self-timer to release the shutter. 
This is, of course, a viable alternative, but
doesn’t work if the surface you are working
with is too thin to support your camera. In
such cases, you can still use it to create a
brace and capture that long exposure
handheld.

Shooting Through Windows

This an unconventional but really effective
brace that is similar to the elbow hook

mentioned above. If you have a ledge – 
for example an open window, a high 
table, or a bookshelf, you can use it to great
advantage. In fig. 16 I am using just such 
a ‘window’ (in reality the ladder of a bunk
bed) to brace myself.

Here, my elbow is sagging down because
I am squeezing the ladder rung into my
armpit to further stabilize my stance. If you
have access to a very wide ledge, laying your
elbow flat on the ledge surface is a great
solution too.  
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Fig. 13: Make a ‘C’ shape with your thumb
and index finger. With the camera firmly
planted alongside the ladder, use the ‘C’ 
to pull the lens toward the ladder, as if 
you were fastening them together. 

Fig. 14: An arm used as a monopod has
helped stabilize shooters for centuries. As
always, leaning into a position maximizes
stability.

Fig. 15: If possible, I like to spread my
elbows to form a super-stable ‘bipod’ 

Fig. 16: If there is an open window, a high table, or a bookshelf handy,
you can use it to create an effective brace. In this illustration, I am using
the ladder of a bunk bed as a makeshift ‘window’.



Breathing Control

Consider the trajectory of a thrown baseball,
an arrow shot into the air or an (unguided)
artillery round. What happens? As long as the
start and finish points of that trajectory have
the same elevation, the path the projectile
follows will always be perfectly symmetrical. 

At the top of the flight path, the
acceleration switches from positive (going up)
to negative (coming down). It is at this point
that the projectile completely stops all
movement and is ‘suspended’ in the air,
immobile for a fraction of a second before
gravity causes it to head back down to Earth.

Exactly the same thing happens at each
peak of your breathing cycle. Whether you are
at your most calm during a peaceful night’s
sleep or at mile 21 of your first full marathon,
your breathing is rhythmic, and the natural
pause in the respiratory cycle is most
pronounced at the very end of the exhalation
phase.

To put breath control into practice, begin
breathing slowly and in a controlled fashion.
The moment you have completely exhaled, hold
your breath – half a second later is when you
should aim to fire your camera’s shutter (fig. 17).

Most people find this to be the most
natural breathing rhythm, but there are
nevertheless two other major variations on
the method described. The first of these
involves an exhale-hold-exhale pattern. 
In other words, you hold your breath  
mid-exhale, take the shot and then continue
exhaling. The other method is the exact
opposite of the primary method described
above and follows an inhale-hold-exhale
pattern.

A few people prefer to hold their breath
right in the middle of the cycle. I don’t get
on with this method at all, but nothing
should hold you back if you are one of the
select few individuals who prefer this
approach. Still others prefer to hold their
breath with their lungs full of air, as this
gives them a sense of ‘fullness’ that
contributes to their feeling of stability. I
shoot my rifle in a standing position using
the exhale-hold-inhale method, but I switch
to the inhale-hold-exhale method when I am
prone (i.e., lying on my stomach), as I feel
better stabilized with my stomach and chest
fully expanded. Try them all – it won’t take
long to found out which breathing method
works best for you.

Aiming and Sight Picture

Sticking to shooting terminology, it is
important to get the same ‘sight picture’ every
time you raise your camera to your face to
take a photo. Try to find a place on your
camera that your nose can instinctively find
before every shot. I squeeze my right nostril
shut on the left edge of my camera with the
top of the viewfinder cup bisecting my right
eyebrow and pressed firmly against my eye
socket. Every time. Once you have found your
ideal position, you can then concentrate on
focusing and framing your shot as necessary.

Shutter Squeeze

Last but certainly not least is the final catalyst
to taking the photograph itself. When you
‘pull the trigger’ (i.e., release the shutter), 
you move the entire camera and cause it to
come off target in spite of the fact that you 
are aiming right at it. Your shutter squeeze
technique has to be just as calm and
controlled as your breathing. Squeeze it slow.
When shooting handheld long exposures, it
can take me as long as two whole seconds to
push down and activate the shutter button.
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Breathing Control, Aiming 
and Shutter Squeeze
Did you know that there is a natural pause in your breathing 
pattern that occurs every time you inhale and exhale? This break 
defines your shooting interval.

in out in out in in

squeeze trigger

out

hold
breath

natural
respiratory

pause

shoot

in out in outin in

squeeze tigger
squeeze tigger

hold

hold

shoottargetshoottarget

Fig. 17: Hold your breath at the end of the exhalation
phase of the respiratory cycle – half a second later is
the perfect moment when you should aim to fire your
camera’s shutter

Fig. 18: Two other breathing control variations. The first involves
holding your breath in mid-exhale, taking the shot and then
continuing to exhale, while the other is based on holding your
breath at the end of the inhale phase of the cycle.
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As you can see, this particular puzzle consists
of many small pieces and you will have to
make a considerable effort to put them
together and see a significant change in your
photography. You may have the best
breathing pattern in the world, but if you 
can’t ‘pull the trigger’ on your camera in a
controlled, deliberate manner you won’t reap
any benefit.

It takes a lot of practice and repetition
(repetition, repetition) to turn these
fundamental skills into second nature, just like
learning to ride a bicycle, drive a car or play a
musical instrument. The first time you attempt
to do any of these things, you concentrate on
every aspect of the task at once – How do I
avoid falling? Which note is that? Those trucks
didn’t seem that big when I wasn’t behind the
wheel. But one day, after you had practiced
them enough (dare I say through repetition,
repetition, repetition?) they became
instinctive.

Applied to sports, the scientifically
accepted term for this phenomenon is
‘muscle memory’ – your body has performed
a certain motion so many times that you don’t
have to think about it and doing it seems
entirely natural. This is why a trained gymnast
can make six handsprings in a row look
effortless, while my attempts at just one (with
spotters on both sides to catch me) resembles
what my sergeants affectionately refer to as a
“soup sandwich“.

Although the methods outlined here are
what the United States military has labeled
the “Four Fundamentals of Marksmanship“ 
in their technical and training manuals, the
nuances involved and the amount and 
type of training involved in making them
instinctive will vary widely from person 
to person. There are many different ways 
to combine these techniques, so
experimentation is the best way to determine
which approach yields the most effective and
consistent results.

When learning these principles, focus on
one at a time. Start with body positioning and,
once you have those components down, go on
to enhancing your breathing technique and so
on. Or start with sight alignment, as it is the
least complex section. However you approach
your training, start with just one aspect and
build on it using the previously honed
component as the foundation for the next.
Remember: slow means smooth, and smooth
makes you fast. You don’t start street racing as

soon as you get behind the wheel, and you will
stall hundreds of times until you don’t have to
think about that d*** clutch any more!

A closing disclaimer – the techniques
described here are by no means exhaustive,
and there other positions and techniques that
you can experiment with. I have attempted to
describe how my marksmanship training has
helped me to improve and enhance my own
photographic capabilities. I hope my
explanations help you too. (jr)  

Conclusion

Deployed to Afghanistan as a
commissioned officer in the United States
Army with a focus on engineering and
linguistics, Alexander Jansen is a First
Lieutenant currently involved in training
Afghan National Army soldiers to clear
roads of hidden or buried bombs known
as Improvised Explosive Devices (IEDs).
His family lives in Florida and he is
currently stationed in Bavaria, Germany.
He enjoys travel, rock-climbing, running,
obstacle courses and the study of
languages.
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You can also use a two-second self-timer
delay in handheld situations, although be
warned: the self-timer deactivates shake
reduction, and I have yet to find a way to
disable the deactivation. Start the timer
toward the end of your exhale cycle so that the
camera automatically fires just when you
begin to hold your breath. Don’t be
discouraged if this technique doesn’t work
right away – getting the timing right takes
practice.

Also, ‘follow through’ is almost completely
neglected in photographic situations. Golfers
know all about finishing their swing and
concentrating on the position of their hip and
back foot after contact with the ball has been
made. Basketball players point their shooting
hand down following the release of the ball to
‘close the lid’. The same concept applies to
photography and can be performed in two ways.

Squeeze Through: In single shot mode,
hold the shutter button down the whole time

the shutter is open and until you hear the
mirror swing back down, then count one full
second before releasing it. This is the point at
which you should once again begin to inhale.
See how everything comes together?

Continuous Drive: In continuous drive
mode (I recommend a low speed setting if you
have the option), use the first exposure to get
the shake out, the second for the keeper
picture and the third to release the shutter
button and inhale again.



Ralph Altmann, Alexander Altmann

How to Combat 

Camera Shake
If you don’t have access to a tripod while you’re out and
about, you need either a steady hand or additional gear to
help you keep your camera (or its sensor) still while you shoot.
This article introduces some useful accessories and shows you
how to use them to prevent camera shake under everyday and
extreme shooting conditions. We also used our own
four-wheel-drive motorized lab to test the limits of 
commercial image stabilizing systems.

78



P ro photographers are often recognizable
by the heavy tripods they carry. The stiller

the camera, the sharper the resulting images
will be, as anyone who earns money taking
photos knows. However, a tripod isn’t always
the ideal solution. In fact, if you are shooting
from a jeep in an off-road situation or from a
ship or a helicopter, a tripod will actually do
more harm than good, as it will transmit any
mechanical vibrations directly to the camera.
In situations like this, it is often easier to keep
the camera still if you hold it yourself,
especially if conditions allow you to use
exposure times of 1/50 s or less. Modern
image stabilizer systems help to prevent
camera movements from affecting the sensor
or the image it produces, but there are still
‘natural’ limits to what you can achieve
without mechanical aid, even if you take our
tutorial on page 68 to heart and improve your
handheld technique accordingly. The
following pages will help you to identify the
limits of your technique and equipment and
show you how to use additional gear to help
you move beyond the usual limitations. We
also take a look at how these techniques can
help video-makers to avoid capturing shaky
footage.

Sources of Camera Shake

Try standing still for a minute and you will
discover that even the apparently simple task
of remaining balanced is actually a dynamic
process that involves constant readjustment
of a large number of muscles. Your body is
constantly making slight compensatory
movements and, as a result, a handheld
camera does the same. The frequency of the
movements picked up by a camera is slightly
higher than that of the body’s own ‘tremor’,
which varies from person to person and can
be controlled (but not completely eliminated)
using advanced body and breathing control
techniques (once again, see page 68). This
means that, in principle, it is physically
impossible to hold a camera absolutely still
using just your body as a support.

These low-frequency muscle movements
are one of the most common causes of
camera shake. Another is the way we often
unintentionally ‘pull’ the camera during the
exposure. This occurs because reflex cameras
block the photographer’s view of the subject
during the exposure, either by raising the
mirror or temporarily switching off live view.
In the case of long exposures (one second and
more), an image stabilizer can help you
compensate for muscle tremor but cannot
stop moving the camera inadvertently . 

In situations in which you are tracking
fast-moving subjects (such as sports events or
race cars), image stabilizing systems have to
compensate for vertical camera movements
only. One example of this type of system is
Nikon VR, which can supposedly tell the
difference between deliberate pans and
camera shake automatically.

Things get more complicated when your
location is moving too. It is particularly
difficult to compensate for random,
long-wave vibrations such as those produced
by a moving vehicle, because they are not
consistent enough to enable you to establish
a counterpattern. Such conditions are too
much for almost any image stabilizer system
and the resulting unavoidable camera
movements are every video-maker’s
nightmare. 

Single sub-optimum frames are not a
film-maker’s greatest concern, as most video
is shot using shutter speeds of less than
1/50 s anyway, and a single shaky frame 
not usually visible among all the others 
in a clip. Nevertheless, as video cameras
become smaller and lighter, handheld
shots – especially for sequences shot while
walking or running – will be increasingly
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This quad bike served as our mobile
anti-shake testbed. The photo of a stork

was one of the in-focus flukes that we
captured along with our other material.



prone to shake. We decided to see 
whether the complex technical aids that
film-makers often to eliminate such effects
can be of use to photographers in the daily
battle against camera shake too. 

Subject movements don’t generally count
as a source of camera shake, although they

always have the same effect on the results.
No-one has invented an image stabilizing
system that can compensate for subject
movement yet, and the only way to
counteract it is to use a fast shutter speed or,
if your subject is following a predictable path,
pan the camera during your shot.

What if a Tripod doesn’t Help?

The camera itself can also be the source of
unwanted movements. The movement of the
shutter opening and closing can cause the
camera to vibrate and the raising and
lowering of the reflex mirror can even ruin
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Tests have shown that anyone who uses a
camera handheld produces camera shake at
a frequency of between 8 and 12 Hertz and
an average amplitude of 0.5 degrees. At a
subject distance of 10m, this equates to an
average of 5cm of camera movement. The
degree to which this movement affects the
quality of the resulting images depends on
the focal length of your lens, the resolution
of your sensor and the size of the displayed
image. A 50mm full-frame lens has a
horizontal angle of view of 40 degrees. In a
camera with a 16-megapixel sensor, this is
distributed across about 5,000 pixels, which
means that 0.5 degrees of movement leaves
traces on the sensor over a distance of 60
pixels – enough to make a photo unusable.

To produce sharp photos, traces of
camera shake should be no longer than
the diameter of the circles of confusion
that are tolerable for the aperture setting
you are using. This measures 17.8µm for
an APS-C camera and an image enlarged
to 12 x 8 inches, and is equivalent to 3.5
pixels of a 16-megapixel sensor. (See
www.dofmaster.com for help calculating
these values.) Such a value helps you
calculate the maximum number of
degrees you can afford to let your camera
move if you want sharp results. For a
50mm full-frame lens, it is less than 0.03
degrees. What this all boils down to is that
to be effective, an image stabilizing
system has to reduce ‘normal’ body

tremor by a factor of 20 for a 50mm lens,
and even more for a telephoto.

You can calculate the maximum effective
shake compensation for sensor-based
stabilizers like those used by Sony, Pentax
and Olympus. For example, Pentax
sensors move by a maximum of 4 mm,
which equates to a horizontal sixth and a
vertical quarter of the 23.6 x 15.7mm
sensor and its available angle of view.
This means that the maximum angle of
view that the stabilizer can effectively
work with (for an assumed shake of 0.5
degrees) is 3 degrees horizontally. This
equates to a highly usable maximum
effective focal length of 600 mm.

The Nuts and Bolts of Camera Shake

x

x

y

y

z

z Roll

Pitch

YawA handheld camera can move in one of six
different ways. Rotation around one or more
of the three main axes is the most common
cause of camera shake. Linear movements
along the x, y or z axes only affect image
sharpness at large reproduction ratios such
as those used in macro photography.

Combating Camera Shake | Basics



shots taken using a tripod if the exposure time
lies in the critical range above 1/10 s. We find
that image stabilizers are of little help in such
situations. Many camera manufacturers and
photo guides advise you to switch stabilizers
off if you are using a tripod. Our tests 
proved that this is sound advice for the
sensor-stabilized Sony Alpha 580 – in fact,
using the stabilizer system made the results a
lot worse.

Mirror lock-up is an effective way to
counteract camera shake caused by mirror
movements, but not all DSLRs have this
functionality built in. Weighing down your
camera and/or tripod can also help to cancel
out mirror-based shake. Extra weights combat
shake caused by wind quite effectively, and
adding a remote release helps to prevent
shake caused by pressing and releasing the
shutter button.

Short and Sharp

The simplest and most effective way to
combat camera shake is to use a short
exposure time. An old photographers’ rule of
thumb states that the shortest effective
shutter speed should be at least 1/focal length
if you want to be sure of getting sharp results.
This ballpark figure is independent of the size
of your sensor if you calculate it for full-frame
equivalent, rather than absolute focal lengths.
Such an approach is, of course, approximate,
and will vary depending on your shooting
ability and the size at which you display the
final image. 

Modern image stabilizers have made a big
impact on shooting techniques, and
manufacturers claim that you can shoot with
a 400mm lens using exposure times as long as

1/25 s if you activate image stabilization. This
equates to four f-stops of additional shooting
leeway compared with generally accepted
values. On the surface, such numbers would
appear to fulfill telephoto users’ wildest
dreams, but be warned: manufacturers’
figures are always accompanied by a “... can
be as much as ...” caveat. You also have to
consider the actual amount of available light

in your particular situation, and some
situations – such as shooting from a moving
jeep – are simply too much for any image
stabilizer. If this is the case, the best thing to
do is to look for other ways to reduce your
exposure time.

Use a larger aperture: Obvious but
effective, this method also reduces overall
depth of field, thereby offering potential
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Many tests have shown that, when used
under ‘normal’ conditions, the image
stabilizing systems offered by the major
camera and lens manufacturers enable
photographers to extend their usable
range of shooting parameters by several
f-stops. We decided to test whether these
systems are just as effective under
extreme conditions, such as those created
by shooting from a moving quad bike on
bumpy ground. We tested Nikon, Canon
and Sony cameras and lenses with and
without activated stabilizers, using a
pattern of different sized dots as our
target to enable the cameras to focus 
as easily as possible. We shot handheld
using a 70mm (105mm full-frame
equivalent) lens and exposure times
between 1/250 and 1/15 s. Conventional
wisdom suggests that 1/100 s should be
the limit for producing sharp results from
solid ground without an image stabilizer.
We repeated our test for all available
stabilizing modes. To finish up, we also

tested whether using a gyro stabilizer (in
this case a Kenyon KS-8), again shooting
with and without active image
stabilization, would affect the results.

We also performed a test to compare the
results of using accessory stabilizers with
those produced by the KS-8 and our test
cameras’ built-in stabilizers for exposure
times of up to one second. To do this, we
photographed points of light moving
across a black monitor screen at preset
speeds. The results of this test are printed
on the following pages in the form of
separate distance/time graphs recorded
for vertical and horizontal camera
movements.

In addition, we tested the comparative
effectiveness of the Kenyon KS-8 and a
Skyler Minicam Mark II steadycam using
video footage shot during a fast run
across a bumpy forest floor. The results
are included on this issue’s free DVD.

How We Tested

This distance/time graph, plotting the results of 10 separate test runs using a tripod-mounted Sony Alpha 580 with active SteadyShot, shows that
the discrepancies caused by regular movements increase exponentially with time



improvements to the composition. It is an
option only if greater depth of field is not
critical to the shot itself. You also have to focus
more precisely and your lens has to have
aperture reserves for you to use in the first
place – the ‘four stops’ of headroom that
manufacturers claim to provide don’t help if
you are already shooting at f11 and your
telephoto zoom has a maximum aperture of
f5.6. 

Increase ISO sensitivity: Also a trivial
idea, but nevertheless one that many
manufacturers market as a kind of ‘electronic
stabilizer’ – a ploy that is actually just
fraudulent labeling. Film with differing
sensitivity has existed since the earliest days
of photography and, then as now, increasing
sensitivity increases the incidence of image
artifacts, whether in the form of analog grain
or digital noise. Nevertheless, a slight
increase in noise is often preferable to a
blurred image. Additionally, improvements
in sensor technology are constantly
increasing the sensitivity levels at which we
can shoot adequate photos, and ISO 800 is
nowadays  a realistic setting for use with a
mid-range APS-C camera. But remember, if
you want to increase your exposure value by
four stops, you have to increase ISO
sensitivity from 100 to 1600.

Increase the amount of available light:
This is simultaneously the best and most
difficult way to reduce exposure times, and
does not reduce depth of field or increase
noise levels. In this case, an increase of four
stops is equivalent to replacing a 60-watt bulb
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How good is a monopod? Our tests showed that, when used with a Canon 70-300mm lens, a monopod is second only to a conventional tripod
when it comes to effective image stabilization. In fact, it was almost as good as the active in-lens stabilizer at damping quick movements.

We set our test cameras to continuous shooting mode and shot
while circling our target on a quad-bike
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with a 500-watt halogen floodlight (or 1000
watts worth of conventional light bulbs).
Reducing the distance between the light
source and the subject also increases
brightness – halving the distance provides
two extra stops of exposure.

Use flash: This reduces the exposure time
to the duration of the flash, even if the shutter
is actually open for longer. Typical flash
durations are around 1/4000 s, making shake
and unwanted subject movement practically
impossible. Studio and fashion photographers

often use independently
controllable flash heads, and all photos that
include wildly waving hair or perfectly
focused water droplets are shot using this
type of equipment. Pop-up and hot-shoe-
mounted accessory flash (rightly) has a
reputation for producing flat-looking images,
although it can be useful for providing extra
sharpness and light if used sparingly as fill
flash. Accessory flash is also great for
producing mixed sharp/unsharp effects if
used with longer exposure times.

Accessory Stabilizers

The next-best way to tackle camera shake is
using a tripod. If you find a conventional
tripod too clumsy for everyday use, a
monopod is a great, lightweight alternative. A
monopod completely prevents vertical
camera movements and, because it relocates
the center of rotation of the camera to its own
foot, it automatically limits pitch and roll
movements. Monopods usually have a

Left: activating the image stabilizer slightly improves the monopod’s performance 
Right: the same test sows that a rope monopod isn’t quite as effective as a conventional monopod

The authors have been using the Cullmann Cruiser shoulder
pod/tabletop tripod (US$69.95) for years. It is easy to fix it it to
street lamps, fences etc. using a bicycle luggage carrier strap. 
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pointed foot, making it simple to perform
pans too. This is one of the reasons panorama
photographers often use a monopod in
preference to a tripod to capture ‘blind’
overhead shots for use in 360-degree
panoramas. If your monopod doesn’t already
have one, a spirit level taped to the main tube
will help you to keep things level while you
shoot. It is always advisable to use a remote
release when using a monopod. Some
monopod manufacturers also include a broad
rubberized foot to provide additional
friction – Gitzo and Manfrotto (and probably
others too) sell rubber feet separately, so it’s
worth trying one out to see if it fits your
model.

An alternative to a conventional monopod
is a ‘rope monopod’, built from a tripod screw,
a rope and a metal or plastic plate for you to
stand on. The idea is to set up a length of rope
under tension between your foot and your
camera, and the result is a surprisingly

effective way to prevent unwanted camera
movements. If you attach the rope to the
nodal point of your lens instead of the
camera’s tripod mount, you can use it to help
you produce shake-free, multi-row
panoramas without parallax errors.
Commercial rope or wire monopods (such as
the ‘Steadepod’) usually have a spring-loaded
roll which you can lock at any length.

If you are using a monopod, the ground
you stand on has to be just a stable as it does
if you are using a tripod. If you are on unstable
ground or if you want to shoot video
handheld, you are better off using a camera
support that attaches to your own body, such
as a steadycam. This type of support is less
prone to wobble than the operator’s hand,
especially when a large, heavy camera is
attached to it! A chestpod or shoulder pod
also allows you to let go of your camera if you
need to. Video enthusiasts often use
chestpods, but they can be useful for

photographers too. The Cullmann Magic
Chestpod (US$80) is a good basic model.

These types of stabilizing aids don’t allow
you to make shake-free long exposures, but
do extend your range of exposure times by
significantly reducing the amplitude of your
body’s own shake. They also extend the
capabilities of the stabilizing mechanisms
built into your camera by reducing the
amount of compensation they have to apply.

Only Flying is More Fun

If you want to see a really effective vibration
reduction system, take a look under your car.
The system of wheels, springs and shock
absorbers is extremely well suited to
preventing the effects of uneven ground from
being transmitted to the car’s chassis. The
most important element of the system is the
relatively loose, spring-mounted connection
between the wheels and the rest of the car,

The humming, bomb-like KS-8 gyro stabilizer from Kenyon weighs
2.3kg (5 lb) and is mounted beneath the camera. The device works on
the same principle as a gyroscope and is slightly clumsy to use,
although still not as unwieldy as a steadycam. The battery pack has to
be carried separately.
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which allows the wheels to move freely over
obstructions while the chassis ‘floats’ above
them. The lighter the wheels and the heavier
the chassis, the more effective the system is.
The shock absorbers ensure that the system’s
inherent oscillations don’t get out of control.

The same principle is used in the
Steadicam, invented by movie cameraman
Garrett Brown in the 1970s. (By the way, the
word ‘Steadicam’ spelled with an ’i’ is a
registered trade mark.) The steadycam
principle involves attaching the camera to a
vertical tube, which is then attached to a
counterweighted gimbal that allows the
operator to move the camera in any direction
laterally while retaining the same horizontal
position and direction of view. The gimbal
mount and additional springs ensure that any
unwanted rotations, shocks and vibrations
have only minimal (or no) effect on the
camera’s position. The sprung arm in heavier
steadycams is attached to a belt or vest worn
by the operator, while the camera mount itself
provides the required damping in lighter
models. In other words, the torque produced
by the steadycam’s own weight prevents the
camera from making sudden or unwanted
rotational movements. The more weight the
steadycam carries on either side of its gimbal,
the more torque it produces and the harder it
is to knock the camera out of position.

The invention of the Steadicam ushered in
a new era of movie aesthetics and made it
possible to perform pans and other camera
movements from  positions that were
unthinkable using conventional cranes,
dollies and tracks. Until recently Steadicam
technology was too heavy and expensive for
amateur use, but some companies are now
producing smaller, less costly steadycams that
are well suited to use with everyday video
cameras and DSLRs.

We were given a Skyler MiniCam (about
US$600) to test. This model is suitable for
cameras that weigh up to 2.5 kg (5 1/2 lb). The
MiniCam can be tricky to set up, and the
camera’s center of gravity has to be
positioned precisely above the central
support. You also have to make sure that the
camera and counterweights are adjusted so
that the MiniCam returns to an upright
position within three seconds if you tip it
while holding it by its angled grip. It has fine
adjustment screws and engraved scales to
help you reconstruct a previous configuration,
and its design means you can also use it as an
impromptu tabletop tripod. The device comes
with two large quick-release brackets, so you
can leave one attached to your regular tripod
and switch quickly between the two, although
it is simpler and quicker to affix a quick-release
bracket from your tripod’s system to the
MiniCam and attach your camera to that. 

‘Steadicam Operator’ is a job in its own
right, and learning to use one requires a 
fair amount of practice. Due to the weight of
the device, it is virtually impossible to capture
longer shots without using your free hand
(placed near the gimbal) to help steady your
equipment. Even though the MiniCam
doesn’t offer much space for doing this,  it is
important to avoid touching the
camera itself during a shot. This
means that you can’t adjust focus 
or zoom settings by hand while
using a steadycam, although 
pro models are equipped with
remote-controlled motors to
perform basic camera adjustments
on the fly. Another reason for not
adjusting camera settings during a shot is that
doing so alters the position of the camera’s
center of gravity. Our tests showed that a
simple change in focus can cause the
MiniCam to tip at an unwanted angle and
force you to readjust its settings. Steadycams
are also quite sensitive to wind. 

As you can see, a steadycam is not really
the obvious choice for producing shake-free
photos, although there is nothing to stop you
from shooting stills if you are already using
one to shoot video footage. Once you have
found the right settings, the MiniCam’s
vibration damping system is very effective.

Don’t Jog My Gyro

It would make life much easier for camera
operators if it were physically possible to
increase the inertia produced by the camera
without increasing its mass. Another way of
producing damping effects is to use the
gyroscope principle. This uses the physical
fact that a rapidly rotating mass retains its
current axis of rotation unless acted upon by
a strong external force. Everyone knows that
a toy gyroscope or a moving bicycle stabilizes
itself if left to its own devices. Gyroscopic
stabilizers were first used in navigational
instruments and for military applications. We
tested a gyro stabilizer made by Kenyon – a
model that is believed to have been
developed for use by snipers during the
Vietnam war. We prefer its current adaptation,
which, when attached to the underside of a
camera, significantly increases its apparent
mass, especially during pans performed
perpendicular to the gyro’s axis of rotation. If,
however, you move the camera sideways or
roll it around the gyro’s axis, you only feel its
own additional weight, which ranges from

Although it might look like a tabletop
tripod, this is, in fact, the Skyler Minicam 

Mark II steadycam in action. The
three-legged support makes a great ad hoc

tripod, but the angled grip makes holding it
for normal use quite tiring.
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800g to 8 kg, depending on the model. You
also have to carry a battery and a current
inverter, although these can be carried
separately attached to your belt.

We were given a medium-sized KS-8 gyro
to test for a few days. This 2.3 kg (5 lb) model is
recommended for use with video cameras and
DSLRs that weigh up to 5 kg (11 lb). The gyro
requires a 115V, 400Hz alternating current
(usually available in helicopters!) and takes up
to 10 minutes to get up to working speed. The
current is provided by a special inverter
attached to the unit’s 12V battery pack (which
can also be powered from a car cigarette
lighter socket). A fully charged battery powers
the KS-8 for about two hours. The helium-filled
interior of the device contains two gyroscope
wheels that rotate in opposite directions at
22,000 rpm and tilt by up to 75 degrees

perpendicular to the axis of rotation. Springs
return the wheels to their original position and
the design of the unit makes it easy to perform
pans with smooth starts and stops.

A Kenyon gyro stabilizer works in two
directions. If you mount it pointing in the
same direction as the lens, it damps yaw and
pitch movements, whereas if you mount it at
right angles to the lens, it damps yaw and roll
movements. If you want to prevent unwanted
movements in all three axes, you have to use
two gyros mounted at 90 degrees to each
other. Cameraman Jost Vacano used a
handheld Arriflex movie camera and two
Kenyon stabilizers to shoot the interior scenes
in the 1981 movie The Boat, which portrayed
wartime scenes inside a submarine. This setup
enabled him to capture stable footage while
running and jumping through the sub’s

hatches. Vacano’s efforts won him an Oscar
nomination and gave Kenyon stabilizers their
breakthrough in the movie industry. Some
camera operators combine Steadicams with
one, two or even three gyros to provide
ultra-stable shooting.

A gyro stabilizer is more compact, less
susceptible to the influence of wind and easier
to use than a steadycam. You can shoot
normally with a gyro mounted and it
effectively compensates for vibrations and
minor shocks. However, both gyros and
steadycams are themselves constantly in
motion and are thus unsuitable for long
exposure use. The trump card of such devices
is their ability to allow you to continue
shooting in situations where ‘normal’
exposure times (in the hundredths of
seconds) are subject to camera shake.
According to  Dedo Weigert Film GmbH, who
loaned us our test gyro, these types of devices
are often bought or rented by aerial
photographers.

The long warm-up time and the
dependency on a special power source are the
downside of the Kenyon approach. We also
found that our test gyro got so hot that we
could no longer hold it using our bare hands.
Gyros are quite loud, so you have to use a
separate microphone or dub sound later if
you use one to shoot video.

Kenyon gyros cost between US$1,300 for
the KS-2 and US$3,600 for the KS-8. Rental
prices start at around US$70 per day.

Home-made Gyroscope

Most computers contain one or more
‘gyroscopes’ of their own in the form of hard
disks that rotate at high speed. In a
competition organized by our German sister
magazine c’t, one particularly innovative DIY
expert took a disused hard disk and
transformed it into a gyro stabilizer using
similar construction principles to those used
in Kenyon gyros.

Light from subject 

Front lens group 
Correction lens 

Rear lens group 

Sensor plane 
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Correction lens 
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Front lens group 

Rear lens group 

Sensor plane 
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Correction lens 

Adjusted light path 

Correction lens shifts downward 

An optically stabilized lens contains an
additional mobile correction lens that
ensures that the light from the subject
always hits the same sensor cells
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A hard disk cannot reach the same rotation
speeds as a Kenyon, but is still capable of
stabilizing a 1kg (2-pound) video camera
when mounted on a cheap steadycam-style
frame made of plywood. The device’s
constructor even managed to use to it to
shoot usable footage from a microcopter
‘drone’.

Active Stabilizers

The external image stabilizing systems we
have described so far are all passive and often
provide only moderate results in spite of
being quite tricky to use. In contrast, many
cameras now have a radically different, active
solution to the same problem built in.
In-camera stabilizer systems simply accept
camera movements as given and only
become active when they begin to have a
detrimental effect on the image captured by
the camera’s sensor. These systems are based
on the idea that the light rays emanating from
the subject only have to be projected onto the
same place on the sensor for the duration of
the actual exposure. This can be achieved by
shifting either the light path or the sensor to
accommodate any camera movements that
may occur. Canon, Nikon, Panasonic, Sigma

and Tamron all manufacture lenses that
effectively ‘bend’ the light path within the
lens, while Sony, Pentax, Olympus and Ricoh
take the sensor-based approach and use tiny
piezo-electric or electromagnetic motors to
shift the sensor to the correct position. The
shift data is delivered by microelectronic
motion sensors that measure acceleration and
angular velocity. These devices work to
extremely high tolerances and have to
produce extremely precise data at very short
intervals in order to shift the sensor (or
correction lens) simultaneously with the
camera’s movements.

This type of system usually comprises two
sensors that measure angular velocity for
lateral rotational and vertical pitch
movements. Measuring linear camera
movements requires the use of additional
sensors, although error correction is
performed in exactly the same way, as the
difference between linear and rotational
movements doesn’t make any difference to
the shift in the projected image (except in the
case of ultra-wide-angle lenses). However, the
only way to compensate for ‘roll’ movements
around the optical axis of the lens is to
produce a matching counter-rotation in the
sensor. Shifts along the z-axis require an

additional degree of freedom within the
stabilizer system to allow for changes in the
plane of focus. This type of camera movement
produces only negligible effects in standard
and telephoto lenses, but produces significant
effects in wide-angle and macro lenses. In fact,
in order to produce truly stabilized wide-angle
images, it is theoretically necessary to tilt the
sensor plane to compensate for the altered
perspective (such as converging lines) these
lenses capture. As far as we know, no-one has
yet created such a sophisticated system,
probably because wide-angle shots are less
prone to shake than those captured using
telephoto lenses. Every photographer knows
that the risk of camera shake increases with
increasing focal length. Canon denied the
necessity of this technology until it actually
began to produce stabilized wide-angle
lenses of its own.

‘Bending’ the Lens

Analog cameras were still the order of the day
when Canon and Nikon introduced their first
image stabilizers in the mid-1990s, so both
companies had no alternative but to build
their systems into the lens, as it would have
been physically impossible to shift the entire
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film and film transport mechanism. Thus the
first stabilized lenses had not only a
motor-driven correction lens but also a
complete sensor system and accompanying
electronics built in. The entire system was
powered by the camera battery. Due to space
limitations, these systems were initially only
built into telephoto lenses, and it is only
recently that further advances in
miniaturization have made it possible to build
similar technology into wide-angle lenses.

In addition to its conventional IS lenses,
Canon has been producing Hybrid IS lenses

since 2009. These contain a third sensor 
that detects lateral and back/forward shift
movements. This system is a boon in macro
situations where even slight movements 
can spoil a shot. Hybrid IS has two modes 
that correct either vertical and horizontal
movements or just vertical movements 
(for use with panned shots of moving
subjects). 

Nikon’s VR (Vibration Reduction) system
also has two modes. Nikon Recommends
‘Active’ mode (which compensates for vertical
and horizontal camera movements) for

shooting from moving vehicles. In ‘Normal’
mode, broader camera movements are
interpreted as alterations to framing on the
part of the photographer and are not
corrected. The latest Canon and Nikon lenses
automatically detect whether they are
tripod-mounted, handheld or are being
panned, and switch modes accordingly.

Advantages:
– The stabilizer can be precisely tuned to the

lens in question
– A single correction lens can be shifted more

quickly and easily than an entire sensor unit,
making it easier to compensate for abrupt
camera movements

– The degree of shift of the correction lens can
be as large as technically possible and
doesn’t depend on the size of the image
circle projected by the lens 

– The viewfinder image is stabilized too
– Adapters, bellows and teleconverters

mounted between the camera and the lens
can be used without affecting the stabilizer
system

Disadvantages:
– Built-in IS systems make individual lenses

heavier, more complex and more expensive.
Canon’s stabilized lenses are almost twice as
expensive as their non-stabilized
counterparts.

– Many popular lenses (especially those with
fixed focal lengths) aren’t available in
stabilized versions

– Roll movements around the optical axis of
the lens cannot be counteracted using
conventional lens components, although

These two diagrams illustrate the effectiveness of the Kenyon KS-8 gyro stabilizer. The running gyro effectively
counteracts short, sharp shocks, but the ‘drift’ effect it produces has an distinct adverse effect on longer exposures.

Pentax sensors are
mounted magnetically,
allowing rotation of up
to one degree 



89c’t Digital Photography 10 (2013)

Combating Camera Shake | Sensor Shift

Canon maintains that its Hybrid IS system
can correct such errors to a certain degree
by re-computing x/y shift data and shifting
the lens accordingly. However, we suspect
that this approach only corrects the linear
component of the roll movement, especially
if the axis of the movement axis isn’t
precisely commensurate with the optical
axis of the lens.

Sensor Shift

In 2004, Konica-Minolta introduced the
Dynax/Maxxum 7D, the world’s first DSLR to
use a sensor shift image stabilizer. Called ‘Anti-
Shake’ back then, the system lives on under
the SteadyShot banner following Sony’s
takeover of Konica-Minolta in 2006. It uses
two tiny piezo-electric motors to shift the

sensor along the x and y axes, and the
accompanying sensors and electronics are
built into the camera body. The obvious
advantage of this approach is that it doesn’t
require special lenses, and all that is required
for the system to function is for the lens to
communicate its current focal length and
focus settings to the camera. 

Sony’s Alpha cameras have two active
sensors that detect both horizontal and
vertical camera movements. The system is
either switched on or off – there are no
modes. The sensors built into current
Olympus and Pentax models are mounted
magnetically and are capable of rotating as
well as shifting along the x and y axes. Pentax
quotes a maximum shift value of 4 mm and
maximum rotation of one degree, which
enables the camera to compensate for roll
movements around the optical axis of the
lens. Olympus has introduced its own ‘5-axis’
stabilization system with the OM-D range of
cameras which, in addition to correcting pitch,
roll and yaw movements, can also stabilize
horizontal and vertical linear shifts in camera
position.

Advantages:
– The system is built into the camera body

and only has to be paid for once
– No specially constructed lenses are

necessary
– The system works with all lenses that have a

compatible mount, regardless of their age. A
lens only has to be capable of transmitting
focal length and focus data to the camera,
which most modern lenses can anyway. If

A comparison of typical Canon and Nikon measurments. Both systems produce
equally poor long-exposure stabilization. 

Sony’s SteadyShot system uses two tiny piezo-electric
motors to adjust the position of the sensor



90 c’t Digital Photography 10 (2013)

Combating Camera Shake | Conclusions

the lens cannot transmit data, the camera
uses a default focal length value equal to the
sensor diagonal and assumes focus is set to
infinity. These values undercompensate for
telephoto lenses and overcompensate for
wide-angles. Pentax cameras allow you to
enter focal lengths from 8 to 800 mm
manually via the menu system.

– A rotating sensor can also compensate for
camera roll – functionality that, as yet, only
Pentax and Olympus have implemented.

Disadvantages:
– Optical viewfinders are not stabilized,

whereas some electronic viewfinders are
– Shifting the entire sensor unit is a more

complex operation than shifting a single
correction lens, potentially increasing
reaction times 

– The sensor cannot be moved outside the
image circle projected by the lens, which
limits the range of compensation, especially
for telephoto lenses

– Teleconverters, extension tubes and
bellows render the system unusable

Conclusions

Even the most sophisticated hi-tech image
stabilizers can’t perform miracles, and
nothing beats a stable camera support. At
exposure times of 1/60 s and longer, it is
virtually impossible to capture sharp images
from a moving car, regardless of which

The graph for the Sony A580 demonstrates that sensor shift stabilization is not appropriate
for use with long exposures. In fact, this system produces a lot more drift than the Canon and
Nikon systems.

Single shaky frames are not much of a
problem when shooting video using
shutter speeds of 1/50 s and less, and
image stabilizers only make a difference 
if you are shooting at telephoto focal
lengths. The real problem lies in the
constant shifts in framing caused by the
constant slight balancing movements of
the camera operator’s hand, which are
especially prevalent with heavier cameras
and can make the viewer feel ‘seasick’. 
A conventional image stabilizer can
effectively counteract such ‘wobble’ effects
and can also help to make handheld shots
look smoother. Stabilizers can help to
smooth out pans as well, although they
sometimes cause ‘jumps’ in a clip. As with 

a stills camera, if you are shooting a video
pan from a tripod, it is better to switch off
your image stabilizer altogether. In a video
context, a gyro stabilizer or a steadycam 
is preferable to in-camera (or in-lens)
stabilization when you are shooting
handheld pans or while moving. Built-in
stabilizers also tend to produce noise close
to the camera’s microphone and reduce
battery life. We have included a short video
clip on this issue’s DVD that illustrates the
effects of gyro and steadycam stabilizers
on video footage.

A recent trend has seen an increase in the
number of aerial video clips shot from
remote-controlled microcopters, or

‘drones’, with a camera slung beneath
them. The camera is usually mounted on 
a motor-driven, sensor-controlled gimbal
that keeps it level during flights. The
principle is the same as the one used in
camera-based image stabilizers, but
instead of adjusting a single component of
the camera, the system constantly adjusts
the position of the entire camera. 

There are many videos and how-to guides
on the subject available online. Just search
for terms like ‘gyro stabilized drone’,
‘microcopter’, or ‘video drone’. There is
basically nothing to stop you using similar
mechanisms as a kind of ‘active
steadycam’.

Stabilizing Video
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camera or stabilization system you use.
Stabilizers significantly reduce the effects of
camera shake, but the blur that remains
makes most shots unusable if they are
enlarged to a size greater than a postage
stamp. During our test, no more than 10
percent of all the shots we captured at 1/60 s
or more were even halfway usable. The
results we produced using the Kenyon gyro
stabilizer weren’t much better either, but
that probably has a lot to do with our lack of
experience using the device.

Whichever system we tried, activating
image stabilization noticeably improved our
hit rate, especially for exposure times
between 1/60 and 1/250 s. We also noticed
that all of our test systems produced about
10 percent flukes, with or without active
stabilization. With active stabilization, we
were pretty sure of capturing at least one
sharp image in each sequence of 10 using
an exposure time of 1/125 s, and more than
25 percent of the images captured by Sony’s
sensor shift system were usable.
Surprisingly, the Sony still led the pack at
1/250 s, with more than two thirds of the

results turning out  acceptable. For the
same test, only 25 percent of the Canon
material and about a third of the Nikon
material were usable.

The Canon and Nikon systems often beat
sensor shift systems in magazine tests, so we
can only assume that our results were due to
our (realistic) use of continuous shooting
mode during our own test runs. If the
stabilizer system doesn’t have time to return
to its zero position between shots, the
positioning motors used to shift the
correction lens quickly get ‘confused’. Canon
confirmed this assumption when asked, but
Nikon and Sony didn’t respond. 

We had hoped that our handheld test
shots taken from stable ground would
enable us to capture effectively stabilized
long exposures. For this part of our test, we
provided basic stability using a monopod,
shoulder pod or gyro before shooting our
test sequences. Theoretically, having
established a stable shooting position, we
should be able to focus on a subject 
for an extended period of time – provided,

of course, that the situation doesn’t

overextend the stabilizing system’s shift
limits. What we actually found is that the
sensors built into our test systems simply
aren’t built for this kind of job. Instead of
measuring the absolute position of the
camera, they measure acceleration and
angular velocity when the camera moves
and use this data to calculate the change in
position. This approach is obviously not
accurate enough to keep things stable
during long exposures. Our test with a
tripod-mounted Sony A580 shows that the
errors the system produces actually increase
exponentially over time.

At the end of the day, nothing beats a
high-quality tripod if you want to take
photos using long exposure times. If you are
shooting handheld, advanced breathing
techniques and mechanical aids are often
more effective than electronic systems.
However, electronic systems really come into
their own in the shutter speed range
between a few tenths and a few hundredths
of a second, where they make it possible to
capture photos that were unthinkable just a
few years ago. (keh)  c

Even with active stabilization, the
shot on the left (captured at 1/15s)

was a complete fluke. In this case
the movement of the vehicle

relative to the subject was itself an
additional source of shake. With

active SteadyShot and an exposure
time of 1/250s, two thirds of the
shots we captured with the Sony

A580 turned out fine (on the right).
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Developing Images
using Blending Modes and Layer Techniques
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Photographers have a lot to gain from advanced
blending mode and layer techniques that go beyond
simply selecting Overlay mode and playing around with
opacity values. These techniques offer exciting new
image editing options using just a few mouse clicks.

This article not only tells you what
Photoshop’s layer techniques and

blending modes are called and where to find
them, it also explains how to combine them
with photographic know-how to produce
fantastic image editing results. There are
hands-on examples that show you how to
selectively improve the tones in your color
and black-and-white images, and you’ll also
find tips on how to produce HDR images while
retaining complete control of the quality and
look of the results. We explain how to adjust
tonal values separately for highlight and
shadow areas and present subtle but effective
ways of sharpening your images. And if all
that isn’t enough, we also let you in on the
secrets of Lab mode and how to use it with
blending modes to provide virtually endless
creative image editing options. To help you
practice, we have included the sample images
used in the tutorials on this issue’s free DVD.
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If you usually stick to standard tools such as
Levels, Curves and Color Balance, you may
well be asking yourself what Blending Modes
are. However, if you are familiar with the
Layers panel and its associated tools, you will
probably have used blending modes (also
referred to as ‘layer modes’) quite a lot. 

You will often come across blending
modes if you use the Photoshop Apply Image
and Calculations commands. Blending modes
are also an integral part of the Paintbrush,
History Brush and Gradient drawing tools, as
well as the Healing Brush, Clone Stamp, Blur
and Dodge retouching tools.

Photoshop CS6 includes a list of 27 different
blending modes, divided into six groups. 

The first group consists of the Normal and
Dissolve modes, which have no obvious
effect. The modes in the second group darken
an image and those in the third are used to
perform general image lightening. The fourth
group makes dark tonal values even darker
while brightening lighter ones, and the fifth
group creates a mathematical relationship
between the two basic tonal areas. The sixth
and final group combines tonal values,
saturation, color and luminosity in a variety of
ways. 

Generally speaking, blending modes are
used to merge various types of image data. In
order to perform this task successfully, all the
data that you wish to merge has to have the
same basic proportions so that the individual
positions in the images being merged are
precisely mapped to one another. If you
imagine two overhead projector
transparencies laid on top of each other, each
point on the top transparency corresponds
precisely to the one underneath it, which is
exactly how blending modes merge points
within separate images. In other words, the
first pixel on the first row is merged with the
corresponding pixel on the layer beneath and
so on, through to the final pixel in the bottom
row of image data. 

This way, images, layers and channels of
the same size can be merged either with each
other or with duplicates of themselves.
Eight-bit RGB images are saved in the form of
separate red, green and blue channels, each
of which contains a maximum of 256 different
tonal values (between 0 and 255). If these

tonal values are multiplied (i.e., 256 x 256 x
256), the result is the well-known total of 16.7
million different colors that an 8-bit image can
contain – a gamut that provides a huge range
of nuances. If you imagine each of these colors
as a one-millimeter strip, the ribbon they
would form would be 16.7 kilometers (about
10½ miles) long. Imagine merging two of
these ribbons, and it quickly becomes clear
why it can be quite tricky to keep track of
what’s going on when applying blending
modes.

To begin with, it is sufficient to note that
blending modes can be used to merge image
data from images, layers or channels that are
the same size. The results either show no
changes (in which case you can do without
blending altogether) or are brighter or darker
than the original image. Things get really
interesting when the darker areas of the
resulting image are darker than the original
but the brighter parts are lighter. 

So now you know that there are 27
different blending modes that can be used to
merge various types of paired image data.
One of the two elements is the source and the
other is the target. An active element is
automatically considered to be the target, so
if you are working with two superimposed
layers, the blending mode you select will be
applied to the upper of the two layers. 

To select a blending mode, simply click it
in the blending mode list (on a Mac, you can
use the Shift-Alt-Initial shortcut, where ‘Initial’
represents the initial letter of the mode’s
name). The Darker Color, Lighter Color,
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What Are Blending Modes?

The list of Blending Modes found in
the Layers panel or the Layer
Options menu
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Subtract and Divide modes are not associated
with a default shortcut, but you can add your
own using the Edit > Keyboard Shortcuts
command.

Photographic Image Editing

If you grew up in analog times, you will know
that shooting and enlarging a
black-and-white image really means
capturing and reproducing the best possible
range of grayscale tones. The tonal range of
the film or sensor in a camera often vastly
exceeds that which can be reproduced on
paper. In other words, a printed image is
always a tonal compromise. In the heyday of
black-and-white analog photography, many
people aspired to perfect tone management,
and Ansel Adams’ famous zone system was a
pioneering attempt to optimize the
relationships between the tones produced by
the image capture, negative development
and print enlargement processes. 

Digital images, too, basically consist of
grayscale values that range from pure black
to white on a scale from 0 to 255 for each of
the RGB channels. It is theoretically possible
to adapt Adams’ zone system – with its
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A typical landscape photo. The histogram displays tonal values covering
the entire scale from 0 to 255. The individual channel views shown on 
page 96 provide a more detailed breakdown of their distribution.

The Layer Style dialog offers more options for fine-tuning the application of blending modes. 
The Blend if options enable you to precisely adjust the overall effect of a blend and the
transitions it creates.



values from 0 to X – to the world of digital
images; although the original system was
designed to create unique combinations of
exposure and development parameters that
only ever applied to a single image. The
basic idea of  influencing the various areas
of brightness within the frame individually is
just as valid for digital images. Blending
modes are a little-known but very effective
tool for applying just this kind of
photographic adjustment, and allow you to
effectively isolate and adjust highlights,
midtones and shadows. Generally, each of
these three zones contains about a third of
the tones in an image, with shadow values
ranging from 0 to 85, midtones from 86 to
170 and highlights from 171 to 255. Based
on this assumed distribution, selecting your
desired pixels is a matter of just a few clicks,
rather than the often painstaking work
involved in using Photoshop’s various
selection tools. What’s more, you can then
edit each of the three zones completely
independently (see the workshop on page
98). 

Preparing Your Image

The first step in the process we are about to
describe involves adjusting the levels in each
color channel so that the tones it contains

cover the maximum possible range. This
ensures that the results are as dynamic as
possible, and the results will be just as good
whether you use the Curves tool or the Levels
tool to make the adjustment.

Adjusting Levels

When you open it, the Levels dialog looks
much like the one shown on page 95. Here,
the overall shape of the curve is less important
than the behavior of its two ends. Your image
will display maximum contrast (i.e., it will
contain the maximum possible range of tonal
values) if the curve actually touches both ends
of the tonal scale. 

In order to achieve maximum image
quality, you will need to adjust each color
channel individually. The illustrations above
right show just how different the distribution
of tonal values in the channels can be. Moving
the black point and white point input sliders
toward the center of the scale distributes the
available tonal values across the entire scale
and, if you hold down the Alt key while doing
so, the preview will show clipped areas (i.e.,
ones that are completely black or completely
white) in the resulting image. Once the slider
reaches the end of the histogram curve, the
associated pixels will be shown in color in the
preview image. 

The adjusted image has a lot more contrast
and will look more dynamic. The differences
this type of adjustment make can be quite
dramatic, but your results will always depend
on the quality of your source material.
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Once the levels have been adjusted, the resulting image displays maximum
contrast and is much more dynamic than the original

Comparing the individual color channels
shows how important it is to adjust contrast
separately for all three
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Prepare your mask: Duplicate the
background layer twice using the Duplicate
Layer command in the Layer menu. Select
the Color Burn blending mode for the
uppermost layer and merge the two upper
layers into one. Use the Select > All
command (or the Ctrl/Cmd+A shortcut) 
and copy the resulting selection using the
Edit > Copy command (Ctrl/Cmd+C). The
selection is now stored on the clipboard.
Now hide this layer by clicking its eye icon
in the Layers panel.

Step1

Mask the shadows and midtones:
Duplicate the background layer once again
andrename the new layer ‘Highlights’.
Create a new mask using the Layer > Layer
Mask > Reveal All command and paste the
contents of the clipboard into it by holding
down the Alt key and clicking the mask,
followed by the Edit > Paste command
(Ctrl/Cmd+V). The shadows and midtones
are now masked, and you can delete the
hidden layer.

Step 2

Brighten the highlights: Any levels
adjustments you make to the ‘Highlights’
layer – for example, using the Hard Light
blending mode – now only affect the bright
image areas. You can also use Curves to
adjust the highlights. The fact that the
midtones and shadows are masked gives
you a lot of leeway for your adjustments
and allows you to experiment with settings
that would be too extreme for application
in an unmasked image.

Step 3

Adjusting Highlights, Midtones and Shadows

This workshop demonstrates how to create masks that allow you to adjust highlights,
shadows, and midtones separately. This approach enables you to optimize one zone
at a time once you have adjusted the basic color levels in your image.
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Adjust the midtones: Because the brightest
tones in this mask are mid-gray, adjustments to
the midtones won’t have a particularly marked
effect. If you want to produce a more obvious
effect, you can always use the Curves or Levels
tools to increase dynamic range. To brighten
the Midtones layer, use either the Curves tool
as shown, or an appropriate blending mode.

Step 5

Prepare to adjust the shadows: Once again,
duplicate the background layer twice. This
time, select the Color Dodge blending mode.
Once you have merged the two upper layers,
copied the result and hidden the new layer,
you can duplicate the background layer and
call it ‘Shadows’. Create a mask, insert the
clipboard contents and invert the mask using
the Image > Adjustments > Invert command.
This creates a shadows mask. Now delete the
hidden layer.

Step 6

Adjust the shadows: You can darken the
Shadows layer using either Multiply blending
mode or the Curves tool.

As you can see, creating zone masks is quick
and easy, and is even faster if you use Actions
to create your masks. You can even record a
single Action to create all three masks in one
routine and simply delete the masks that you
don’t need for the image you are working on.

Step 7

Prepare to adjust midtones: The method
here is basically the same as for the highlights.
Duplicate the background layer twice and
select Exclusion blending mode. Merge the
two upper layers into one, select all, copy the
result to the clipboard and hide the new layer.
Duplicate the background layer again and call
it ‘Midtones’. Create a mask and activate it by
clicking it with the Alt key pressed. Now paste
the contents of the clipboard into the mask
and delete the hidden layer.

Step 4
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You can use the techniques introduced in 
the workshop on page 98 to fine-tune the
three basic tonal zones in black-and-white
images too. 

Using the individual RGB channels within
the Curves or Levels tools gives you even
more ways to use zone masks to enhance your
images. Adjusting the individual color
channels within each zone enables you to
apply sophisticated effects like those 
you can produce using the Lightroom Split
Toning tool, which allows you to finely
balance the adjustments you make to the
individual zones.

Subtle adjustments to highlights and
shadows can make black-and-white images
seem more three-dimensional, especially if
the differences between your tweaked 
image and a conventional grayscale version
are not immediately obvious. For the portrait
of a child shown below, we created and
adjusted shadow and highlight masks to
achieve the effect we were looking for. In 
this case, a slight lift in the red channel 
curve was all that was required to add
warmth to the shadow areas. 

Similarly, lowering the blue channel 
curve for the highlights also warmed up the 

brighter areas. The result is very subtle and
gives the finished image added charm.

Creating a Look

The possibilities are virtually endless, 
and you can achieve similar effects to the
monochrome ones described here in color
images using any or all of the color channels
in any combination of the zone masks we
have already created. Green is the dominant
color in both the light and dark the areas in
the image of an ornamental leek bud shown
opposite. Increasing the red component in

Advanced Tonal Adjustments

Subtle adjustments to
the individual color
channels in the shadow
and highlight zones give
this black-and-white
image extra impact

Continued on page 104
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Using blending modes and the Curves
tool, you can produce enhanced color

looks like this one with just a few clicks

Here, we brightened the red channel and
darkened the green and blue channels in

the shadow zone to accentuate the red
tones in the darker image areas
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Simultaneously reducing
the red component while
increasing the green and
blue levels gives the
midtones a cooler look 

Highlights react in a similar way to midtones, producing a cold/warm contrast alongside the
light/dark contrast that already exists between the highlight and shadow areas
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Deliberately blurred highlights
can give a photo a filmy, rather
romantic feel

The mask shows precisely which parts of the
image are affected by the added blur

Because the higher Radius setting also
includes pixels taken from the yellow
leaves, a strong blur effects gives the sun an
exaggeratedly yellow tint



the shadows offers an effective counterpoint
to the green-tinged highlights. To begin with,
we adjusted each channel by eye until we
achieved a satisfactory look for the darker
tones. 

We then adjusted the midtones channel
by channel, reducing the red component
and increasing the green and blue levels.
Adjusting the upper end of a curve more
than the lower end ensures that effect on

the midtone areas is more pronounced.
Finally, we applied similar adjustments to
the individual highlight channels, again
reducing the red component and increasing
the green and blue levels. You can, of
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It doesn’t always
make sense to
sharpen the entire
image. Subtle partial
sharpening in the
shadow areas is often
more effective, as
shown here in the
detail of the tire.

The Shadows mask shows
which parts of the image will

be affected. Using masks
allows you to apply much
more radical effects than

you can when sharpening an
unmasked image.



course, adjust the overall brightness for any
or all of the zones using the combined RGB
curve.

Romantic Highlights

Blur effects can also be used to alter the effect
of the highlights in an image. Selective blur
often gives portraits and landscapes a
characteristic look of their own.  

To apply a selective blur effect, duplicate
the background layer twice and select the
Color Burn blending mode for the upper layer.
Merge the two upper layers, copy the new
layer to the clipboard and then delete it. You
can then duplicate the background layer
again, create a new mask and paste the
contents of the clipboard into it.

Now apply the Gaussian Blur filter to the
duplicate background layer. The effect you
achieve will depend on your Radius setting,

which will itself depend on the size of the
image you are working on. In our backlit forest
example on page 103, you can see the results
of applying radius settings of 7.2 and 90. The
blur filter darkens the highlights; to
counteract it you will have to apply a Curves
adjustment or use a blending mode such as
Screen from the third group in the list.

Subtle Sharpening

The logical counterpoint to blurred
highlights is sharpened shadows. The
brighter areas in many images tend to look
rather two-dimensional, so the general
impression of sharpness is determined more
by the sharpness of the shadow details. To
enhance this effect, create a shadow zone
mask, copy the background layer twice and
select Color Dodge blending mode for the

uppermost layer. As previously, you then
have to merge the two upper layers, copy the
resulting content to the clipboard and delete
the layer. Then make a new copy of the
background layer and create a mask  that you
then fill with the contents of the clipboard.
Invert the new layer using the Image >
Adjustments > Invert command. Again, you
can save a lot of time by recording these
steps in an Action, especially if you use
shadow masks regularly. 

You can now apply the Unsharp Mask
filter to your new layer. As with the other
effects we have described, you can apply
much more extreme values to a masked
image than you can use on a conventional
image layer. Using this approach, you can
selectively increase contrast in the darker
areas of your image – as we have with our
race car photo – which not only increases
sharpness, but also adds depth.

Blending Modes for Photographers | Sharpening
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Create a highlight mask: Open all three source images in
Photoshop and use the ‘normally’ exposed image as the basis for
the step-by-step creation of HDR shadow and highlight masks.
Duplicate the background layer twice and select the Color Burn
blending mode for the upper layer. Merge the two upper layers
and call the resulting layer ‘Highlight Mask’. Now switch to the
source image with the shortest exposure time (i.e., the
underexposed one in which the highlights show maximum detail)
and copy it to the clipboard. Switch back to the normally exposed
image and paste the contents of the clipboard onto a new layer
called ‘HDR Highlights’. Create a new mask and activate the
‘Highlight Mask’ layer. Use the Select All command and copy the
resulting selection before deleting the ‘Highlight Mask’ layer. Now
paste the copied mask into your newly created mask by clicking
the mask with the Alt key pressed, followed by the Ctrl/Cmd+V
shortcut. The resulting image now has good highlight detail, but
doesn’t yet look convincing.

Step1

Fine-tune the highlight mask: Paying
attention to the transitions between the
highlights and midtones as well as the
general feel of the image, reduce the opacity
of the highlight mask layer until the
highlights show just the right level of
brightness and apply the Gaussian Blur filter.
Larger Radius values make these transitions
softer. Once you have found the right Radius
setting, you can re-adjust brightness if
necessary.

Step 2

Creating HDR Effects Using Blending Modes

Another way to use your new knowledge of blending
modes is to create enhanced-contrast images. All you need
is a high-contrast subject that you capture in three separate
images, one using exposure settings that produce a ‘normal’
image and two others that capture all the highlight and
shadow detail. The ‘normal’ image should be exposed at a
level that approximately represents the overall brightness
that you want your finished  HDR image to have. Use a
tripod to ensure that the three images can be perfectly
superimposed.

Normal exposure Underexposed Overexposed
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Create a shadow mask: Hide the ‘HDR
Highlights’ mask and duplicate the background
layer twice. Select the Color Dodge blending
mode for the upper duplicate, merge the two
upper layers and invert the result using the
Image > Adjustments > Invert command. Call
the result ‘Shadow Mask’. Now switch to the
overexposed image (i.e., the one with the
longest exposure time and good shadow detail).
This means that the brightest source image is
responsible for creating the darkest parts of the
finished image. Select the entire image and
copy it to the clipboard. Now switch back to the
‘normal’ image and paste the new contents of
the clipboard to a new ‘HDR Shadows’ layer.
Create a new mask, activate the ‘Shadow Mask’
layer, apply the Select All command
(Ctrl/Cmd+A), copy the resulting selection and
delete the ‘Shadow Mask’ layer. Paste the copied
mask into the ‘HDR Shadows’ layer by clicking
the mask with the Alt key pressed followed by
the Ctrl/Cmd+V shortcut.

Step 3

Fine-tune the Shadow mask: The ‘HDR Shadows’ layer we have
created looks OK, but could benefit from a little tweaking using the
Gaussian Blur filter, though with a much smaller Radius setting than the
one we used for the highlight image. Increase the saturation of the ‘HDR
Shadows’ layer using the Image > Adjustments > Hue/Saturation
command to accent the shadow tones. Once you are happy with all your
shadow and highlight settings, you can merge all your layers into one
before making any final global adjustments to contrast and brightness.
This is the point at which you can apply additional sharpening too, if
you wish.

However you decide to apply these techniques, the masks we have
created and the uses of blending modes and layers that we have
outlined are very useful for identifying the highlight and shadow details
you want to emphasize and the effects of the adjustments you make to
them.

Step 4



Some users consider the High Pass filter to be
a strange and exotic tool, while others find it
an indispensable aid to everyday image
editing. The filter ‘thinks’ somewhat out of the
box but, once you have understood how it
works, there are many ways to apply it
effectively. However, you can only realize its
full potential if you use it in combination with
blending modes. The five tone levels included
in a grayscale wedge illustrate the filter’s
principle very well, as they represent tonal
values of 0, 64, 128, 192 and 255 in all three
RGB channels (i.e., tonal variations at regular
intervals).

The High Pass Filter

The High Pass filter can be found in the
Photoshop Filter menu under Filter > Other.
When applying the filter to a grayscale wedge,
you can select Radius values between 0.1 and
250 pixels, and the effect is only visible at
obvious edges (i.e., where there is contrast).
Where there is no contrast, the filter produces
mid-gray pixels. The filter can be applied to

any layer (including the background),
although this doesn’t make much sense, as
you will see if you try applying it to a grayscale
wedge as an experiment.

An edge is produced where dark and light
image areas meet, and applying the High Pass
filter produces a dark line on the dark side and
a bright line on the bright side of the edge.
The larger the Radius value you use, the
broader these lines will become, up to the
point at which they form a visible, medium
gray band. In our example opposite, the 
dark-to-light transition moves from left to
right, which means that the dark bands form
on the left and the bright ones on the right
when the High Pass filter is applied. A Radius
value of 3.0 produces a fine edge line and the
remaining tonal bands all turn to mid- gray. 

If we apply a much larger Radius value,
such as the 90 we used in our example, the
edge lines are transformed into broad
gradients, making it impossible to tell how the
original image might have looked by studying
the results produced by the filter. If your
source image doesn’t contain any distinct

changes in tone (i.e., edges), applying the
High Pass filter will produce consistent gray
tones throughout the frame, irrespective of
the Radius value you use. 

At first glance, the High Pass filter doesn’t
have any obvious uses in a photographic
context. The only exceptions are if you use it
with blending modes or to create a mask for
isolating edges that you wish to tweak
selectively.

In order to apply blending modes, you
have to duplicate the background layer first
and apply the High Pass filter to the copy.

The blending modes from the fourth
group apply effects similar to that produced
by applying an S-curve with the Curves tool –
i.e., they brighten highlights and darken
shadows – and combine well with the High
Pass filter. If you merge any tonal value from
one layer with mid-gray from another using a
blending mode from the fourth group, the
original brightness will remain unchanged in
the parts of the original image where gray
pixels are located. These blending modes only
have an effect in places where non-mid-gray
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Photos with well-defined monotone areas, such as the sky in this photo, can benefit from sharpening using the High Pass filter.
The filter sharpens only edges, leaving detail in major shapes untouched and preserving overall image data quality. 



tonal values are present in the original image.
As we have already seen, the High Pass filter
produces distinct lines at object edges, so
applying it here increases edge contrast,
which also sharpens the image. Soft Light is
the subtlest mode of the group, while Overlay
and Hard Light produce slightly stronger
effects. Vivid Light and Linear Light produce
the highest-contrast results of all. 

The best way to get a feel for the effects
produced by the High Pass filter is to apply
any blending mode from the fourth group to
your duplicate layer and then apply the filter.
Doing things in this order makes it easier to
see which Radius value best suits the image
you are working on, and you can always
switch to a different blending mode once you
have selected the right filter settings.

Combining Tools and Blending
Modes

Blending modes can also be applied using
various brushes and retouching tools. With a
little practice, this direct style of application
can be a lot quicker than using separate layers
to apply your chosen effects, especially when
you are performing minor adjustments. The

Blending Modes for Photographers | Advanced Techniques

We used a grayscale
wedge to represent the
range of tones within an
image. Applying the High
Pass filter with a low
Radius value produces
distinct lines at the edges
of the individual zones
and consistently gray color
fields. Higher Radius
values produce distinct
gradients at every edge.
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following example uses the Brush tool to
illustrate the principles involved in this
particular technique. 

Use the Brush tool with a low hardness
value and a size setting commensurate with
the image you are working on – you should be
able to perform your intended adjustment
with a single stroke. Select white as your color
and reduce opacity to between 30 and 60%.
In this case, use the Soft Light blending mode;
if you are aiming to produce higher-contrast
results, use Overlay (or even Hard Light) . Now
all you have to do is ‘paint in’ the areas you
wish to brighten. If you are not satisfied with
the results, use the Edit > Step Backward
command or undo the step in the history
panel to undo your adjustment and start
again. 

Using layers to achieve the same effect
takes longer. If this is the approach you wish
to take, first create a new layer using the 
Layer > New command and select an
appropriate blending mode and opacity
setting as described above. Select a white
brush in Normal mode and set opacity to
100% with size and hardness settings as
detailed in our previous example. You can
now paint your adjustment into your new
layer. The result is the same as the
brush-based one, but can be adjusted at any
time by adding to or erasing the areas you
have painted. 

For completeness’ sake, we would also
like to mention a third technique that builds

on the second example we have just
described. Instead of creating a blank layer,
fill the new layer with 50% gray by using the
Edit > Fill command and selecting the 50%
gray option in Use drop-down in the Fill
dialog. This is the same gray that blending
modes such as Soft Light use. While this
doesn’t actually have any effect on the
results you produce, it does make it a lot
easier to see where you have painted in your
editing layer.

If you want to add a vignette effect to an
image, you can either use a selection with a
soft edge and the Levels tool, your RAW
converter’s built-in tool (if available) or a large,
soft brush. If you want to leave the color of
your vignette as it is, use a dark neutral gray
tone or black with reduced opacity. Using a
color picked from the tones included in the
image itself is a great way to emphasize the
effect of a vignette.

We used just a couple of brush strokes and
Screen blending mode with a bright
yellow/green tone and 42% opacity to
brighten the background in the image of a
flower bud opposite. Once again, we could
have worked with separate layers, but  direct
use of brushes and blending modes helped us
to produce a quick and effective vignette
effect. This approach also allows you to use
any shape you like for your vignette, an
advantage that is lacking if you use a 
soft-edged selection or your RAW converter’s
built-in tool. 

Lab and Blending Modes

To give you a taste of the real potential of
blending modes, we would also like to take an
excursion into the world of Lab mode
adjustments. Lab mode images have three
channels too, but instead of representing the
colors red, green and blue, they are called 
L,  a and b, where L stands for ‘Lightness’ and
a and b represent the color-opponent
dimensions described by the Lab color model.
Using this model can take some getting used
to (see page 112), especially if you are used to
using RGB channels. However, once you have
understood the principle involved, you will
quickly be able to use it to produce fascinating
visual effects. 

To use Lab mode, convert your image
using the Image > Mode > Lab Color
command or the Edit > Convert to Profile
dialog. Most images have sufficient contrast
and are clearly visible in all three RGB
channels, whereas the shapes in a Lab mode
image are only really visible in the L channel.
The a and b channels usually appear
extremely pale and contain almost no
recognizable detail. 

The way Lab mode works becomes more
apparent when you take a look at the Curves
dialog produced by your image (see the
illustrations on page 112). The graph for the 
L channel displays values from 0 (black) to 100
(white), while the scale in the a and b channels
ranges from -128 to +127 with zero in the

For minor adjustments, such as the local tonal adjustment we applied to this cat portrait, using blending modes 
as direct tool settings can significantly speed up your worflow
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middle. The a channel represents the
magenta/green component and the 
b channel blue/yellow. The negative values
stand for the ‘cooler’ green and blue tones,
while the positive values represent the
‘warmer’ magenta and yellow tones. Here, a
zero value represents a neutral gray tone, the
lightness of which is determined by it L value.
Positive a and b values are brighter than
neutral gray, while negative values are darker.
These relationships are the ‘secret’ of the Lab
model. 

But let’s get back to blending modes. The
separation of lightness and tone
incorporated into the Lab model makes it
possible to adjust a color without affecting
its brightness by applying blending modes
to the a or b channels only – an approach
that is simply not possible in RGB and CMYK
modes, where adjustments to color always
affect brightness. 

Using Calculations 
to Adjust Colors 

In the following example, we will be using the
b channel of an image to apply a Calculations
adjustment (Image > Calculations) using one
of the blending modes from the fourth group
(i.e., the ones that do not change a photo’s
original neutral gray tone). Merging either the
a or the b channel with itself intensifies the
colors in the image that correspond to that
channel.

There are many more color variations to
be discovered if you invert the source pixels
in the Calculations dialog (select the Invert
checkbox in the Source 1 section) or blend
the L channel in Normal mode with one of
the color channels. It is easier to gain an
impression of the results these types of
blends will produce if you hide the channel
you are not working on by clicking on the
eye icon in the Channels panel. You can now
blend the L channel into your target color
channel by selecting it as your source. This
converts all the image elements that are
darker than neutral gray to green (if you are
using the a channel) or blue (if you are
working with b). Correspondingly, all the
elements that are brighter than neutral gray
are converted to magenta in the a channel
and yellow in the b channel. All of the
adjustments mentioned here can be  
fine-tuned by adjusting the opacity level.
Using Calculations is a quick way to
selectively intensify colors and is a popular
method for pepping up images captured in
dull weather. But remember, color data has
to be present in the first place if it is to be
intensified, so check the content of the

image areas you want to adjust using the
Eyedropper tool in the Info panel before
applying an effect.

Adjusting Colors using
Advanced Blending Options

To try out this technique, first duplicate the
background layer of your Lab mode image
and double-click the new layer icon to open
the Layer Style dialog. Then uncheck the 
L channel in the Advanced Blending section
of the dialog to ensure that the blending

mode you select in the General Blending
section is only applied to the two color
channels. In our garage door example on
page 113, we used Linear Light mode. 

You can, of course, further tweak your
effect by unchecking one of the color
channels and/or adjusting the Blend if options
to apply your blend effect to just part of the
selected channel(s). The possibilities are
virtually endless and your imagination is the
only limit to what you can achieve. And by the
way, you can apply the same technique in
reverse to adjust the brightness of an image
without affecting its colors. (pen)  

c’t Digital Photography 10 (2013)

Blending Modes for Photographers | Advanced Techniques

111

Applying a vignette with reduced opacity produces subtle effects that are
quite difficult to detect but are nevertheless very effective



The channel views for a Lab mode image are unusual if you are used to viewing RGB images. Although the L channel
contains most of the visual information you would expect, the a and b channels do not appear to contain any visible data.

The L channel has values that range from 0 to 100, whereas zero is located in the middle of the color curves
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With just a few clicks in the right places, you can alter the
colors in a Lab-mode image without affecting brightness

Use the Blend if options to specify which colors remain
unaffected by your changes c
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Dedicated

Selection Tools
Using Photoshop isn’t the only way to make precision selections –
there is a range of standalone and plug-in selection tools available 
that do the job just as well at a fraction of the cost. This article 
tests some of the more popular tools on the market and compares 
the results with those produced by Photoshop.

Image: quavondo (iStockphoto)



In Issue 8 of c’t Digital Photography, we
explained some sophisticated Photoshop

selection techniques and promised to review
some of the alternative plug-ins and
standalone tools later on. This article makes
good on that promise and takes a closer look
at three of the better selection tools that we
have come across.

All three tools are available for Windows
and Mac. The techniques they employ are quite
similar to those used by Photoshop, and are
based on color ranges, edge tolerances and
fine-tuning masks. The advantage of a
dedicated tool is that it concentrates on doing
one thing very well rather than having to
integrate its functionality into a smorgasbord
of other tools and tweaks the way Photoshop
does. This means that dedicated tools are often
simpler and more intuitive to use.

All of these solutions strongly emphasize
the use of color ranges. While Topaz ReMask 3
is based almost entirely on this concept,
OnOne Perfect Mask 5 and Vertus Fluid Mask 3
combine color ranges with additional
segmenting techniques to achieve precise
results. Both tools allow you to directly
influence the complexity of the segments
they select. 

While all three divide an image into
foreground, background and transition zones,
they use very different tools to fine-tune the
results. The segment-based tools look a lot
like the Photoshop Extract filter, which has
been integrated into the Smart Radius tool
since the release of CS5. The range of
fine-tuning options in all the programs we
tested is significantly broader than that
offered by Photoshop. 

Used as plug-ins, all of our test candidates
either install automatically to Photoshop or ask
for your target application during setup. Fluid
Mask  3 and ReMask  3 are included in the
Photoshop Filter menu, while Perfect Mask 5
becomes part of the Automate command in
the File menu.

But take care: Fluid Mask 3 and ReMask 3
delete any excess pixels from your original
image file. ReMask 3 automatically creates a
copy of the background layer, and you can
use the selection to generate a layer mask for
the original image layer, whereas with Fluid
Mask 3, it is a good idea to make a copy of the
background layer manually before you begin
making a selection. The more sophisticated
OnOne solution automatically converts its
selection results into a new, masked
Photoshop layer.

Our Test Procedure 

We used a green screen image that includes
various individual hairs and blurred edges as

our test image. Selecting the background
color is not particularly tricky; the real
challenge lies in finding and removing the
remains of the background from between the
hairs and dealing with blurred transitions.
Using Photoshop to process these types of

artifacts requires detailed knowledge of the
application and a lot of time-consuming
fine-tuning work. Our aim was to see just how
quickly and effectively these tools tackle the
same tasks and find out how good the results
really are.

115c’t Digital Photography 10 (2013)

Image Processing | Selection Tools

The best way to start any complex
selection using Photoshop is to apply a
double blend to the green channel using
the Multiply and Overlay blending
modes. An additional Levels correction
gives the edges of the selection (i.e., the
hair ends) sufficient contrast with the
background. Inverting the resulting
selection gives you the basis for your
layer mask, which you can then fine-tune
using the Dodge and Burn tools to make
individual areas more or less opaque.
Use the Blur tool in Darken mode to deal
with blurred transitions. The
Decontaminate Colors option in the
Refine Edge dialog isn’t powerful
enough to remove all the remaining
background color between the hair
ends, but you can get rid of it by
duplicating your working layer and
reducing the size of the mask to reveal
the edge pixels on the layer below. Once
you have done this, select either Multiply
or Screen mode for the new layer

(depending on the color of the
background) and use a Replace Color
brush to find and replace the hair color
where necessary.

Using Photoshop to Perform Our Test

A tweaked version of the green 
channel makes an ideal starting point
for a selection mask
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This is the original photo we used for our test
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How it works: Perfect Mask 5 combines color
range techniques with complex image
segmenation. You can use custom color
lookup tables to fine-tune your selection, and
the masks this produces can be edited
directly.

Using the program: The currently loaded
image is automatically segmented when you
start the plug-in. The resulting segments can be
displayed separately and help to differentiate
between ‘Keep’ (foreground) and ‘Drop’
(background) zones. Use the Scaling option in
the program’s Settings dialog to define the
degree of precision in the segmented view.

The first step is to use the Drop Brush tool
to define sample background colors. The
program then automatically deletes all the
segments of the same color as the one(s) you
have selected. You can alter the brush settings
to make the edge definition in your selection
more or less precise. 

The Refine Brush function is then used to
roughly define the edge of the selection,
creating transparent areas in the process. The
clever part of this operation is that you can
define your own Keep and Drop colors using
an eyedropper and save them in a custom
table. To use your saved colors, make sure that
you select the Use Dropper Colors option.

The same option is available for the Magic
Brush fine-tuning tool – a kind of ‘background
eraser’ which, when properly defined, can
even be used to make precise selections of
blurred transitions. The Transition slider
determines the hardness of a transition, and
its maximum value of 255 represents a very
soft transparency effect. 

Once you have performed any fine-tuning,
you can edit the mask you have produced in
the Adjust Mask pane, using the Chisel tool to
sharpen the selection’s edge or the Blur tool
to soften it. The resulting mask is then handed
over to Photoshop as a layer mask.

Conclusions: Perfect Mask 5 is a complex tool
that is nevertheless simple to use. The
insividual functions have a good range of
options and the ability to define custom color
tables is really helpful. The additional mask
tools make it possible to produce near-perfect
masks, and the simple handover to Photoshop
is the icing on the cake.

» OnOne Perfect Mask 5

www.ononesoftware.com
Price: US$99.95
(Perfect Photo Suite 6 costs
US$299.95)

Perfect Mask 5 hands over its comprehensive masking results directly to
a new Photoshop layer mask

Perfect Mask 5 allows you to display the
segments that make up a selection, and
offers various different segment scaling
parameters

The Refine Brush tool selects the
transition areas in your image

The Magic Brush tool can be used to delete unwanted
background color and any remaining colored pixels
from between the hair ends
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How it works: ReMask 3 offers a set of tools
that select and delete pixels based exclusively
on color range techniques.

Using the program: This plug-in dives
straight in and presents you with three Basic
Brush tools for marking the areas that you
wish to use for your transition and defining
‘keep’ (foreground) and ‘cut’ (background)
areas. Clicking the ‘Compute Mask’ button
performs the selection you have defined.

Having made your basic selection, you can
now fine-tune the results. There are various
brush tools available for making global and
local adjustments to the edges of the mask, all
of which are based on color range selection
techniques. The Single Color Selection brush
can be used to remove a single color on either
side of the mask’s edge, while the Dual Color
Selection brush enables you to select background
and foreground colors between which you
can then add a transparent transition area. 

Conclusions: The plug-in is simple and
intuitive to use. The Dual-Color Selection
Brush quickly proved to be the best all-round
tool for performing tricky selections.

» Topaz ReMask 3

www.topazlabs.com
Price: US$69.99

ReMask 3 creates a ‘compute’ zone between the ‘cut’ and
‘keep’ areas, which you can then fine-tune to suit your own
particular needs

You can individually adjust the mask’s
hardness and strength (i.e.,contrast)

The Dual Color Selection Brush is specially
designed for use with complex transitions.
You have to select the colors you want it
to adjust before applying it.
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How it works: Vertus Fluid Mask  3 uses a
complex segmentation algorithm that can be
adjusted to suit various different types of
images areas. Individual segments can be
fine-tuned using different parameters and
color range tools.

Using the program: Fluid Mask 3 starts by
segmenting the image and displaying a set
of segment outlines that can be quite
confusing at first glance. The segments can

be divided into Blend, Keep and Delete areas
using local and global brushes as fill and
extraction tools. Once you have created an
initial selection using the ‘Create Cut-out’
button, you can fine-tune any transitions
that your initial settings haven’t
implemented properly. Select areas where
you want to adjust the transitions using the
Rectangle Patch or Patch Brush tool. You can
then use the Preview Cut-Out tool to review
your changes. 

There is a multitude of fine-tuning options
available. You can analyze and adjust the
degree of segmentation separately for a
selected area and use the color Workspace
dialog to allocate individual tones to the
Blend, Keep and Delete masks. The edge
blending settings have their own Intelligent
Blending and Edge Smoothing sliders for
adjusting the degree of sharpness/softness
you wish the transitions to have, and the
additional Complex Hair Blending option even
enables you to compare the color ranges of
the Delete and Keep areas, making it possible
to make precise selections within extremely
complex transitions. 

But be warned: Complex Hair Blending uses
a lot of processing power, so it is a good idea
to save your project before applying it, just in
case it overtaxes your system. Once you are
happy with your results, you can hand over
the finished mask to Photoshop using the Save
and Apply command in the File menu.

Conclusions: Fluid Mask 3 seems clunky and
complicated at first, and isn’t nearly as
intuitive to use as the other programs we
tested. However, once you get the hang of
using it, it delivers very good results, especially
for details that can otherwise be tricky to deal
with.

Conclusion
These tools offer varying degrees of
complexity and intuitiveness. Fluid Mask 3 is
the most complicated to master, but rewards
patient users with excellent results. ReMask 3
is very simple to use, but requires a lot of
time-consuming fine-tuning once a basic
selection has been made. Perfect Mask 5 is just
as intuitive to use and, once you find out how
to use its advanced settings, extremely
effective. The Adjust Mask pane is very similar
to the Photoshop Masks panel, giving
experienced Photoshop users a useful head
start. (pen)  c

» Vertus Fluid Mask 3

www.vertustech.com
Price: US$149.00

Fluid Mask 3‘s approach to segmentation takes a little getting
used to but rewards you with excellent results if you are
prepared to spend some time learning how to use it effectively

The Complex Hair Blending option is
highly customizable but uses a lot of

processing power 
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Dmitri Popov

Budget RAW Processing

with Photivo
High-end RAW processing tools such as Adobe Lightroom and
Apple Aperture are popular among photographers, but are 
not particularly cheap. Fortunately, there is a growing range of
free open source RAW processing tools available that includes
Photivo. This is a relatively new application built by a small group
of developers, but offers all the essential features you need for
your everyday RAW processing needs.



Shooting in RAW puts you fully in charge of
the digital image editing process, which 

is why many amateur and professional
photographers prefer working with raw
sensor data rather than JPEG files. However,
the quality of the results you produce
depends not only on your personal levels 
of skill and experience, but also on the
software you use. 

In addition to Photivo, RawTherapee is
another popular open source RAW processor
that has been available with an open source
license for a while now (both are included on
this issue’s free DVD). Although Photivo has a
user-friendly interface, it doesn’t shield the
user from the complexities of its tools and
features the way RawTherapee does, so
mastering Photivo requires some time and
effort. (For more details, see our article on
RawTherapee in Issue 7 of c’t Digital
Photography.) This is not necessarily a
disadvantage, and learning to use the
program is a great way to get to know the
theory and basic principles of RAW image
processing and retouching. The lack of
proper documentation doesn’t make the
learning process any easier, but if you are
willing to spend time learning Photivo’s tools,
you will be able to achieve impressive results
within a relatively short space of time. Photivo
is a pure RAW processor and lacks tools for
sorting and organizing photos. It is basically
designed as a tool for optimizing individual
images and, as such, is better suited to use as
a companion application rather than an end-
to-end photo workflow. The fact that both
Photivo and RawTherapee are available free of
charge makes the question of which
application is ‘better’ largely irrelevant. There
is no better way to find out which solution
meets your needs best than to try out both
applications for yourself.

Photivo supports various common
demosaicing algorithms, including bilinear,
VNG, VNG4, PPG, AHD, VCD, LMMSE and
others. The application includes a large
collection of processing tools, from lens
distortion and vignetting correction features
to a variety of different denoising and
sharpening tools and also includes a handful
of creative tools and filters, such as film grain
simulation, black and white conversion,
cross-processing, split-toning, vignetting, soft
glow and tilt/shift, to name just a few. 

Photivo integrates well with the GIMP open
source photo processing package, which
means that you can use it as part of a
complete, free digital photographic workflow.
It is available for Windows (32 and 64-bit),
Linux and Mac OS X, and the application is
localized to several languages, including
German, French, Russian, Italian and Dutch. In

short, Photivo is an extremely attractive RAW
processing application, so before you spend
money on a commercial solution, it is well
worth giving it a try.

Installation and Configuration

Thanks to the precompiled installer packages
available at the Photivo website, installing the
application in Windows is a straightforward
procedure. Simply download the setup
package for your specific architecture (32 or
64-bit) and run the installer, but bear in mind
that the 64-bit version only runs on
Windows 7, so if you are using 64-bit version
of Windows XP or Vista, you should use the
32-bit version of the application. You can also
turn Photivo into a portable application that
you can run off a USB stick or external hard
drive, allowing you to process RAW files even
when you are away from your main machine.
To make Photivo portable, copy the entire
program folder from the C:\Program\Files
directory to your USB stick. Create an empty
text file and save it as use-portable-profile
(without a file extension) in the Photivo folder

on the USB key. And that’s it – you can now
run Photivo from your USB stick in portable
mode.

Photivo is first and foremost a RAW
processing tool, so you need a dedicated
photo retouching application for 
post-processing work. If you use GIMP as your
preferred photo editing tool, you will be
pleased to hear that you can integrate the two
using the Photivo to GIMP plug-in. This module
enables you to hand over the currently open
file from Photivo to GIMP while preserving the
original Exif metadata and output color
profile. To install the plug-in in Windows,
download it from photivo.org, unpack the
downloaded archive and move the
ptGimp.exe and QtCore4.dll files to the
C:\Users\USERNAME\.gimp-2.x\plug-ins\ folder.

Before you start using Photivo, you will
need to configure a couple of basic settings.
Cick the ‘Photivo Settings’ button to switch
to the settings pane, where you will find an
expandable list of configuration options. To
complete GIMP integration, switch to the
Export command section, and tick the Use
gimp plugin check box. Specify the path to
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Using the settings pane, you can alter various
basic options, including the default theme, the
language and the path to the GIMP executable
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the gimp-2.x.exe file in the field above the
check box (by default, the path is C:\Program
Files\GIMP-2.x\bin). Photivo uses English as
its default language, but you can switch to
any of its other supported languages in the
Translation section of the settings pane. If
the default skin is not your cup of tea, you
can reconfigure it in the Theming section.
There are other options you can tweak too,
but it best to leave these at their default
values for now.

Working with Photivo

Once you have configured the program, it’s
time to get to grips with the application’s
basic operations. When you launch Photivo,
it automatically opens the built-in file
browser, which accesses local and external

storage devices. The file browser interface is
split into three parts: the left-hand sidebar
shows the hierarchical folder structure, the
middle pane displays thumbnails of photos
in the currently selected folder and the
right-hand pane displays a preview of the
selected RAW file. The browser enables you
to bookmark frequently used folders and
access them with a single mouse click. To
bookmark the current folder, press the ‘Add
Bookmark’ button in the Bookmarks section
of the left-hand pane or use the Ctrl+B
keyboard shortcut. Double-clicking a file
opens it for editing.

Although Photivo offers a wide selection
of tools, its interface is designed to be as
unobtrusive as possible. The application
window is split into two main areas: the
image area and the tool pane. The latter is
organized in several tabs, with names like
Camera, Geometry, RGB, Lab Color/Contrast,
Lab Sharpen/Noise etc. Each tab represents
a separate processing stage for the currently
selected RAW image file, and the general
assumption is that you start processing in 
the Camera tab and work your way through
the others until processing is complete. 
The sheer number of tools offered by the
program can be overwhelming, but the 

built-in search feature enables you to quickly
locate the tool you need. Simply type the
name of the tool you want in the Search field
located below the histogram pane – the
application will then automatically display a
list of matching results. 

In addition to the Search feature, you can
also mark tools that you use regularly as
favorites. To do this, right-click a tool and
select the Add to favorites option from the
context menu. You can then use the ‘Favorite
tools’ button to choose from the list of tools
you use most. Similarly, you can also hide
tools that you use rarely by right-clicking them
and selecting the Hide option from the
context menu. Press the H key to view a list of
all hidden tools or the U key to unhide all tools
in the current tab.

There are several other actions available in
the tool context menus. The Save preset
action allows you to save a tool’s current
settings for later use, while the Append
preset action writes the current tool settings
to an existing preset file. This action enables
you to save the settings of multiple tools in a
single preset. To apply an existing preset to
the current photo, switch to the Input section
of the Camera tab, press the ‘Open preset’
button and select the preset file you want to
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Photivo’s built-in browser
gives you access to RAW
files stored on local and
external storage devices,
and lets you bookmark
frequently used directories
for faster access



apply. The Block action lets you temporarily
disable a specific tool without affecting its
settings, allowing you to exclude certain
operations when processing an image. Finally,
the Reset action restores the tool’s settings to
its default values.

Photivo provides helpful visual clues to
help you identify which tools are enabled in
the current processing session. A green dot on
a tab means that at least one tool on that tab
is currently active. Colors are also used to
indicate the status of each tool: a green arrow
means that the tool is active, while a red one
means that the tool is blocked. You can use
the ‘Active tools’ button to quickly access all
active tools.

The image area is the other key part of the
application’s interface. This contains the
current rendering of the photo you are
working on, also known as a ‘pipe’. By default,
the size of a pipe is one quarter of the size of
the original RAW file, which ensures speedy
processing and fast preview updates when
changes are applied. You can adjust the size
of the pipe using the drop-down list at the
bottom of the tool pane, and Photivo cleverly
allows you to export either the current pipe or
a full-size pipe at the same size as the original
RAW file. This approach provides you with
faster RAW development and efficient
utilization of hardware resources while still
allowing you to export processed images at
full size. The only limitations to this feature
apply to the Liquid Rescale tool and most 
of the sharpening filters. The effect these 
tools produce depends on the pipe size, so
applying them to a quarter-size pipe and 
then exporting a full-size image can lead to
unexpected results.

The zoom bar at the bottom of the image
pane contains buttons for zooming in and out
of the preview image, but you can also zoom
using the scroll wheel on your mouse or the 
0 to 4 keys. Right-clicking the preview image
gives you access to more useful options. For
example, the Mode command lets you switch
between several display modes that are
designed to help you analyze your image.
These include the standard RGB mode, which
gives you a realistic rendering; Structure
mode, which provides an overview of detail
distribution within the image; and Gradient
mode, which shows the luminance gradient
that represents the edge detail in the image.
L*, a* and b* modes display the luminance
and color channels that correspond to those
in the L*a*b* color space.

The commands contained in the Clipping
sub-menu enable previews of under- and
overexposed image areas. To activate this
feature, select the Indicate command and
enable the Overexposure and Underexposure
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Right-click on the preview image to access the
Mode and Clipping image analysis options

Right-clicking a tool accesses various useful
actions, allowing you to save the tool’s
settings as a preset, hide or block a tool and
reset it to its default values

Raw Processing | Photivo



options. You can also view under- and
overexposure information for the individual
RGB channels by enabling the R, G, and B
options.

Processing RAW Files 
with Photivo
Photivo supports non-destructive editing, so
you can experiment with as many tools and
effects as you like without altering your
original image data. During export, the
application saves all changes made during
your current processing session to a separate
.pts file, enabling you to re-apply the same
actions to multiple files. To apply a session’s
actions, open a RAW file, switch to the Camera
tab, click the ‘Open settings file’ button, and
select one of your saved .pst files. You can also
save the current settings state at any time by

right-clicking the ‘Save current pipe’ button
and selecting the Save settings option.

Now we’ve covered the basics, let’s put
Photivo to use and process a sample photo – in
this case, one of the Hanazono shrine in
Shinjuku, Tokyo. Although this is probably not
the world’s best photo of the shrine, it has
several obvious issues which make it a perfect
candidate for tweaking. You can download 
the image file from https://s3-eu-west-
1.amazonaws.com/dmpop/20110904-111124-
10632.NEF and reproduce the actions
described here on your own computer. Open
the downloaded RAW file and switch to the
Camera tab. The first thing you have to do is
choose the correct color profile. To do this,
expand the Camera color space section,
select the External Profile option from the drop-
down list and pick the appropriate color profile
(in this case, NIKON_D5000.icc) using the ‘Load

a camera profile’ button. If Photivo doesn’t offer
a color profile for your specific camera model,
you can use one of the default profiles. Leave
the Intent and Gamma drop-down options at
their default values.

The next steps involve straightening the
image, adjusting its perspective and cropping
the results. Switch to the Geometry tab, expand
the Rotation and Perspective section and
use the mouse to move the Rotate slider to the
left to straighten the photo. Instead of using
the slider, you can also right-click the currently
displayed value and enter a custom value
manually (in the case of our sample image, this
needs to be about -0.5). Press the Enter key to
apply the change. Enabling the Grid option
makes it easier to align images accurately. To
fix perspective in our sample image, tilt the
photo forward by using a Tilt value of 15. Once
you’ve done that, crop the image using the
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The tools in the Geometry tab can be used to rotate and
crop images as well as adjust perspective



tools in the Crop section. Enable the Crop
option and, if necessary, enable the Aspect
Ratio option and specify your desired values.
You can then use your mouse to define a crop
area within the image. Press the ‘Confirm crop’
button to apply your selected settings.

Next stop is the RGB section, which
contains tools for adjusting exposure,
brightness and color. By default, Photivo uses
the Like UFRaw automatic exposure mode,
which often produces underexposed results.
However, you can easily work around this
issue by adjusting exposure manually. In the
Exposure section, select Manual from the list
of exposure mode options and adjust the EV
value appropriately. Next, expand the
Brighten section, activate the Enable option
and adjust the Brightness slider to taste. To
make the colors more vibrant, use the
Vibrance slider in the Color Intensity section.

Our sample image could also use some
sharpening, so the next place to head is the
Lab Sharpen/Denoise section. Photivo offers
several sharpening tools but uses the Wiener
filter by default. This filter produces excellent
results with a minimum of tweaking, so try it
first before exploring other tools. Photivo
doesn’t skimp on denoising features either,
and includes the powerful but easy-to-use
GreyCStoration tool. Although this tool offers
a multitude of user-adjustable parameters,
you can usually achieve great results by using
the default values and experimenting with
different shadow masks.

Increasing exposure values and
brightening an image may well produce
overblown sky areas as a result. For situations
like this, Photivo has the Gradual Overlay tool
tucked away in the EyeCandy tab. This tool
emulates a graduated neutral density filter,

which is an analog tool often used to properly
expose bright skies. To apply the filter, switch
to the EyeCandy tab, expand the Gradual
overlay I section and select SoftLight from the
Mode drop-down list. You can then tweak the
available parameters until you find the effect
you are looking for. Enabling the Gradual
overlay II section gives you options for
adding a color hue to the filter. The EyeCandy
tab also contains a handful of other creative
tools, including Black and White conversion
and the Cross Processing tool with its various
cross process emulations. The tab also
includes Texture Overlay and Vignette tools.

Once you are happy with the changes you
have made, it is time to export the finished
image. Before you actually export a file, you
have to configure the export settings in the
Output Parameters section of the Output
tab. Here, you can specify the desired format
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Alongside its other options, the RGB tab contains tools for
adjusting exposure, brightness and color vibrancy



(PPM, JPEG, PNG or TIFF) as well as the title,
tags and rating. Finally, right-click the ‘Save
current pipe’ button and select the Save full
size option to export the full-size photo. If you
want to hand over an image to GIMP for
further processing, right-click the ‘Send image
to external editor’ button and select either the
current or full-size pipe option.

Batch Mode

Photivo includes a batch mode which allows
you to automatically process multiple RAW files

in a single session. Although batch mode isn’t
particularly intuitive to use, it is nevertheless
fairly straightforward. Start by opening a RAW
file and making your desired changes, then
right-click the ‘Save current pipe’ button and
choose the Save job file command. Select the
RAW files you want to include in the batch job,
specify an output folder and save the job file.
In Windows, launch the command prompt and
execute the following command, replacing the
sample values with the actual paths to the
Photivo executable and the .ptj job file:

C:\Program Files\Photivo\photivo.exe 
-j C:\path\to\jobfile.ptj
Please note that Photivo doesn’t provide

any output during batch operations, so you
have to keep the command prompt open
until the job has been completed.

Conclusion

This article covers just a few of Photivo’s many
capabilities, and the application offers a
myriad of other tools and features which can

help you get the most out of your RAW
images. Although there is no real
documentation to speak of, the program’s
non-destructive processing approach makes
it easy to explore the available tools and
functions without running the risk of
damaging your precious image data. (jr)
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The EyeCandy tab offers several
creative filters to help you enhance
and enliven the look of your images c

Photivo boasts a wide range of denoising and sharpening tools. By default,
the application uses the Wiener sharpening filter, which produces good results
with a minimum of tweaking.
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Book Review

Book Review

Using static images to capture movement
and convey its significance has always

been extremely difficult to achieve using the
photographic medium, and this book faces a
double challenge in that it is the companion
piece to a 3D film that many critics believe set
new milestones in the documentation of dance.
This direct comparison really emphasizes the
fact that photos lack not only a temporal but
also a spatial dimension.

That Pina – The Film and the Dancers
successfully resolves this paradox to stand in its
own right alongside the stage performances
and the film is due in no small measure to the
brilliance of its subject. Pina Bausch, the dance
theater luminary who died in 2009, had a
reputation for works of extraordinary intensity
and for a tireless search for ways to express
human experience. And, wherever there is a
serious quest for authentic experience, good
photographic opportunities are never far away.
Donata Wenders, who was on set with her own
camera during filming, shot these articulate
photos with a sensitive appreciation of the

dancers and their work. Like the film, the book
portrays performances both on stage and
outdoors. Some were taken in urban settings,
usually with only one or two dancers as their
central theme, and the interesting thing is that
although their costumes make them look out
of place, the way they express themselves
makes them seem an entirely natural part of
the scene. In fact, individuals are key to the
essence of the book, and the dancers’ own
statements that are paired with the photos play
an important role. Their words often provide
surprisingly profound insights into how Pina
Bausch worked.

The images, together with the
accompanying text by Wim Wenders and 
the words of the dancers, are accessible even
to readers who are not immersed in the world
of dance. The dancers’ presence, thoughtfully
observed by Donata Wenders, and the energy
of the choreography and stage design, which
are simultaneously intense and subversive,
will touch all but the most disinterested of
readers. (Robert Seetzen/tho)

All for Dance
Pina – The Film and the Dancers

Pina – The Film and the Dancers 

Donata and Wim Wenders
Published by Schirmer/Mosel
264 pages, 153 illustrations
10.6 x 9.8 inches
US$65.00
ISBN 978-3-8296-0623-3

Pina Bausch used a great
variety of materials in 

her productions, including
real water fights and

ankle-high grass Ph
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When it comes to establishing a web
presence, photographers have a

 wealth of options at their disposal. Amateurs
and enthusiasts often choose to join one of
many photo sharing services like Flickr,
SmugMug and 500px. These services provide
a wide range of tools and features that 
make it easy to publish photos, interact with
other users and even make some money by
selling an image or two. However, many
professional photographers still opt for
maintaining a dedicated portfolio as part of
their website. Building an individual portfolio
with a unique design and style is a serious 
and often expensive undertaking, but for
many photographers it’s worth the trouble, 
as it provides a good way to showcase their
work and attract potential customers.

Now, there is yet another option available
to enthusiast photographers and seasoned
professionals alike. Instead of relying on 
third-party photo sharing services or 
investing time and money in a custom
portfolio, you can choose the blog format for
showcasing your photographic work. As a
photographer, you can put a blog to a variety
of practical uses – the format is suitable for
adding narrative and cultural context to
photos or explaining the photographic
decisions you made when you took a
particular shot. If you travel a lot, you can use
a blog to share your travel experiences along
with shots that might not make it into your
portfolio but give your readers a good
impression of the place you are visiting. As a
seasoned photographer, you may have some

tricks and tips that you want to share with a
wider audience, and a blog provides a
platform for that too. You can also use it to
publish tutorials covering your favorite photo
processing software, review photographic
gear, post the latest photo news or cover
other photography-related topics. Sharing
knowledge is a good way to establish 
yourself not only as a competent
photographer but also as an expert in your
field. If photography is your passion, a blog
can be a great tool for reaching other
like-minded users and interacting with them.
If you run your own photography business,
you can use a blog to keep your clients and
followers in the loop and communicate with
them in a direct, personal manner. Since 
many popular blog engines can be 
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Dmitri Popov

WordPress 
for Photographers

Whether pro or hobbyist, these days most photographers end up presenting their
photos online in one form or another. Designing your own portfolio website takes
time and effort, and also costs money, so many photographers use ready-made
websites like Flickr, SmugMug and 500px. A photoblog is an elegant and economical
alternative way to exhibit your work, and also gives you the opportunity to exchange
news and views or explain your work to your followers. Using WordPress.com and
custom plug-ins designed specifically for photographers, even beginners can quickly
get their own blog up and running.

Instead of using it as a simple blog, photographer Alfie Goodrich uses WordPress to present his online portfolio



configured to display photo collections in a
visually appealing way, you can even use a
blog to completely replace a dedicated
portfolio.

While there are many high-quality
blogging applications out there, you can’t go
wrong with WordPress. This powerful and
flexible open source blogging engine is
equally suitable for maintaining a simple
single-user personal blog or a complex 
multi-user publishing solution. WordPress has
a gentle learning curve, so even if you have 
no experience of maintaining a blog, you
should be able to master the basics fairly
quickly. The engine’s default functionality can
be extended using plug-ins, and the official
plug-in repository contains a large selection
of modules which can be used to add all sorts
of features to a blog, some of which cater
specifically for photographers. Thanks to its
support for custom themes, you can give 
your WordPress blog a unique look, and there
are dozens of individual designers and
companies that offer ready-made themes for
you to use (see the table on page 136).

WordPress is available with a range of
hosting options to suit most budgets and
levels of technical expertise. If your technical
chops are up to scratch, you can deploy
WordPress on your own server, giving you
maximum flexibility at zero cost. As an
alternative, you can opt for a web hosting
service that has all the required components.
In fact, some web hosting providers offer
WordPress as part of a service plan, allowing
you to deploy blogging software in a matter
of minutes.

Running WordPress on your own server or
a hosting service gives you full control, but

also hands you the responsibility for 
keeping things running smoothly. If you 
are not prepared to be your own system
administrator, you might want to consider
using the WordPress.com hosting service
offered by Automattic, the company that
develops WordPress software. Hosting a blog
with WordPress.com is a great solution for
photographers who don’t want to get
involved with installing and maintaining
WordPress and dealing with system
administration tasks on a daily basis. Hosting
a blog at WordPress.com means that you
don’t have to worry about security fixes,
updates, bandwidth costs and the stability of
your internet connection. Better still, it won’t
cost you anything – the basic blog
functionality is available free of charge, and
you can extend it by upgrading to the Pro
plan, which costs US$99 per year and 
includes, among other things, domain
mapping (use your own domain name 
instead of wordpress.com), custom design (for
tweaking your blog’s appearance) and the
ability to host HD videos. Each of these
options can be purchased separately, so if, 
for example, you are only interested in the
custom design feature, you can enable just
that for US$30 per year. 

Hosting your blog with WordPress.com
does have some limitations, and you can’t 
add your own themes and extend
functionality by installing plug-ins. The
themes question is not much of an issue, as
WordPress.com offers free and premium
themes which (if the custom design option is
enabled) you can tweak to your liking. A lack
of plug-ins can, however, be a limiting factor,
as it prevents you from using WordPress to 

its full potential. The good news is that if 
you choose to host your blog with
WordPress.com, you can still migrate to a
different provider or your own server later.
This way, you can start with a simple blog and
move on to a different solution when your
needs outgrow the basic functionality the
service provides. In fact, WordPress.com
provides a simple export tool for doing just
that. In short, WordPress.com offers a really
simple way to launch your own blog and,
once you have mastered the WordPress
basics, you can switch to a different hosting
solution to get the most out of the options it
offers.

Getting Started with
WordPress.com
Setting up a blog on WordPress.com is
straightforward and can be achieved in
minutes. If you don’t have a WordPress.com
account, simply point your browser to
https://signup.wordpress.com/signup/ to
access the account registration form. Pick a
name for your blog, specify login credentials,
choose the desired language and hit the
‘Create Blog’ button. You can then use the
activation e-mail sent to the address you
specify during registration to activate your
blog. Once you’ve done that, all you have to
do is pick a theme (or simply keep the default
one) before you are automatically dropped
into the administrative interface of your blog,
which you can access at any time via
<yourblog.wordpress.com/wp-admin>. The
Dashboard section is the default landing
point, and features several useful widgets,
including QuickPress (handy for creating a
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The Dashboard
allows you to
manage your blog,
view statistics and
manage comments.
You can customize
the Dashboard by
adding and
removing widgets.



quick blog post), Stats (for displaying your
blog’s statistics) and Recent Comments (which
shows a list of the most recent comments and
lets you manage them). To customize the
Dashboard, click the Screen Options tab.

Before you start populating your blog 
with posts, you can configure it in the
Settings section. In the General Settings
subsection, specify a tagline for your blog,
select the correct time zone, date and time
formats, and choose an appropriate icon. 
Next stop is the Sharing subsection, where
you can connect your blog to popular social
networks and configure sharing buttons.

WordPress.com supports all popular social
networks, including Google+, Reddit,
Pinterest, Twitter, Facebook and others. The
service also features dedicated buttons for
sharing blog posts via e-mail and re-posting
them on other WordPress blogs. In the User >
My Profile subsection, you can provide basic
personal info, contact details and links to
other websites and services. The Personal
Settings subsection lets you enable and
configure a raft of options, including the
geotagging feature, which you can use to
attach location information to blog articles.
There is also a proofreading feature that

supports various languages and helps you to
catch grammar and style errors that might
otherwise go unnoticed.

The next step involves picking a theme
and configuring the overall appearance of
your blog. WordPress.com offers dozens of
free and premium themes, including a few
designed specifically for photographers
(such as Nishita, Duotone, Portfolio and
Photography). To apply a theme to your
blog, switch to the Appearance > Themes
subsection, select a theme you like and 
press the Activate link located next to its
name. If your chosen theme supports
widgets, your next stop should be the
Appearance > Widgets subsection.
WordPress widgets are containers for
different types of content. For example, the
Flickr widget displays photos from your 
Flickr photo stream, while the Image widget
can be used to display a single, static image.
There are many widgets to choose from, and
adding them to your blog’s sidebar is easy –
simply drag the widget you want from the
Available Widgets panel to the Sidebar 
panel. Some widgets require some 
additional tweaking once you have added
them – for example, to make the Flickr
widget work properly, you need to provide
your Flickr feed’s URL, specify the number of
photos to display and enter the required
thumbnail size.

Once you’ve configured your blog, you 
can start adding content, and WordPress
makes this extremely easy to do. The fastest
way to publish a short post is to use the
QuickPress widget in the Dashboard section.
For lengthy articles, you can use the 
dedicated editing interface, which offers all
the essential tools for working with text and
images. In addition to blog articles, WordPress
also lets you create custom pages, which can
be useful for publishing static content for 
your blog. For example, you can create a 
page containing information about you and
your photography business, a page with a list
of useful photo resources or anything else 
that you think is relevant to your work.

Although WordPress is a complex
application, its intuitive design makes it
simple to master. And remember, once 
you’ve learned the ropes, you can migrate
your blog to a self-hosted solution, opening
up a whole new world of plug-in-based 
photo publishing options.

131c’t Digital Photography 10 (2013)

Photoblogs | WordPress for Photographers

Setting up a blog on WordPress.com
is really simple. Fill out a short
registration form, activate your
account and you are good to go.

ShootTokyo is based on WordPress. The photoblog has a clear and attractive design.



Installing and Hosting
WordPress

The major advantage of self-hosting a
WordPress blog (either on your own server or
using a hosting provider) is the ability to
extend its functionality using plug-ins and
custom themes. The simplest way to host 
your own WordPress blog is to use a provider
who offers WordPress as part of a hosting 
plan. This approach offers the best of both
worlds: you retain full control over your
WordPress installation without the hassles of

deploying and maintaining your own server.
Many established hosting providers support
WordPress, but, if your technical skills are up
to scratch, you can install and run it on your
own server. A precise description of the
installation procedure is beyond the scope of
this article, but the ‘Installing WordPress’ web
page at http://codex.wordpress.org/Installing_
WordPress provides all the information you
need to get started.

If you are migrating from the
WordPress.com service, you don’t have to start
from scratch. In the administration interface of

your WordPress.com blog, switch to the Tools
> Export subsection, click on the Export link,
choose the All content option and click the
‘Download Export File’ button. Then, in the
administration interface of your self-hosted
blog, navigate to the Tools > Import
subsection, and click on the WordPress link. You
will then be prompted to install the WordPress
Importer plug-in. Once you’ve done that, you
can import the downloaded export file. By the
way, the import tool can handle content from
other popular publishing services too, including
Blogger, Movable Type and Tumblr.
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Extending WordPress using
Plug-ins and Themes

There are plug-ins available that enable you
to transform your blog into a powerful photo
publishing platform. To get an idea of just
how powerful WordPress plug-ins can be, we
took a look at the Photonic (http://
wordpress.org/extend/plugins/photonic/) and
YAPB (http://wordpress.org/extend/plugins/
yet-another-photoblog/) modules in
combination with the Grain theme (http://
sourceforge.net/apps/mediawiki/wp-grain/
index.php?title=Main_Page).

Plug-ins for embedding photo galleries in
blog articles are a dime a dozen, but most of
them don’t offer the same level of

functionality as Photonic. In addition to a 
wide array of features, this plug-in supports
several popular photo sharing services
including Flickr, Picasaweb, 500px and
SmugMug. This feature alone makes it a great
choice if you plan to showcase photos hosted
by other services on your WordPress blog.

Installing and enabling Photonic (or any
other WordPress plug-in) is very simple.
Navigate to the Plugins > Add New
subsection in the administrative interface,
use the Search field to find the appropriate
plug-in and click the ‘Install Now’ button.
Switch to the Installed Plugins subsection,
and click on the Activate link next to the
newly installed item. To set up Photonic,
navigate to the Settings > Photonic

subsection. Leave the general settings at
their default values for now and configure
the services you want to use with your blog.
To enable Flickr functionality in Photonic,
you need to specify your Flickr API Key and
Secret. If you don’t have a Flickr API key, you
can obtain a non-commercial one free of
charge from www.flickr.com/services/
api/misc.api_keys.html. You also need to
find out your Flickr ID, which is required 
for embedding photos from your Flickr
account in a blog post. The simplest way to
do this is to use the idGettr service
(http://idgettr.com/). Adding a gallery to a
blog article is a simple matter of using the
[gallery] shortcode and some appropriate
parameters, for example:
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[gallery type=’flickr’ user_id=’82643076@N00’ 
view=’photos’]

You can specify other optional 
parameters, too. For example, if you want to
display only photos containing specific tags,
you can do this using the tags parameter 
as follows: [gallery type=’flickr’ user_id=
’82643076@N00’ tags=’flowers, macro’ view=
’photos’]

The sort parameter lets you specify a 
sort order using one of a range of 
supported values, including date-posted-asc,
date-posted-desc, date-taken-asc, date-taken-
desc, interestingness-desc, interestingness-asc
and relevance.

To limit the number of photos shown in
your gallery, use the per_page parameter. The
following example displays the first 35 
photos with the flowers tag from your Flickr
photo stream:
[gallery type=’flickr’ user_id=’82643076@
N00’ tags=’flowers’ per_page=’35’ view=
’photos’]

Photonic can be used to embed individual
photos too, using the photo_id parameter:
[gallery type=’flickr’ view=’photo’ photo_id=
’4638718670’]

Similarly, you can embed photosets,
galleries and collections:
[gallery type=’flickr’ user_id=’82643076@
N00’ view=’photosets’] [gallery type=’flickr’
view=’galleries’] [gallery type=’flickr’
user_id=’82643076@N00’ view=’collections’]

While Photonic adds the ability to pull
photos from third-party photo sharing
services and embed them in blog articles,
the YAPB (Yet Another Photo Blog) plug-in
transforms a regular WordPress blog into a
complete photoblogging platform. Since
YAPB is just a regular WordPress plug-in you

can install and activate it using the
procedure described above, but to make the
most of its capabilities, you will either have
to tweak the current theme or use YAPB-
compatible themes like Grain. To add and
activate this or any other theme, download
and unpack the latest version and move the
resulting folder to the wp-content/themes
directory within your WordPress installation.
In the administrative interface of your blog,
switch to the Appearance > Themes
subsection, where you should see the new
theme in the Available Themes list. Click on
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the Activate link next to the new theme to
enable it.

Both the YAPB plug-in and the Grain 
theme are highly configurable, and offer a
long list of settings for you to tweak. To
configure the plug-in, switch to the Settings
> YAPB section. You can leave most of the
available settings at their default values, but 
it is preferable to uncheck the Activate
automatic image rendering in general option 
in the Automatic Image Insertion group if you
want to improve the plug-in’s compatibility
with the Grain theme.

The Grain theme features various settings
for you to tweak, and you can edit them in 
the approprieate section of the 
administrative interface. All available options
contain brief descriptions, which makes
configuring them much easier. Even if you
leave most of the options at their default
values, it’s a good idea to configure the
copyright settings right from the start. To do
this, switch to the Copyright Settings
subsection and specify your desired values. 
At the very least, you should enter your name
in the Copyright holder and Full copyright
holder and info fields. If you want to release
your photos under a Creative Commons
license, enable the Embed Creative Commons
license option and specify the appropriate
license.

While the combination of YAPB and Grain
transforms WordPress into a useful
photoblogging platform, it doesn’t
significantly change the program’s basic
functionality, and instead adds some new

options to the editing interface. When you
create a new blog article or edit an existing
one, you can attach photos using the YAPB
Image widget and specify additional 
settings using the Grain Options For This 
Post widget.

YAPB itself can be extended using
additional plug-ins, and the YAPB-queue
extension (http://wordpress.org/extend/
plugins/yapb-queue/) is one module that you
should definitely consider installing. This
extension enables you to automatically
publish photos at predefined intervals. This 
is extremely useful if, for example, you are
traveling and don’t have regular Internet
access. You can then upload multiple 
photos when you have an opportunity and 
let YAPB-queue take care of the rest. 
Once you have installed the plug-in in 
the usual way, all you have to do is transfer 
the photos you wish to publish to the 
/wp-content/uploads/yapq-input directory
within your WordPress installation and specify
the start time and appropriate intervals in the
Posts > YAPB queue subsection of the
administrative interface.

If you want to manage your blog when
you’re on the road, you’ll appreciate the
WordPress app, which is available for all
popular mobile platforms, including iOS and
Android. You can use it to draft and publish
blog articles, manage comments, view
statistics and much more besides. The app
includes a powerful text editor with rich
formatting functionality and the ‘Quick 
Photo’ button on the Dashboard lets you take

a quick snap and push it to your blog without
leaving the app’s interface. This feature is
particularly useful if you use your blog to
document your work or your travels. 
Whether you use an iPhone, an iPad or an 
Android-based device, the WordPress app is a
great tool for managing your blog when you
are out and about.

Learning from Other
Photographers
The best way to gain inspiration and learn
more about using WordPress as a
photographer is to study existing photoblogs
and learn from other photographers’
experiences. WordPress.com offers a series of
articles that cover all the photoblogging
basics, from choosing a theme to building
connections. The individual pages can be
found at http://en.blog.wordpress.com/
2012/05 by adding the following extensions
to the URL: 
/14/photo-blogging-101-part-1/ 
/21/photo-blogging-101-part-2/ 
/28/photo-blogging-101-part-3/.

The Japan in 365 days blog
(http://picturesinjapan.wordpress.com/) is a
great example of a photoblog hosted using
the WordPress.com service. The blog is a
platform for a project that publishes a new
photo every day for a year. The blog is based
on the minimalistic Twenty Ten theme, which
lacks any visual embellishments but does
feature several interesting tweaks. For
example, the header is configured to display
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the photo from the blog post that is currently
being viewed, while the Image widget in the
sidebar is used to display a link to a shop
where you can order other featured photos.
The sidebar also lets visitors subscribe to blog
updates and displays the latest tweets from
the author. Additionally, each post offers an
assortment of sharing buttons courtesy of
WordPress.com’s sharing functionality while
other pages provide a brief intro and the
author’s contact information. This blog is a
classic example of what can be done using 
the tools offered by the WordPress.com
service. 

ShootTokyo (http://shoottokyo.com/) is
another Japan-related photoblog based on
WordPress, but this time hosted using a 
third-party provider. The blog also sports a
minimalistic look and includes several
interesting features. It makes heavy use of
pages for longer articles, which are all
nevertheless easily accessible via a 
navigation menu. The Explore section of 
the blog presents photos organized into

thematic collections, and the photos in each
collection are displayed as large thumbnails
with mouse-over functionality that reveals
information about each image. The blog’s
author describes the process of building the
site at http://shoottokyo.com/2011/09/23/

creating-shoottokyo/, where you can read a
bunch of useful tips and tricks that are sure 
to help you build your own blog. 

The website belonging to photographer
Alfie Goodrich (http://www.alfiegoodrich.
com/) takes a different approach, using
WordPress as the basis for an online portfolio
that showcases the author’s work, instead of
presenting a conventional blog.

Final Words

It is no coincidence that WordPress has
become the blogging platform of choice 
for many photographers. This powerful
blogging engine offers a wide range of
publishing tools wrapped in a user-friendly
interface. Themes and plug-ins extend the
program’s functionality and allow you to
customize it to fit your specific needs.

WordPress also offers a range of hosting
options and there is a wealth of resources
available online to help you get started.
Whether you are a hobbyist or a pro
photographer, WordPress is one of the best
blog-building solutions out there. (jr)
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Here is a WordPress blog showing
tweaks configured using the YAPB
plug-in and the Grain theme

Using the WordPress app (available for iOS and Android), you can work on blog articles,
manage comments and check statistics on the go. The Quick Photo shortcut allows you to
snap photos and publish them straight to your blog.

BLOGGING TOOLS FOR PHOTOGRAPHERS
Tool URL Description
Automattic http://automattic.com/ Wordpress.com Hosting-Service
WordPress registration https://signup.wordpress.com/signup Starting point
Photonic http://wordpress.org/extend/plugins/photonic Embedding photogalleries
YAPB http://wordpress.org/extend/plugins/yet-another-photoblog Transforming a WordPress blog into a photoblogging platform
Grain http://sourceforge.net/apps/mediawiki/wp-grain YAPB-compatible themes
yapb-queue http://wordpress.org/extend/plugins/yapb-queue publish photos automatically at predefined intervals
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Installation Errors

I’ve downloaded the software from
WordPress.org and unpacked it to my
server directory, but the install wizard
doesn’t load when I access its URL.

There are two things which can prevent the
five minute installation on Windows from
working. Some users will need a .htaccess
file that isn’t included with the zipped
WordPress package. To see if this is the case,
create a trial file with this name and try
once again to open your blog’s URL. If 
that doesn’t work, you may not have
appropriate user access rights. The server
administrator requires read and write
permissions not only for installation, but
also so that one-click updates, themes 
and plug-ins can be installed from the
administrator interface. 

Switching Blog Services

I have been using a different blog
service or software. How do I make the
switch to WordPress easier?

WordPress offers import plug-ins for data
stored with a variety of blog services,
which you can install with a single click
from the Tools > Import section of the
admin interface. The most common
services, such as Blogger, Tumblr, Movable
Type and LiveJournal are supported, but if
you can’t find the plug-in you are looking
for right away, take a look in the plug-in
directory.

Data Security

How do I back up my blog?

The simplest way is to regularly log in to
your hosting service and use the automatic
backup and database dump tools on offer.

Alternatively, the WP-Database-Backup
plug-in enables you to automate the
creation of regular custom backups. You
can then have these backups sent to you
via e-mail, download them from the Tools
> Backup section of the admin interface 
or save them on the server.

The BackupWordPress plug-in offers a
complete backup solution and copies a
database dump to your WordPress
directory. You can set it up to mail you
your backups, or just a download link if 
the size of the resulting file exceeds a
preset limit. Remember to exclude the  
wp-content/backups/ folder from future
backups.

My Design has been
Overwritten 

WordPress lets me customize my site
design without any problems, but
overwrites it when I perform an
update.

Unfortunately, this is how the software
works. All your changes are overwritten
when you update your themes. The
solution is to create a child theme. to do
this, create a new folder with a new name
in the  wp-content/themes/ folder. A child
theme has to contain a styles.css file with
the following code lines at its start:

/*
Theme Name: themename
Template:         parentname
*/
@import url(../parentname/style.css);

You can select any name you like for your
new theme name, and the template should
have the same name as the parent theme,
written in lower case letters with hyphens
between multiple words if applicable. You
can then customize individual parts of the
imported Style Sheet without overwriting
everything. As long as you use exactly the
same filenames and storage locations for
your child theme as you have for the theme
from which it inherits its attributes, any
attributes present in the parent theme will
simply be overwritten by the new ones.  

Googled Designs

Am I allowed to use designs that I find
on the Web?

It is safer to use only themes offered at the
official project website. Any designs that

you find by searching for ‘free WordPress
themes’ are highly likely to contain hidden
malware. Stick to themes that you can
install directly from the WordPress
Dashboard. These also include a preview.

Analytics Tools
Which analytics tools can I use with
WordPress?

Hosting your own blog makes it easier to
conform to the data privacy laws that
apply where you live. Many WordPress
users use the open source Piwik package.
This is simple to install and should be
located in the same directory as your blog
on your Web server. 

Copy the authentication token from the
API page in the Piwik admin interface and
install the WP-Piwik plug-in. Paste the URL
of your Piwik installation and the copied
token into the settings page. Now all you
have to do is use the plug-in to embed the
appropriate java code in the footer of each
page you want to analyze. Once you have
set it up, Piwik delivers regular, fresh Web
usage statistics. (rzl)

FAQ: Managing and Enhancing WordPress

Piwik and the WP-Piwik plug-in help you
capture and analyze your blog’s stats

c
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Open Source Photo 
Workflow Tools

❚ Dedicated RAW converters, image editors and
database tools have been making way for
all-in-one photo workflow tools like Lightroom
for some time now. As ever, the open source
community is never far behind and has already
produced its own successful all-in-ones, such as
RawTherapee, digiKam and GTKRawGallery. We
test seven of the latest open source RAW tools
and give you the low-down on who’s ahead in
this particular race.

Coming up in Issue 11
• • • • •

Photographing Children

❚ Photos of kids are often really cute, but that’s
exactly what sometimes gives them an
uninspiring, ten-a-penny look. We give you
useful tips and explain techniques to help you
shoot quality ‘kidpics’ that will not only please
the parents, but that have real photographic
value too.

Cool Home-build Projects

❚ How about a home-made tilt/shift lens or a
macro lens converted for use as a microscope?
Or ultra-high-speed photo sequences that you
can shoot at home? This exclusive workshop
shows you three inexpensive home-build
projects that produce fascinating and unusual
visual results.
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